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About This Handbook
This handbook is intended to complement the instructor-led presentation of this
course, and serve as a source of reference. It is not suitable for self-study.

Typographic Conventions
American English is the standard used in this handbook. The following typographic
conventions are also used.

Type Style Description

Example text Words or characters that appear on the screen. These
include field names, screen titles, pushbuttons as well as
menu names, paths, and options.

Also used for cross-references to other documentation
both internal and external.

Example text Emphasized words or phrases in body text, titles of
graphics, and tables

EXAMPLE TEXT Names of elements in the system. These include report
names, program names, transaction codes, table names,
and individual key words of a programming language,
when surrounded by body text, for example SELECT
and INCLUDE.

Example text Screen output. This includes file and directory names
and their paths, messages, names of variables and
parameters, and passages of the source text of a program.

Example text Exact user entry. These are words and characters that
you enter in the system exactly as they appear in the
documentation.

<Example text> Variable user entry. Pointed brackets indicate that you
replace these words and characters with appropriate
entries.
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Icons in Body Text
The following icons are used in this handbook.

Icon Meaning

For more information, tips, or background

Note or further explanation of previous point

Exception or caution

Procedures

Indicates that the item is displayed in the instructor's
presentation.
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Course Overview
This four-day instructor-led course teaches system administrators the skills and
knowledge required to design and deploy a SAP BusinessObjects Business
Intelligence platform. In this course, students will learn how to analyze and identify
customer requirements in order to design a solution using the concepts of High
Availability, Scalability, Sizing, Disaster Recovery and Lifecycle Management. Using
a case study, students will design, build and troubleshoot a system and then produce a
content management plan using advanced security and replication techniques.

The business benefit of this course is that it provides system architects/administrators
with an understanding of the concepts necessary to effectively design and deploy a
Business Intelligence solution using the SAP BusinessObjects Business Intelligence
platform.

Target Audience
This course is intended for the following audiences:

• The target audience for this course is system architects/administrators who are
experienced with SAP BusinessObjects Business Intelligence platform.and will
be responsible for designing and deploying solutions for their organization.

Course Prerequisites
Required Knowledge

• SAP BusinessObjects Business Intelligence Platform: Administration and
Security

• SAP BusinessObjects Business Intelligence Platform: Administering Servers –
Windows

Recommended Knowledge

• Windows conventions
• Familiarity with Windows Server 2000/2003 administration
• Windows Server 2000/2003 security concepts (global/local groups, and directory

structure)
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Course Goals
This course will prepare you to:

• Analyze and identify customer requirements in order to design a SAP
BusinessObjects BI solution using the concepts of High Availability, Scalability,
Sizing, Disaster Recovery and Lifecycle Management

• Produce a content management plan using advanced security and replication
techniques

• Design and deploy a SAP Business Intelligence solution using the SAP
BusinessObjects BI platform

Course Objectives
After completing this course, you will be able to:

• Explain SAP BusinessObjects BI platform architecture, administration, and
security

• Ensure availability of your SAP BusinessObjects BI solutions
• Design a scalable system
• Size a SAP BusinessObjects BI deployment
• Deploy a SAP BusinessObjects BI platform
• Manage content across BI deployments.
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Unit 1
Reviewing Architecture, Administration,
and Security in SAP BusinessObjects

BI Platform,

Unit Overview
This first unit covers the architecture and security model in SAP BusinessObjects
Business Intelligence platform.

Unit Objectives
After completing this unit, you will be able to:

• Define SAP BusinessObjects BI platform architecture terms
• Describe key architectural process flows
• Understand how rights work in SAP BusinessObjects BI platform
• Describe how access levels are used
• Understand top-level, folder-level and object-level security
• Understand inheritance

Unit Contents
Lesson: SAP BusinessObjects BI Platform Architecture .. . . . . . . . . . . . . . . . . . . . . . . .2

Exercise 1: Test your knowledge in SAP BusinessObjects Business
Intelligence Platform... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

Lesson: SAP BusinessObjects BI Platform Security .. . . . . . . . . . . . . . . . . . . . . . . . . . . 40
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Lesson: SAP BusinessObjects BI Platform Architecture

Lesson Overview
This lesson provides a review of the SAP BusinessObjects BI platform architecture
including certain key process flows and some terminology used throughout this course.

Lesson Objectives
After completing this lesson, you will be able to:

• Define SAP BusinessObjects BI platform architecture terms
• Describe key architectural process flows

Business Example
This lesson outlines the overall platform architecture, system, and service components
that make up the SAP BusinessObjects Business Intelligence platform. This
information helps administrators understand the system essentials and help to form a
plan for the system deployment, management, and maintenance.

Overview of SAP BusinessObjects BI platform
SAP BusinessObjects Business Intelligence platform is the business intelligence
platform that supports a range of performance management (Dashboard and
Analytics), reporting, querying, and analysis applications. It also provides an
industry-standard, proven architecture and platform-support for semantic layers,
data integration, and security. SAP BusinessObjects Business Intelligence platform
provides for web-based administration and configuration of the entire system.

Architecture overview
SAP BusinessObjects Business Intelligence platform is designed for high performance
across a broad spectrum of user and deployment scenarios. For example, specialized
platform services handle either on-demand data access and report generation, or
report scheduling based on times and events. You can offload processor intensive
scheduling and processing by creating dedicated servers to host specific services. The
architecture is designed to meet the needs of virtually any BI deployment, and is
flexible enough to grow from several users with a single tool, to tens of thousands of
users with multiple tools and interfaces.
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End users can access, create, edit, and interact with reports using specialized tools
and applications that include:

• Clients installed by SAP BusinessObjects Business Intelligence Platform Client
Tools installation program:

– Web Intelligence
– Business View Manager
– Report Conversion Tool
– Universe design tool
– Web Service query tool (formerly Query as a Web Service)
– Information design tool
– Translation Management Tool (formerly Translation Manager)
– Widgets for SAP BusinessObjects Business Intelligence Platform (formerly

BI Widgets)
• Clients available separately:

– SAP Crystal Reports
– SAP Crystal Reports for Enterprise
– SAP BusinessObjects Dashboard Design (formerly Xcelsius)
– SAP BusinessObjects Analysis (formerly Voyager)
– BI Workspaces (formerly Dashboard Builder)

• IT departments can use data and system management tools that include:

– Report Viewers
– Central Management Console (CMC)
– Central Configuration Manager (CCM)
– Repository Diagnostic Tool (RDT)
– Data Federation Administration Tool
– Upgrade management tool (formerly Import Wizard)
– Universe design tool (formerly Universe Designer)
– SAP BusinessObjects Mobile

To provide flexibility, reliability, and scalability, SAP BusinessObjects Business
Intelligence platform components can be installed on one or across many
machines. You can even install two different versions of SAP BusinessObjects
Business Intelligence platform simultaneously on the same computer, although this
configuration is only recommended as part of the upgrade process or testing purposes.
Server processes can be “vertically scaled” (where one computer runs several, or all,
server-side processes) to reduce cost, or “horizontally scaled” (where server processes
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are distributed between two or more networked machines) to improve performance.
It is also possible to run multiple, redundant, versions of the same server process
on more than one machine, so that processing can continue if the primary process
encounters a problem.

System overview
SAP BusinessObjects Business Intelligence platform provides enterprise level analysis
and reporting tools. Data can be analyzed from any of a large number of supported
database systems (including text or multi-dimensional OLAP systems) and BI reports
can be published in many different formats to many different publishing systems.

The following diagram illustrates how SAP BusinessObjects Business Intelligence
platform fits in with your organization's infrastructure.

Figure 1: System overview

SAP BusinessObjects Business Intelligence platform reports from a read-only
connection to your organization's databases, and uses its own databases for storing its
configuration, auditing, and other operational information. The BI reports created by
the system can be sent to a variety of destinations, including file systems, and email,
or accessed through web sites or portals.

SAP BusinessObjects Business Intelligence platform is a self-contained system that
can exist on a single machine (for example, as a small development or pre-production
test environment) or can be scaled up into a cluster of many machines that run
different components (for example, as a large-scale production environment).
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SAP BusinessObjects BI platform architecture basic
terminology

Services and Servers
SAP BusinessObjectsBI platform uses the terms server and service to refer to the two
types of software running on an SAP BusinessObjects BI platform machine.

Host
A host can be a physical computer or virtual machine.

Service
A service is a server subsystem that performs a specific function. The service
runs within the memory space of its server under the process id of the parent
container (server). For example, the SAP BusinessObjects Web Intelligence
Scheduling and Publishing Service is a subsystem that runs within the Adaptive
Job Server.
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Server
The term server is used to describe an operating system level process hosting
one or more services. For example, the Central Management Server (CMS) and
Adaptive Processing Server are servers. A server runs under a specific operating
system account and has its own PID.
SAP BusinessObjects Business Intelligence platform consists of collections
of servers running on one or more hosts. Small installations (such as test or
development systems) can use a single host for a web application server, database
server, and all SAP BusinessObjects Business Intelligence platform servers.
Medium and large installations can have servers running on multiple hosts. For
example, a web application server host can be used in combination with an
SAP BusinessObjects Business Intelligence platform server host. This frees up
resources on the SAP BusinessObjects Business Intelligence platform server
host, allowing it to process more information than if it also hosted the web
application server.
Large installations can have several SAP BusinessObjects Business Intelligence
platform server hosts working together in a cluster. For example, if an
organization has a large number of SAP Crystal Reports users, Crystal Reports
processing servers can be created on multiple SAP BusinessObjects Business
Intelligence platform server hosts to ensure that there are plenty of resources
available to process requests from clients.
The advantages of having multiple servers include:

• Improved performance

Multiple SAP BusinessObjects Business Intelligence platform server hosts
can process a queue of reporting information faster than a single SAP
BusinessObjects Business Intelligence platform server host.

• Load balancing

If a server is experiencing a higher load than the other servers in a cluster,
the CMS automatically sends new work to a server with better resources. •
Improved availability If a server encounters an unexpected condition, the
CMS automatically re-routes work to different servers until the condition
is corrected.

• Improved availability

If a server encounters an unexpected condition, the CMS automatically
re-routes work to different servers until the condition is corrected.

Node
A node is a collection of SAP BusinessObjects BI platform servers running on
the same host. One or more nodes can be on a single host.
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Server Intelligence Agent (SIA)
Server Intelligence Agent is a component of the Central Management Console
(CMC) to manage a collection or server processes, collectively known as a node.
Changes to server processes applied in the CMC are propagated to affected
servers by the Server Intelligence Agent. The SIA is also used for the automatic
restart or shutdown of a server if it encounters an unexpected condition, and is
used by the Central Management Server (CMC) to manage nodes.
The Agent (SIA) server archives server information in the CMS system database
so you can easily restore default server settings, or create redundant instances of
server processes with the same settings.

SAP BusinessObjects BI platform consists of collections of servers running on one or
more hosts. Small installations (such as test or development systems) can use a single
host for a web application server, database server, and all SAP BusinessObjects BI
platform servers.

Medium and large installations can have servers running on multiple hosts. For
example, a web application server host can be used in combination with an SAP
BusinessObjects BI platform server host. This frees up resources on the SAP
BusinessObjects BI platform server host, allowing it to process more information than
if it also hosted the web application server.

Large installations can have several SAP BusinessObjects BI platform server hosts
working together in a cluster. For example, if an organization has a large number of
SAP Crystal Reports users, Crystal Reports processing servers can be created on
multiple SAP BusinessObjects BI platform server hosts to ensure that there are plenty
of resources available to process requests from clients.

2012 © 2012 SAP AG. All rights reserved. 7
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Figure 2: Services and servers

Note: The nodes, servers, and services shown are for illustrative purposes
only. The number of hosts, nodes, servers and services, as well as the type of
servers, and services, will vary in real-world installations.

In this figure two hosts form the cluster named ProductionBISystem, with two hosts:

• The host named HostAlpha has two nodes:

– NodeMercury: contains an Adaptive Job Server (NodeMercury.AJS) with
services to schedule and publish reports, an Input File Repository Server
(NodeMercury.IFRS) with a service to store input reports, and an Output
File Repository Server (NodeMercury.OFRS) with a service to store report
output

– NodeVenus: contains an Adaptive Processing Server (NodeVenus.APS)
with services to provide publishing, monitoring, and translation features, an
Adaptive Processing Server (NodeVenus.APS2) with a service to provide
client auditing, and a Central Management Server (NodeVenus.CMS) with
a service to provide the CMS services.

• The host named HostBeta has three nodes:
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– NodeMars: contains a Central Management Server (NodeMars.CMS) with
a service to provide the CMS services.

– NodeJupiter: contains an Web Intelligence Processing Server
(NodeJupiter.WebIntelligence) with a service to provide Web Intelligence
documents, and an Event Server (NodeJupiter.EventServer) to provide
report monitoring of files.

– NodeSaturn: contains an Adaptive Processing Server (NodeSaturn.APS)
with a service to provide client auditing.

Architecture
The architecture of SAP BusinessObjects Business Intelligence platform is designed
to meet the needs of virtually any BI deployment, and is flexible enough to grow
from several users with a single tool, to tens of thousands of users with multiple
tools and interfaces.

Developers can integrate SAP BusinessObjects BI into your organization's other
technology systems by using web services, Java, or .NET application programming
interfaces (APIs).

Figure 3: Architecture
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Tiers
SAP BusinessObjects Business Intelligence platform can be thought of as a series
of conceptual tiers:

Client

Figure 4: Client

Group Tool

BI Client Analysis, edition for MS Office (Excel and PPT plugin)
SAP BusinessObjects Analysis, edition for Microsoft Office,
is a plugin that integrates into Microsoft Excel and Microsoft
PowerPoint to be used as an online analytical processing (OLAP)
tool. It provides access to a range of OLAP data sources, and
also allows users to combine information from different systems
within a single workspace.

Analysis, edition for OLAP (web client)
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Group Tool

SAP BusinessObjects Analysis, edition for OLAP (formerly
Voyager) is an online analytical processing (OLAP) tool for
working with multi-dimensional data. It provides access to a
range of OLAP data sources, and can also combine information
from different OLAP data sources within a single workspace.

BI launch pad (web client)
BI launch pad (formerly InfoView) is the main web interface for
business users to view, schedule, and keep track of published
business intelligence documents. BI launch pad can access,
interact with, and export, any type of business intelligence
including reports, analytics, dashboards, scorecards, and strategy
maps. It simplifies information delivery and delivers secure
access to BI content and tools, such as BI workspaces, SAP
BusinessObjects Web Intelligence, SAP BusinessObjects
Explorer, and SAP BusinessObjects Analysis, edition for OLAP.

BI workspaces (web client)
BI workspaces (formerly Dashboard Builder) helps you track
your business activities and performance using modules
(templates for data) and Business Intelligence (BI) workspaces
(for viewing data in one or more modules). Modules and BI
workspaces provide information needed to adjust business
rules as conditions change. It helps you track and analyze key
business data. It also supports group decision-making and
analysis via integrated collaboration and workflow capabilities.
BI workspaces enables you to organize content in pages, create
mash-ups of Business Intelligence content, and present the
information in a way that is tailored to the role of the user, either
for personal use or for sharing with others

Business View Manager
Business View Manager allows users to build semantic layer
objects that simplify underlying database complexity. Business
View Manager can create data connections, dynamic data
connections, data foundations, business elements, business
views, and relational views. It also allows detailed column and
row-level security to be set for the objects in a report. Designers
can build connections to multiple data sources, join tables, alias
field names, create calculated fields, and then use the simplified
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Group Tool
structure as a Business View. Report designers and users can
then use the business view as the basis for their Crystal reports,
rather than building their own queries from the data directly.

Crystal Reports 2011
SAP Crystal Reports 2011 is a Windows-based report design tool
used to create powerful reports that can be published in the SAP
BusinessObjects Business Intelligence platform.

Crystal Reports for BI platform
SAP Crystal Reports for Enterprise is a Java-based report design
tool used to create and integrate powerful reports in the SAP
BusinessObjects Business Intelligence platform.

Crystal Reports Viewer 2011
SAP Crystal Reports Viewer 2011 is a Java-based tool to view
Crystal reports.

Dashboards
SAP BusinessObjects Dashboards (formerly Xcelsius) is a tool
for data visualization and the creation of dynamic, interactive
dashboards. Data can be updated dynamically from the SAP
BusinessObjects Business Intelligence platform, and exported
to a variety of different formats that can be viewed by data
consumers in standard formats, such as PowerPoint, PDF, or
Flash.

Explorer
SAP BusinessObjects Explorer is an information-discovery tool
that empowers everyone in an organization with fast, easy access
to information, so they can explore data, spark new ideas, and
find new insights.

Information Design Tool
The Information Design Tool is an SAP BusinessObjects
metadata design environment that enables a designer to extract,
define, and manipulate metadata from relational and OLAP
sources to create and deploy UNX universes.

Live Office
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Group Tool

SAP BusinessObjects Live Office integrates with the Microsoft
Office environment, allowing dynamically updated data to
be embedded within Microsoft PowerPoint, Excel, and Word
documents. In addition, you can share your documents with
others over the web for collaborative decision-making.

Web Service Query Tool
The Web Service Query Tool (formerly Query as a Web Service)
allows Business Intelligence queries to be used in custom web
applications. Business users create their own queries from a
universe connection and publish them as web services so they
can be incorporated into client applications.

Universe Design Tool
The Universe Design Tool (formerly Universe Designer) allows
data designers to combine data from multiple sources in a
semantic layer (UNV universe) that hides database complexity
from end users. It abstracts the complexity of data by using
business rather than technical language to access, manipulate,
and organize data.
Universe design tool provides a graphical interface to select and
view tables in a database. The database tables are represented
as table symbols in a schema diagram. Designers can use this
interface to manipulate tables, create joins between tables, create
alias tables, create contexts, and solve loops in a schema. You
can also create universes from metadata sources. Universe
design tool is used for the universe generation at the end of the
creation process.

Web Intelligence Desktop
SAP BusinessObjects Web Intelligence Desktop is an ad-hoc
analysis and reporting tool for business users with or without
access to the SAP BusinessObjects Business Intelligence
platform. It allows business users to access and combine
data from relational, online analytical processing (OLAP),
spreadsheet, or text file sources, using familiar business terms in
a drag-and-drop interface. Workflows allow very broad or very
narrow questions to be analyzed, and for further questions to be
asked at any point in the analysis workflow. Web Intelligence

2012 © 2012 SAP AG. All rights reserved. 13
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Group Tool
Desktop users can continue working with Web Intelligence
document files (.wid) even when unable to connect to a Central
Management Server (CMS).

Web Intelligence (web client)
SAP BusinessObjects Web Intelligence is an ad-hoc analysis
and reporting tool for business users with access to the SAP
BusinessObjects Business Intelligence platform. It allows
business users to access and combine data from relational, online
analytical processing (OLAP), spreadsheet, or text file sources,
using familiar business terms in a drag-and-drop interface.
Workflows allow very broad or very narrow questions to be
analyzed, and for further questions to be asked at any point in
the analysis workflow.

Widgets
SAP Widgets (formerly BI Widgets) ) are mini-applications that
allow easy and fast access to frequently used functions and
provide visual information from your desktop. SAP Widgets
allow your organization to provide access to existing BI content
on the SAP BusinessObjects Business Intelligence platform. Or
you can add Web Dynpro applications, that are registered as
Extensible Business Client Markup Language (XBCML) widgets
on the SAP NetWeaver Application Servers, as desktop widgets.

Admin
Client Central Configuration Manager

The Central Configuration Manager (CCM) is a server
troubleshooting and node management tool provided in two
forms. In a Microsoft Windows environment, the CCM allows
you to manage local and remote servers through its graphical user
interface (GUI) or from a command line. In a Unix environment,
the CCM shell script (ccm.sh) allows you to manage servers
from the command-line. The CCM allows you to create and
configure Server Intelligence Agent (SIA) nodes and start or stop
your web application server. On Windows, it also allows you
to configure network parameters, such as Secure Socket Layer
(SSL) encryption. These parameters apply to all servers within
a node. Note: Most server management tasks are now handled
through the Central Management Console (CMC), not through
the CCM. The CCM is now used for troubleshooting and node
configuration.
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Group Tool

Central Management Console (web client).
The Central Management Console (CMC) is the main
web interface to perform administrative tasks in the SAP
BusinessObjects Business Intelligence platform, including user,
content, and server management. It also allows you to publish
and organize content, and configure security settings.

Data Federation Administration Tool
The Data Federation Administration Tool (formerly Data
Federator) is a rich client application that offers easy-to-use
features to manage your data federation service. Tightly
integrated in the SAP BusinessObjects Business Intelligence
platform, the data federation service enables multi-source
universes by distributing queries across disparate data sources,
and lets you federate data through a single data foundation.The
Data Federation Administration tool lets you optimize data
federation queries and fine-tune the data federation query engine
for the best possible performance.

Lifecycle Management Console (web client)
The Lifecycle Management Console provides a centralized view
to monitor the progress of the entire lifecycle process. It is used
to promote content from one SAP BusinessObjects Business
Intelligence platform to another of the same version.

Report Conversion Tool
The Report Conversion Tool converts Desktop Intelligence
reports to Web Intelligence format, and publishes them to a
Central Management Server (CMS).The Report Conversion Tool
also lets you audit your converted reports. This helps identify
reports that cannot be fully converted, and explains why.

Repository Diagnostic Tool
The Repository Diagnostic Tool scans, diagnoses, and repairs
inconsistencies that may occur between the Central Management
Server (CMS) system database and the File Repository Servers
(FRS) filestore. It can also report the repair status and completed
actions.

Translation Management Tool
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Group Tool

The Translation Management Tool defines multilingual universes
and manages translation of universes and their Web Intelligence
documents and prompts.

Upgrade Management Tool
The Upgrade management tool (formerly Import Wizard) guides
administrators through the process of importing users, groups,
and folders from previous versions of the SAP BusinessObjects
Business Intelligence platform (formerly know as SAP
BusinessObjects Enterprise). It also allows you to import and
upgrade objects, events, server groups, repository objects, and
calendars.

WDeploy
WDeploy is a tool to assist in deploying SAP BusinesObjects
Business Intelligence platform web applications, such as BI
launch pad and the Central Management Console, to target
application servers.

Note: Key administrative tools for administrators are Central Management
Console (CMC), Central Configuration Manager (CCM), Repository
Diagnostic Tool, and Upgrade management tool.
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Web

Figure 5: Web

Web Server
The web server receives HTTP requests sent from the web client. The web
server holds and manages static content such as .html and .js files that may be
part of a SAP BusinessObjects Business Intelligence suite web application.

Web Application Server
A web application server acts as the translation layer between a web browser or
rich application, and the SAP BusinessObjects Business Intelligence platform.
The web application server hosts web applications, web services and Software
Development Kits (SDK). Various web application servers running on Windows,
Unix, and Linux are supported. Note: If you do not have a web application
server in place for use with the SAP BusinessObjects Business Intelligence
platform, the installation program can install and configure a Tomcat 6 web
application server for you.
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Web Application Container Server
The Web Application Container Server (WACS) is an SAP BusinessObjects
Business Intelligence platform server that allows SAP BusinessObjects Business
Intelligence platform web services and web applications, such as the Central
Management Console (CMC) and BI launch pad, to run without the need for a
previously installed Java web application server.

Web Applications
Web applications run in the web application server to process requests from the
web client. SAP BusinessObjects Business Intelligence suite web applications
include:

• Central Management Console
• Lifecycle Management Console
• BI launch pad
• BI workspaces
• SAP BusinessObjects Web Intelligence
• SAP BusinessObjects Analysis, edition for OLAP
• SAP BusinessObjects Explorer
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Web Services
Web services run in the web application server to process requests from client
applications. Web services can be called remotely using the Simple Object
Access Protocol (SOAP) for exchanging information that is not dependent on a
specific platform, object model, or programming language.
SAP BusinessObjects web services include logic to understand and direct
requests to the appropriate SAP BusinessObjects Business Intelligence platform
server. SAP BusinessObjects web services can be accessed by rich clients
such as Live Office and Crystal Reports, and also by custom-built web service
consumer applications.
SAP BusinessObjects Business Intelligence platform web services include:

• Session
• BIPlatform
• ReportEngine
• QueryService
• SaveService
• BICatalog
• Publish
• LiveOffice
• managequeryasaservice
• Federator
• XcelsiusWebServices
• BicsRemote
• Gopher
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Management

Figure 6: Management

Central Management Server
The Central Management Server (CMS) maintains a database of information
about your SAP BusinessObjects Business Intelligence platform (in the CMS
system database) and audited user actions (in the Auditing Data Store). All
platform services are managed by the CMS. The CMS also controls access to the
system files where documents are stored, and information on users, user groups,
security levels (including authentication and authorization), and content.

Event Server
The Event Server monitors the system for events, which can act as a trigger for
running a report. When you set up a event trigger, the Event Server monitors
the condition and notifies the CMS that an event has occurred. The CMS can
then start any jobs that are set to run upon the event.

Explorer Master Server
Explorer Master Server manages all of the Explorer processing servers,
including: Explorer Exploration Server, Explorer Indexing Server, and Explorer
Search Server

20 © 2012 SAP AG. All rights reserved. 2012



BOE330 Lesson: SAP BusinessObjects BI Platform Architecture

Server Intelligence Agent
A Server Intelligence Agent (SIA) manages and monitors all of the servers
on a node, ensuring they operate properly. Note: A node is a group of SAP
BusinessObjects Business Intelligence platform servers that run on the same
host. All of the servers on a node run under the same user account. One machine
can contain many nodes, so you can run processes under different user accounts.

Storage

Figure 7: Storage

Crystal Reports Cache Server
The Crystal Reports Cache Server intercepts report viewing requests sent from
clients to the Crystal Reports Processing Server. If the Cache Server cannot
fulfill the request with a cached report page, it passes the request on to the
Crystal Reports Processing Server, which runs the report and returns the results.
The Cache Server then caches the report page for potential future use.
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Dashboard Design Cache Server
The Dashboard Design Cache Server determines if a previously served
dashboard viewing request would satisfy the current dashboard viewing request.
If the request cannot be fulfilled by the Dashboard Design Cache Server, it
forwards the request to the Dashboard Design Processing Server. The Dashboard
Design Cache Server will try to share previous data results as much as possible.

Input File Repository Server
The Input File Repository Server stores all of the documents and program objects
that have been published to the SAP BusinessObjects Business Intelligence
platform. It can store a large variety of file types.

Output File Repository Server
The Output File Repository Server stores all of the instances generated by
scheduled jobs for all object types including Crystal Reports, Web Intelligence,
and programs. It can store a large variety of file types.

Processing

Figure 8: Processing
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Adaptive Job Server
The Adaptive Job Server is a generic server that processes scheduled jobs for
a variety of object types. Services that can be hosted on this server include:
Authentication Update Scheduling Service, Crystal Reports 2011 Scheduling
Service, Crystal Reports Scheduling Service, Destination Delivery Scheduling
Service, Lifecycle Management Scheduling Service, Platform Search Scheduling
Service, Probe Scheduling Service, Program Scheduling Service, Publication
Scheduling Service, Replication Service, Security Query Scheduling Service,
Visual Difference Scheduling Service, Web Intelligence Scheduling Service.

Adaptive Processing Server
The Adaptive Processing Server is a generic server that hosts services responsible
for processing requests from a variety of sources. Services that can be hosted
on this server include: Adaptive Connectivity Service, BEx Web Application
Service, Client Auditing Proxy Service, Custom Data Access Service, Data
Federation Service, Document Recovery Service, DSL Bridge Service, Excel
Data Access Service, Lifecycle Management ClearCase Service, Lifecycle
Management Console Service, Monitoring Service, Multi Dimensional Analysis
Service, Platform Search Service, Publishing Post Processing Service, Publishing
Service, Rebean Service, Security Token Service, Translation Service, Visual
Difference Service, Visualization Service, Web Intelligence Monitoring Service.

Connection Server
The Connection Server provides database access to source data. It supports
relational databases, as well as OLAP and other formats. The Connection Server
is responsible for handling connection and interaction with the various data
sources and providing a common feature set to clients.

Connection Server 32
The Connection Server 32 is responsible for 32-bit database connectivity to
access data.

Crystal Reports 2011 Processing Server
The Crystal Reports 2011 Processing Server responds to Crystal Reports page
requests by processing reports and generating encapsulated page format (EPF)
files. The key benefit of EPF is that it supports page-on-demand access, so only
the requested page is returned, not the entire report. This improves system
performance and reduces unnecessary network traffic for large reports. The
Crystal Reports 2011 Processing Server retrieves data for the report from the
latest instance or directly from the data source. After it generates the report, it
converts the requested data to one or more EPF files. These EPF files are then
sent to the Crystal Reports Cache Server.
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Crystal Reports 2011 Report Application Server
The Crystal Reports 2011 Report Application Server (RAS) provides ad-hoc
reporting capabilities that allow users to create and modify Crystal reports via
the SAP Crystal Reports Server Embedded Software Development Kit (SDK).

Crystal Reports Processing Server
The Crystal Reports Processing Server responds to Crystal Reports for Enterprise
page requests by processing reports and generating encapsulated page format
(EPF) files. The key benefit of EPF is that it supports page-on-demand access, so
only the requested page is returned, not the entire report. This improves system
performance and reduces unnecessary network traffic for large reports. The
Crystal Reports Processing Server retrieves data for the report from the latest
instance or directly from the data source. After it generates the report, it converts
the requested data to one or more EPF files. These EPF files are then sent to the
Crystal Reports Cache Server.

Dashboard Analytics Server
The Dashboard Analytics Server is used by BI workspaces to create and manage
corporate and personal BI workspace module content.

Dashboard Design Processing Server
The Dashboard Design Processing Server responds to Dashboards requests by
processing dashboards and generating the results.

Dashboard Server
The Dashboard Server is used by BI workspaces to create and manage corporate
and personal dashboards.

Explorer Exploration Server
Explorer Exploration Server provides and manages the Information Space
exploration and analysis capabilities including search on data, filtering and
aggregation.

Explorer Indexing Server
Explorer Indexing Server provides and manages the indexing of Information
Space data and metadata.

Explorer Search Server
Explorer Search Server processes search queries and returns search results.
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Web Intelligence Processing Server
The Web Intelligence Processing Server is responsible for generating Web
Intelligence documents. The Web Intelligence Processing Server obtains
document creation requests from the Web Application Server and then
communicates with the Input File Repository Server in order to obtain a copy of
the Web Intelligence document (WID) file and the universe definition. When
viewing an existing instance of a WID, the Web Intelligence Processing Server
communicates with the Output File Repository Server to obtain an existing
historical instance of a WID.

Data

Figure 9: Data

CMS system database
The CMS system database is used to store SAP BusinessObjects Business
Intelligence platform information, such as user, server, folder, document,
configuration, authorization, and authentication details. It is maintained by the
Central Management Server (CMS), and is sometimes referred to as the system
repository.
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Auditing Data Store
The Auditing Data Store (ADS) is used to store information on trackable events
that occur in SAP BusinessObjects BI platform. This information can be used
to monitor the usage of system components, user activity, or other aspects of
day-to-day operation.

Lifecycle Management database
The Lifecycle Management database tracks configuration and version
information related to an SAP BusinessObjects Business Intelligence platform
installation, as well as updates.

Monitoring database
The Monitoring database is an embedded Java Derby database to store system
configuration and component information for SAP supportability in the SAP
BusinessObjects Business Intelligence platform.

Universes (UNV)
UNV Universes are identified by the .unv file extension. They are the legacy
type of universe based on the semantic layer in previous versions of the
SAP BusinessObjects Business Intelligence platform. They are built using
the legacy Universe Design Tool. A universe is an organized collection of
metadata objects that enables business users to analyze and report on corporate
data in non-technical language. These objects include dimensions, measures,
hierarchies, attributes, pre-defined calculations, functions, and queries. The
metadata object layer is built on a relational database schema or an OLAP cube,
so the objects map directly to the database structures. A universe includes
connections to the data sources so that users of query and analysis tools can
connect to a universe and run queries and create reports using the objects in a
universe without needing to know about the underlying data structures in the
database.

Universes (UNX)
UNX Universes are identified by the .unx file extension. They are the new
type of universe based on the new semantic layer in the SAP BusinessObjects
Business Intelligence 4.0 platform. They are built using the new Information
Design Tool. A universe is an organized collection of metadata objects that
enables business users to analyze and report on corporate data in non-technical
language. These objects include dimensions, measures, hierarchies, attributes,
pre-defined calculations, functions, and queries. The metadata object layer is
built on a relational database schema or an OLAP cube, so the objects map
directly to the database structures. A universe includes connections to the data
sources so that users of query and analysis tools can connect to a universe and
run queries and create reports using the objects in a universe without needing to
know about the underlying data structures in the database.
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Business Views
Business Views simplify report creation and interaction by abstracting the
complexity of data for report developers. Business Views help separate the data
connections, data access, business elements, and access control. Business Views
can only be used by Crystal Reports and are designed to simplify the data access
and view-time security required for Crystal report creation. Business Views
support the combination of multiple data sources in a single view.

Flat files
Flat files include .txt, .csv, and .xls files.

Relational databases
Relational databases store data in two-dimensional tables.

OLAP data sources
OLAP data sources store data in multi-dimensional cubes.

SAP Business Warehouse
SAP NetWeaver Business Warehouse (BW) is the OLAP data source from SAP.

SAP Business Explorer queries
SAP Business Explorer (BEx) queries are used to analyze data in SAP NetWeaver
Business Warehouse. BEx queries are built in the BEx query designer.
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Log on to SAP BusinessObjects Business Intelligence
platform
The following steps explain how CMS validates users when you log on to SAP
BusinessObjects Business Intelligence platform.

1. The user sends the log in request from the BI launch pad web client through
the web server to the web application server, where the BI launch pad web
application is running.

Note: This log on process also applies to other web clients, such as the
Central Management Console (CMC).

2. The web application server determines that the request is a logon request. The
web application server sends the username, password, and authentication type to
the Central Management Server (CMS) for authentication.

3. The CMS validates the username and password against the appropriate
database. In this case, Enterprise authentication is used, so user credentials are
authenticated against the CMS system database.

4. Upon successful validation, the CMS creates a session for the user in memory.
5. The CMS sends a response to the web application server to let it know that

the validation was successful.
6. The web application server generates a logon token for the user session in

memory. For the rest of this session, the web application server uses the logon
token to validate the user against the CMS. The web application server also
generates the next web page to send to the web client.

7. The web application server sends the next web page to the web server.
8. The web server sends the web page to the web client.

28 © 2012 SAP AG. All rights reserved. 2012



BOE330 Lesson: SAP BusinessObjects BI Platform Architecture

Figure 10: Log on to SAP BusinessObjects Business Intelligence platform

Setting a schedule for a Web Intelligence document
1. The web client submits a schedule request in an URL, typically via the web

server to the Web Application Server.
2. The Web Application Server interprets the URL request and determines that the

request is a schedule request. The Web Application Server sends the schedule
time, database login values, parameter values, destination, and format to the
specified CMS.

3. The CMS ensures that the user has rights to schedule the object. If the user has
sufficient rights, the CMS adds a new record to the system database. The CMS
also adds the instance to its list of pending schedules.
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Start the Server Intelligence Agent
This following steps explain the interaction of platform components when the Server
Intelligence Agent is started.

1. The user starts the Server Intelligence Agent (SIA) manually in the Central
Configuration Manger (CCM).

Note: Note: A Server Intelligence Agent (SIA) can be configured to start
automatically with the operating system, or it can be started manually
with the Central Configuration Manager (CCM).

2. The Server Intelligence Agent (SIA) looks in its cache to locate a Central
Management Server (CMS). If the SIA is configured to start a local CMS, and
the CMS is not running, the SIA starts the CMS and connects. If the SIA is
configured to use a running CMS (local or remote), it attempts to connect to
the first CMS in its cache. If the CMS is not currently available, it attempts to
connect to the next CMS in its cache. If no cached CMS is available, the SIA
waits for one to become available. The CMS then confirms the SIA's identity to
ensure that it is valid.

3. Once the SIA has successfully connected to a CMS, it requests a list of servers to
manage. Note: A SIA does not store information about the servers it manages.
The configuration information that dictates which server is managed by a SIA
is stored in the CMS system database and is retrieved from the CMS by the
SIA when it starts.

4. The CMS queries the CMS system database for a list of servers managed by the
SIA. The configuration for each server is also retrieved.

5. The CMS returns the list of servers to manage, and their configuration, to the SIA.
6. For each server configured to start automatically, the SIA starts it with the

appropriate configuration and monitors its state. Each server started by the SIA
is configured to use the same CMS used by the SIA. Any servers that are not
configured to start automatically with the SIA will not start.
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Figure 11: Start the Server Intelligence Agent

Run a schedule for a Web Intelligence document
The following steps explain the interaction of platform components when a scheduled
Web Intelligence document is run to create a document instance.

1. The Central Management Server (CMS) checks the CMS system database to
determine if there is any scheduled Web Intelligence document to be run at
that time.

2. When the scheduled job time arrives, the CMS locates an available Web
Intelligence Scheduling Service running on an Adaptive Job Server. The CMS
sends the schedule request and all information about the request to the Web
Intelligence Scheduling Service.

3. The Web Intelligence Scheduling Service locates an available Web Intelligence
Processing Server based on the Maximum Jobs Allowed value configured on
each Web Intelligence Processing Server.

4. The Web Intelligence Processing Server determines the location of the Input File
Repository Server (FRS) that houses the document and the universe metalayer
file on which the document is based. The Web Intelligence Processing Server
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then requests the document from the Input FRS. The Input FRS locates the Web
Intelligence document as well as the universe file on which the document is
based, and then streams them to the Web Intelligence Processing Server.

Note: This step also requires communication (not shown in this
diagram) with the Central Management Server (CMS) and the CMS
system database to locate the required server and objects.

5. The Web Intelligence document is placed in a temporary directory on the Web
Intelligence Processing Server. The Web Intelligence Processing Server opens
the document in memory. The QT.dll generates the SQL from the universe on
which the document is based. The Connection Server libraries included in the
Web Intelligence Processing Server are used to connect to the data source, which
is a relational database in this example. The queried data passes through QT.dll
back to the Report Engine in the Web Intelligence Processing Server, where the
document is processed. A new successful instance is created.

6. The Web Intelligence Processing Server uploads the document instance to the
Output File Repository Server. Note: this step also requires communication (not
shown in this diagram) with the Central Management Server (CMS) and the
CMS system database to locate the required server and objects.

7. The Web Intelligence Processing Server notifies the Web Intelligence Scheduling
Service (on the Adaptive Job Server) that document creation is completed. If the
document is scheduled to go to a destination such as file system, FTP, SMTP,
or Inbox, the Adaptive Job Server retrieves the processed document from the
Output File Repository Server and delivers it to the specified destinations. That
is not the case in this example.

8. The Web Intelligence Scheduling Service updates the Central Management
Server with the job status.

9. The Central Management Server (CMS) updates the job status in its memory,
and then writes the instance information to the CMS system database.
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Figure 12: Run a scheduled SAP BusinessObjects Web Intelligence document
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View a Web Intelligence document on demand
The following steps explain the interaction of platform components when you view a
Web Intelligence document on demand to see the most current data available.

1. The user sends the view request from the BI launch pad web client through
the web server to the web application server, where the BI launch pad web
application is running.

2. The web application server recognizes the request as a request to view a
Web Intelligence document. The web application server checks the Central
Management Server (CMS) to ensure the user has sufficient rights to view the
document.

3. The CMS checks the CMS system database to determine if the user has the
appropriate rights to view the document.

4. The CMS sends a response to the web application server to confirm that the user
has sufficient rights to view the document.

5. The web application server sends a request to the Web Intelligence Processing
Server, requesting the document.

6. The Web Intelligence Processing Server requests the document, and the universe
file on which the requested document is built, from the Input File Repository
Server (FRS). The universe file contains metalayer information, including
row-level and column-level security. The Input FRS sends a copy of the
document and the universe to the Web Intelligence Processing Server.

Note: This step also requires communication (not shown in this
diagram) with the Central Management Server (CMS) and the CMS
system database to locate the required server and objects.

7. The Web Intelligence Report Engine runs on the Web Intelligence Processing
Server. The Report Engine opens the document in memory and launches QT.dll
and a Connection Server in process. QT.dll generates, validates, and regenerates
the SQL and connects to the database to run the query. The Connection Server
uses the SQL to get the data from the database to the Report Engine, where the
document is processed.

8. The Web Intelligence Processing Server sends the viewable document page that
was requested to the web application server.

9. The web application server forwards the document page to the web server.
10. The web server sends the requested page to be rendered in the web client.
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Figure 13: View an SAP BusinessObjects Web Intelligence document on demand
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Exercise 1: Test your knowledge in SAP
BusinessObjects Business Intelligence
Platform

Exercise Objectives
After completing this exercise, you will be able to:
• Describe the servers and client applications in SAP BusinessObjects Business

Intelligence platform.

Business Example
As the system administrator, you need to describe the servers and client applications
in SAP BusinessObjects Business Intelligence platform.

Task: Test your knowledge
Use the interactive media files that come with the course to test your knowledge in
SAP BusinessObjects Business Intelligence platform.

1. Launch the first media file and complete the activity Hangman.

2. Launch the second media file and complete the activity Application Terms
and Definitions Matching.

3. Launch the third media file and complete the activity Server Terms and
Definition Matching.
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Solution 1: Test your knowledge in SAP
BusinessObjects Business Intelligence
Platform
Task: Test your knowledge
Use the interactive media files that come with the course to test your knowledge in
SAP BusinessObjects Business Intelligence platform.

1. Launch the first media file and complete the activity Hangman.

a) Navigate to the media folder and double-click Hangman.html.

2. Launch the second media file and complete the activity Application Terms
and Definitions Matching.

a) Navigate to the media folder and double-click 5Terms_Definition_Match-
ing.html.

3. Launch the third media file and complete the activity Server Terms and
Definition Matching.

a) Navigate to the media folder and double-click Server_TandD_Match-
ing.html.
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Lesson Summary

You should now be able to:
• Define SAP BusinessObjects BI platform architecture terms
• Describe key architectural process flows

2012 © 2012 SAP AG. All rights reserved. 39



Unit 1: Reviewing Architecture, Administration, and Security in SAP
BusinessObjects BI Platform, BOE330

Lesson: SAP BusinessObjects BI Platform Security

Lesson Overview
A solid understanding of the SAP BusinessObjects BI platform security model is
essential for system architects. This lessons is a review of the security model.

Lesson Objectives
After completing this lesson, you will be able to:

• Understand how rights work in SAP BusinessObjects BI platform
• Describe how access levels are used
• Understand top-level, folder-level and object-level security
• Understand inheritance

Business Example

How rights work in SAP BusinessObjects BI platform
Rights are the base units for controlling user access to the objects, users, applications,
servers, and other features in SAP BusinessObjects BI platform. They play an
important role in securing the system by specifying the individual actions that
users can perform on objects. Besides allowing you to control access to your
SAP BusinessObjects BI platform content, rights enable you to delegate user and
group management to different departments, and to provide your IT people with
administrative access to servers and server groups. It is important to recognize the
difference between rights set on objects or folders, and rights set on principals (the
users and groups) who access them. For example, to give a manager access to a
particular folder, in the "Folders" area, you add the manager to the access control list
(the list of principals who have access to an object) for the folder. You cannot give the
manager access by configuring the manager's rights settings in the "Users and Groups"
area. The rights settings for the manager in the "Users and Groups" area are used to
grant other principals (such as delegated administrators) access to the manager as an
object in the system. In this way, principals are themselves like objects for others
with greater rights to manage. Each right on an object can be granted, denied, or
unspecified. The SAP BusinessObjects BI platform security model is designed such
that, if a right is left unspecified, the right is denied. Additionally, if settings result in a
right being both granted and denied to a user or group, the right is denied. There is
an important exception to this rule. If a right is explicitly set on a child object that
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contradicts the rights inherited from the parent object, the right set on the child object
overrides the inherited rights. This exception applies to users who are members of
groups as well. If a user is explicitly granted a right that the user's group is denied,
the right set on the user overrides the inherited right.

Terminology
Access levels

Access levels are groups of rights that users frequently need. They allow
administrators to set common security levels quickly and uniformly rather than
requiring that individual rights be set one by one. SAP BusinessObjects Business
Intelligence platform comes with several predefined access levels. These
predefined access levels are based on a model of increasing rights: Beginning
with View and ending with Full Control, each access level builds upon the rights
granted by the previous level.

Inheritance

Top-level folder security
Top-level folder security is the default security set for each specific object type
(for example Universes, Web Intelligence Application, Groups and Folders).
Each object type has its own top-level folder (root folder) that all the objects
below inherit rights from.
If there are any access levels common to certain object types that apply
throughout the whole system, set them at the top-level folder specific to each
object type. For example, if the Sales group requires the View access level to all
folders, you can set this at the root level for Folders.

Folder-level security
Folder-level security enables you to set access-level rights for a folder and the
objects contained within that folder. While folders inherit security from the
top-level folder (root folder), subfolders inherit the security of their parent folder.
Rights set explicitly at the folder level override inherited rights.

Object-level security
Objects in SAP BusinessObjects Business Intelligence platform inherit security
from their parent folder. Rights set explicitly at the object level override
inherited rights.
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Setting Rights
How rights work in SAP BusinessObjects Business
Intelligence platform
Rights are the base units for controlling user access to the objects, users, applications,
servers, and other features in SAP BusinessObjects Business Intelligence platform.
They play an important role in securing the system by specifying the individual
actions that users can perform on objects. Besides allowing you to control access to
your SAP BusinessObjects Business Intelligence platform content, rights enable you
to delegate user and group management to different departments, and to provide your
IT people with administrative access to servers and server groups.

It is important to recognize the difference between rights set on objects or folders, and
rights set on principals (the users and groups) who access them. For example, to give a
manager access to a particular folder, in the Folders area, you add the manager to the
access control list (the list of principals who have access to an object) for the folder.
You cannot give the manager access by configuring the manager's rights settings in the
"Users and Groups" area. The rights settings for the manager in the Users and Group
area are used to grant other principals (such as delegated administrators) access to the
manager as an object in the system. In this way, principals are themselves like objects
for others with greater rights to manage.

Each right on an object can be granted, denied, or unspecified. The SAP
BusinessObjects Business Intelligence platform security model is designed such that,
if a right is left unspecified, the right is denied. Additionally, if settings result in a right
being both granted and denied to an user or group, the right is denied.

There is an important exception to this rule. If a right is explicitly set on a child object
that contradicts the rights inherited from the parent object, the right set on the child
object overrides the inherited rights. This exception applies to users who are members
of groups as well. If an user is explicitly granted a right that the user's group is denied,
the right set on the user overrides the inherited right.

Advanced rights settings
To provide you with full control over object security, the CMC allows you to set
advanced rights. These advanced rights provide increased flexibility as you define
security levels for objects at a granular level.

Use advanced rights settings, for instance, if you need to customize a principal's
rights to a particular object or set of objects. Most importantly, use advanced rights to
explicitly deny a user or group any right that should not be permitted to change when,
in the future, you make changes to group memberships or folder security levels.

The following table summarizes the options that you have when you set advanced
rights.

42 © 2012 SAP AG. All rights reserved. 2012



BOE330 Lesson: SAP BusinessObjects BI Platform Security

Advanced rights

Rights option Description

Granted The right is granted to a principal.

Denied The right is denied to a principal.

Not Specified The right is unspecified for a principal.
By default, rights set to Not Specified
are denied.

Apply to Object The right applies to the object. This
option becomes available when you click
Granted or Denied.

Apply to Sub Objects The right applies to sub-objects. This
option becomes available when you click
Granted or Denied.

Type-specific rights

Type-specific rights are rights that affect specific object types only, such as Crystal
reports, folders, or access levels. Type-specific rights consist of the following:

• General rights for the object type

These rights are identical to general global rights (for example, the right to add,
delete, or edit an object), but you set them on specific object types to override the
general global rights settings.

• Specific rights for the object type

These rights are available for specific object types only. For example, the right to
export a report's data appears for Crystal reports but not for Word documents.

The diagram Type-specific rights example illustrates how type-specific rights work.
Here right 3 represents the right to edit an object.

Group A is denied Edit rights on the top-level folder and granted Edit rights for
Crystal reports in the folder and subfolder. These Edit rights are specific to Crystal
reports and override the rights settings on a general global level.

As a result, members of Group A have Edit rights for Crystal reports but not the
XLF file in the subfolder.

2012 © 2012 SAP AG. All rights reserved. 43



Unit 1: Reviewing Architecture, Administration, and Security in SAP
BusinessObjects BI Platform, BOE330

Figure 14: Type-specific rights example

Type-specific rights are useful because they let you limit the rights of principals based
on object type. Consider a situation in which an administrator wants employees to
be able to add objects to a folder but not create subfolders. The administrator grants
Add rights at the general global level for the folder, and then denies Add rights for
the folder object type.
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Rights are divided into the following collections based on the object types they
apply to:

• General

These rights affect all objects

• Content

These rights are divided according to particular content object types. Examples
of content object types include Crystal reports, and Adobe Acrobat PDFs.

• Application

These rights are divided according to which SAP BusinessObjects Business
Intelligence platform application they affect. Examples of applications include
the CMC and BI launch pad.

• System

These rights are divided according to which core system component they affect.
Examples of core system components include Calendars, Events, and Users
and Groups.

Type-specific rights are in the Content, Application, and System collections. In each
collection, they are further divided into categories based on object type.

Troubleshooting user rights
Troubleshooting user rights can be a laborious undertaking for a systems administrator.
The SAP BusinessObjects Business Intelligence platform contains two tools which
are aimed at negating this challenge.

• Permissions Explorer

The Permissions Explorer is aimed at making it easier to pinpoint the source of
inherited user rights.

• Security Query

The Security Query tool enables an administrator to list which objects a user can
access and why. It also enables the administrator to interactively make changes
to the security settings from the query result.

Managing security settings for objects in the CMC
You can manage security settings for most objects in the CMC with the security
options on theManage menu. These options let you assign principals to the access
control list for an object, view the rights that a principal has, and modify the rights that
the principal has to an object.
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Checking security settings for a principal
In some cases, you may want to know the objects to which a principal has been
granted or denied access. You can use a security query to do this. Security queries let
you determine which objects a principal has certain rights to and manage user rights.
For each security query, you provide the following information:

• Query Principal

You specify the user or group that you want to run the security query for. You
can specify one principal for each security query.

• Query Permission

You specify the right or rights you want to run the security query for, the status
of these rights, and the object type these rights are set on. For example, you can
run a security query for all reports that a principal can refresh, or for all reports
that a principal cannot export.

• Query Context

You specify the CMC areas that you want the security query to search. For each
area, you can choose whether to include sub-objects in the security query. A
security query can have a maximum of four areas.

Access level
Access levels are groups of rights that users frequently need. They allow
administrators to set common security levels quickly and uniformly rather than
requiring that individual rights be set one by one.

You can do the following with access levels:

• Copy an existing access level, make changes to the copy, rename it, and save it
as a new access level.

• Create, rename, and delete access levels.
• Modify the rights in an access level.
• Trace the relationship between access levels and other objects in the system.
• Trace the relationship
• Replicate and manage access levels across sites.
• Use one of the predefined access levels in SAP BusinessObjects Business

Intelligence platform to set rights quickly and uniformly for many principals.
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Predefined access levels
SAP BusinessObjects Business Intelligence platform comes with several predefined
access levels. These predefined access levels are based on a model of increasing
rights: Beginning with View and ending with Full Control, each access level builds
upon the rights granted by the previous level.

The following table summarizes the rights that each predefined access level contains.

Predefined access levels

Access level Description Rights involved

View If set on the folder level,
a principal can view the
folder, objects within the
folder, and each object's
generated instances. If
set at the object level, a
principal can view the
object, its history, and its
generated instances.

• View objects
• View document

instances

Schedule A principal can generate
instances by scheduling
an object to run against
a specified data source
once or on a recurring
basis. The principal
can view, delete, and
pause the scheduling of
instances that they own.
They can also schedule
to different formats
and destinations, set
parameters and database
logon information, choose
servers to process jobs,
add contents to the folder,
and copy the object or
folder.

View access-level rights,
plus:

• Schedule the
document to run

• Define server groups
to process jobs

• Copy objects to
another folder

• Schedule to
destinations

• Print the report's data
• Export the report's

data
• Edit objects that the

user owns
• Delete instances that

the user owns
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Access level Description Rights involved

• Pause and resume
document instances
that the user owns

View On Demand A principal can refresh
data on demand against a
data source.

Schedule access-level
rights, plus:

• Refresh the report's
data

Full Control A principal has full
administrative control of
the object.

All available rights,
including:

• Add objects to the
folder

• Edit objects
• Modify rights users

have to objects
• Delete objects
• Delete instances

No Access The user or group is not
able to access the object
or folder.

No rights

Hint: The following rights are required when using these access levels.

Access level task Rights required

Create an access level Add right on the Access Levels top-level folder

View granular rights
in an access level

View right on the access level

Assign an access level
to a principal on an
object

View right on the access level

Use the Access Level for Security Assignment
right on the access level

Modify Rights right on the object, or Securely
Modify Rights right on the object and the principal
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Access level task Rights required

Modify an access
level

View and Edit rights on the access level

Delete an access level View and Delete rights on the access level

Clone an access level View right on the access level
Copy right on the access level
Add right on the Access Levels top-level folder

Custom access levels
In addition to the predefined access levels, you can also create and customize your
own, which can greatly reduce administrative and maintenance costs associated with
security. Consider a situation in which an administrator must manage two groups,
sales managers and sales employees. Both groups need to access five reports in the
SAP BusinessObjects Business Intelligence platform system, but sales managers
require more rights than sales employees. The predefined access levels do not meet
the needs of either group. Instead of adding groups to each report as principals and
modifying their rights in five different places, the administrator can create two new
access levels, Sales Managers and Sales Employees. The administrator then adds
both groups as principals to the reports and assigns the groups their respective access
levels. When rights need to be modified, the administrator can modify the access
levels. Because the access levels apply to both groups across all five reports, the rights
those groups have to the reports are quickly updated.

Inheritance
Rights are set on an object for a principal in order to control access to the object
however, it is impractical to set the explicit value of every possible right for every
principal on every object. Consider a system with 100 rights, 1000 users, and 10,000
objects: to set rights explicitly on each object would require the CMS to store billions
of rights in its memory, and, importantly, require that an administrator manually set
each one.

Inheritance patterns resolve this impracticality. With inheritance, the rights that
users have to objects in the system come from a combination of their memberships
in different groups and subgroups and from objects which have inherited rights from
parent folders and subfolders. These users can inherit rights as the result of group
membership; subgroups can inherit rights from parent groups; and both users and
groups can inherit rights from parent folders.
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By default, users or groups who have rights to a folder inherit the same rights for
any objects that are subsequently published to that folder. Consequently, the best
strategy is to set the appropriate rights for users and groups at the folder level first,
then publish objects to that folder.

SAP BusinessObjects Business Intelligence platform recognizes two types of
inheritance:

1. Group inheritance
2. Folder inheritance

Group inheritance
Group inheritance allows principals to inherit rights as the result of group membership.
Group inheritance proves especially useful when you organize all of your users into
groups that coincide with your organization's current security conventions.

Figure 15: Group inheritance example 1

In Group inheritance example 1, you can see how group inheritance works. Group
B is a subgroup of Group A, so it inherits Group A’s rights. In this case, it inherits
right 1 as granted, and the rest of the rights as unspecified. Every member of Group
B inherits these rights. In addition, any other rights that are set on the subgroup are
inherited by its members. In this example, John is a member of Group B, and thus
inherits right 1 as granted, rights 2, 3, 4, and 6 as not specified, and Right 5 as denied.

When group inheritance is enabled for a user who belongs to more than one group, the
rights of all parent groups are considered when the system checks credentials. The
user is denied any right that is explicitly denied in any parent group, and the user is
denied any right that remains completely not specified thus, the user is granted only
those rights that are granted in one or more groups (explicitly or through access levels)
and never explicitly denied.
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In Group inheritance example 2, Green User is a member of two unrelated groups.
From Blue Group, he inherits rights 1 and 5 as "granted" and the rest as not specified;
however, because Green User also belongs to Red Group, and Red Group has been
explicitly denied right 5, Green User's inheritance to right 5 from Blue Group is
overridden.

Figure 16: Group inheritance example 2

Folder inheritance
Folder inheritance allows principals to inherit any rights that they have been granted
on an object's parent folder. Folder inheritance proves especially useful when you
organize SAP BusinessObjects Business Intelligence platform content into a folder
hierarchy that reflects your organization's current security conventions. For example,
suppose that you create a folder called Sales Reports, and you provide your Sales
group with View On Demand access to this folder. By default, every user that has
rights to the Sales Reports folder will inherit the same rights to the reports that you
subsequently publish to this folder. Consequently, the Sales group will have View On
Demand access to all of the reports, and you need set the object rights only once,
at the folder level.

In Folder inheritance example, rights have been set for Group on a folder. Rights
1 and 5 have been granted, while the rest have been left unspecified. With folder
inheritance enabled, members of Group have rights on the object level identical to
the rights of the group on the folder level. Rights 1 and 5 are inherited as granted,
while the rest have been left unspecified.
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Figure 17: Folder inheritance example

Rights override
Rights override is a rights behavior in which rights that are set on child objects
override the rights set on parent objects. Rights override occurs under the following
circumstances:

• In general, the rights that are set on child objects override the rights that are
set on parent objects.

• In general, the rights that are set on subgroups or members of groups override
the rights that are set on groups.

You do not need to disable inheritance to set customized rights on an object. The child
object inherits the rights settings of the parent object except for the rights that are
explicitly set on the child object. Also, any changes to rights settings on the parent
object apply to the child object.

Rights override example 1 illustrates how rights override works on parent and child
objects. A User is denied the right to edit a folder’s contents; the rights setting is
inherited by the subfolder. However, an administrator grants the User Edit rights to
a document in the subfolder. The Edit right that the User receives on the document
overrides the inherited rights that come from the folder and subfolder.
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Figure 18: Rights override example 1

Rights override example 2 illustrates how rights override works on members and
groups. Group 1 is denied the right to edit a folder; Group 1A inherits this rights
setting. However, an administrator grants John, who is a member of Group 1 and
Group 1A, Edit rights on the folder. The Edit rights that John receives on the folder
override the inherited rights that come from Group 1 and Group 1A.
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Figure 19: Rights override example 2

Complex rights override illustrates a situation where the effects of rights override
are less obvious. User is a member of subgroups 1A and 2A, which are in Groups 1
and 2, respectively. Groups 1 and 2 both have Edit rights on the folder. 1A inherits the
Edit rights that Group 1 has, but an administrator denies Edit rights to 2A. The rights
settings on 2A override the rights settings on Group 2 because of rights override.
Therefore, User inherits contradictory rights settings from 1A and 2A. 1A and 2A do
not have a parent-child relationship, so rights override does not occur; that is, one
sub-group’s rights settings do not override another’s because they have equal status.
In the end, User is denied Edit rights because of the “denial-based” rights model in
SAP BusinessObjects Business Intelligence platform.
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Figure 20: Complex rights override

Rights override lets you make minor adjustments to the rights settings on a child
object without discarding all inherited rights settings. Consider a situation in which
a sales manager needs to view confidential reports in the Confidential folder. The
sales manager is part of the Sales group, which is denied access to the folder and
its contents. The administrator grants the manager View rights on the Confidential
folder and continues to deny the Sales group access. In this case, the View rights
granted to the sales manager override the denied access that the manager inherits from
membership in the Sales group.

Scope of rights
Scope of rights refers to the ability to limit the extent of rights inheritance. To define
the scope of a right, you decide whether the right applies to the object, its sub-objects,
or both. By default, the scope of a right extends to both objects and sub-objects.

Scope of rights can be used to protect personal content in shared locations. Consider
a situation in which the finance department has a shared Expense Claims folder that
contains Personal Expense Claims subfolders for each employee. The employees want
to be able to view the Expense Claims folder and add objects to it, but they also want
to protect the contents of their Personal Expense Claims subfolders. The administrator
grants all employees View and Add rights on the Expense Claims folder, and limits
the scope of these rights to the Expense Claims folder only. This means that the
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View and Add rights do not apply to sub-objects in the Expense Claims folder. The
administrator then grants employees View and Add rights on their own Personal
Expense Claims subfolders.

Scope of rights can also limit the effective rights that a delegated administrator has.
For example, a delegated administrator may have Securely Modify Rights and Edit
rights on a folder, but the scope of these rights is limited to the folder only and does
not apply to its sub-objects. The delegated administrator cannot grant these rights to
another user on one of the folder's sub-objects.

Guidelines for planning security
Use the following principles as a guide for planning security in SAP BusinessObjects
Business Intelligence plaform.

General Rules

• Each right is also referred to as an Access Control Entry (ACE) in SAP
BusinessObjects BI platform and can be set to one of three states: Explicit
Denial (D), Explicit Grant (G), Not Specified (NS).

• A list of all ACEs is referred to as an Access Control List (ACL).
• A combination of ACEs and states (for example Right to Schedule - G, Right to

View - G, Right to Modify - D, and so on) makes up an Access Level.
• There are predefined Access Levels: No Access (Not Specified state for all

rights), Full Control, View, Schedule, View On Demand, and there are also
Custom Access Levels that administrators can create on their own.

• Groups and users in the system are also referred to as principals. In SAP
BusinessObjects BI platform you give rights to principals on objects (folder,
document, application)

• If a user belongs to more than one group, and there is a conflict in rights
assignments between the groups to which the user belongs to, the Denied (D)
right wins over a Granted (G) right, and the Granted (G) right wins over a Not
Specified (NS) right (Deny > Grant > Not Specified).

– G + NS = G
– G + D = D
– G + D + NS = D
– D + NS = D
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Hierarchical Rules

• A more specific assignment typically wins over a less specific assignment, such
as a user over a group, a subgroup over a parent group, and a sub-object over a
parent object.

• Groups may contain subgroups and/or users. Subgroups and users are treated
as members of the parent group. In other words, if a parent group is given an
explicit Grant right to view the folder, the user who is a member of a subgroup
of the parent group will have the right to view the folder as well. In this case
only the parent group is listed in the User Security dialog box on the folder
while the subgroup is not.

• The rights given to the group closest to the user take precedence (without
breaking inheritance). In other words, if a user is a member of a subgroup and
is not added to the parent group, the user's effective rights will come from the
subgroup, and not from the parent group. In this case both the parent group and
the subgroup are listed in the access rights dialog box on the folder. The rights
between the parent group and the subgroup may be the same or conflicting, but
rights assigned to the subgroup will take precedence.

• If a user is added to both the subgroup and to the parent group, the calculation
of effective rights is the same as if a user belonged to two groups on the same
level. Refer to the rule G + D + NS = D.

• User rights are of explicit type on the object, but of inherited type on sub-objects.
• Group rights are always of inherited type.
• Explicit rights (the user's rights) on an object overwrite inherited rights (the

group's rights) on the same object.
• Security rights can be overridden on lower levels in folder hierarchy without

breaking inheritance.
• The administrator can combine access levels for a principal which can result in a

conflict. In these cases, refer again to the rule G + D + NS = D.
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Summary of recommendations for rights administration
Keep these considerations in mind for rights administration:

• Use access levels wherever possible. These predefined sets of rights simplify
administration by grouping together rights associated with common user needs.

• Set rights and access levels on top-level folders. Enabling inheritance will allow
these rights to be passed down through the system with minimal administrative
intervention.

• Avoid breaking inheritance whenever possible. By doing so, you can reduce
the amount of time it takes to secure the content that you have added to SAP
BusinessObjects Business Intelligence platform.

• Set appropriate rights for users and groups at the folder level, then publish
objects to that folder. By default, users or groups who have rights to a folder will
inherit the same rights for any object that you subsequently publish to that folder.

• Organize users into user groups, assign access levels and rights to the entire
group, and assign access levels and rights to specific members when necessary.

• Create individual administrator accounts for each administrator in the system
and add them to the Administrators group to improve accountability for system
changes.

• By default, the Everyone group is granted with limited rights to top-level
folders. After installation, it is recommended that you review the rights of
Everyone group members and assign security accordingly.
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Lesson Summary

You should now be able to:
• Understand how rights work in SAP BusinessObjects BI platform
• Describe how access levels are used
• Understand top-level, folder-level and object-level security
• Understand inheritance
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Unit Summary
You should now be able to:
• Define SAP BusinessObjects BI platform architecture terms
• Describe key architectural process flows
• Understand how rights work in SAP BusinessObjects BI platform
• Describe how access levels are used
• Understand top-level, folder-level and object-level security
• Understand inheritance

Related Information
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Test Your Knowledge

1. In the context of SAP BusinessObjects BI platform, what is the difference
between a server and a service?

2. What is the Server Intelligence Agent?
The SIA is a locally run service managed by the operating system. The task
of the Server Intelligence Agent (SIA) is to start, stop, and monitor locally
run BusinessObjects servers. When one of the managed servers goes down
unexpectedly, the SIA restarts the server immediately. When you issue a
command in the CMC to stop a server, the SIA stops the server.

3. What is an Access Level?

4. List the options available when setting advanced rights.

5. Describe the concept of rights override.
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6. What is “scope of rights”?
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Answers

1. In the context of SAP BusinessObjects BI platform, what is the difference
between a server and a service?

Answer: A server is an Operating System (OS) level process hosting one or
more services. For example, CMS and Adaptive Processing Server are servers.
A server runs under a specific OS account and has its own PID. A service is a
server subsystem that provides a specific function. The service runs within the
memory space of its server under the Process ID (PID) of the parent container
(server). For example, the Web Intelligence Scheduling and Publishing Service
is a subsystem running within the Adaptive Job Server.

2. What is the Server Intelligence Agent?
The SIA is a locally run service managed by the operating system. The task
of the Server Intelligence Agent (SIA) is to start, stop, and monitor locally
run BusinessObjects servers. When one of the managed servers goes down
unexpectedly, the SIA restarts the server immediately. When you issue a
command in the CMC to stop a server, the SIA stops the server.

3. What is an Access Level?

Answer: Access levels are groups of rights that users frequently need. They
allow administrators to set common security levels quickly and uniformly rather
than requiring that individual rights be set one by one.

4. List the options available when setting advanced rights.

Answer: Granted, Denied, Not Specified, Apply to Object, Apply to
Sub-Objects.

5. Describe the concept of rights override.

Answer: Rights override is a rights behavior in which rights that are set on child
objects override the rights set on parent objects. Rights override occurs under
the following circumstances:

• In general, the rights that are set on child objects override the rights that are
set on parent objects.

• In general, the rights that are set on subgroups or members of groups
override the rights that are set on groups.
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6. What is “scope of rights”?

Answer: Scope of rights refers to the ability to limit the extent of rights
inheritance. To define the scope of a right, you decide whether the right applies
to the object, its sub-objects, or both. By default, the scope of a right extends to
both objects and sub-objects.
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Unit 2
Identifying Requirements

Unit Overview
This unit provides you with information for planning your SAP BusinessObjects
Business Intelligence platform deployment. It explains the key requirements and
choices you need to make before you begin your deployment.

Unit Objectives
After completing this unit, you will be able to:

• Consider the many different requirements that might affect a SAP
BusinessObjects Business Intelligence platform deployment

• Evaluate your organization's needs before you deploy your SAP BusinessObjects
Business Intelligence platform system

• Describe the checklist of criteria that helps you plan your SAP BusinessObjects
Business Intelligence platform deployment,

Unit Contents
Lesson: Planning your SAP BusinessObjects Business Intelligence platform
deployment .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
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Lesson: Planning your SAP BusinessObjects Business
Intelligence platform deployment

Lesson Overview
This lesson provides guidelines for assessing your organization's needs, and
suggestions for deployment scenarios.

Lesson Objectives
After completing this lesson, you will be able to:

• Consider the many different requirements that might affect a SAP
BusinessObjects Business Intelligence platform deployment

• Evaluate your organization's needs before you deploy your SAP BusinessObjects
Business Intelligence platform system

• Describe the checklist of criteria that helps you plan your SAP BusinessObjects
Business Intelligence platform deployment,

Business Example
By evaluating your needs before you deploy your SAP BusinessObjects Business
Intelligence platform system, you can keep troubleshooting to a minimum.

Planning your deployment
Planning your deployment involves the following steps:.

1. Refer to the SAP BusinessObjects Business Intelligence platform supported
platform document at: http://support.businessobjects.com/documentation/sup-
ported_platforms.

2. Review the key concepts you need to consider for your deployment, including
operating system, database, and application server considerations, in addition to
security, performance and scalability, and high availability. See Assessing your
organization's environment.

3. Choose an initial deployment architecture. Which deployment architecture will
serve your needs within the limits of your resources?

Note: It is important to note that each deployment is unique. The flexibility
of the SAP BusinessObjects Business Intelligence platform service-based
architecture allows you to tailor the deployment to serve your organization's
requirements as precisely as possible
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Assessing your organization's environment
The resources and conventions used in your existing network environment affect how
you deploy SAP BusinessObjects Business Intelligence platform.

Different deployment options are available to you, depending on the operating
systems, web application servers, database servers and authentication method you
plan to use. Other conventions used in your current environment may also affect how
you deploy SAP BusinessObjects Business Intelligence platform, such as security,
performance monitoring, and design for high availability.

Operating systems
SAP BusinessObjects Business Intelligence platform runs on Microsoft Windows and
Unix (including Linux) operating systems.

An Administrator account must be used to install SAP BusinessObjects Business
Intelligence platform on Windows operating systems.

Note: Review the online SAP BusinessObjects Business Intelligence
platform supported platforms document for information related to
supported operating system release versions, patch levels, or caveats:
http://support.businessobjects.com/documentation/supported_platforms.

Databases in SAP BusinessObjects Business Intelligence platform
In SAP BusinessObjects Business Intelligence platform, a database can be defined
as a data repository that organizes a collection of information into structures called
tables for rapid search and information retrieval. Databases allow tables to be grouped
together into collections of logically related tables called tablespaces. Tables are
grouped into tablespaces within a database system in the same way that files are
grouped into a directory within a file system.

Web application servers
SAP BusinessObjects Business Intelligence platform requires a Java web application
server to process the server-side scripts that make up web applications. You can install
the Tomcat application server during the SAP BusinessObjects Business Intelligence
platform installation or use a supported third-party web application server and Java
Development Kit (JDK).

Note: For a detailed list of supported web application servers, consult the
Supported Platforms Guide available at: http://service.sap.com/bosap-support.
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Web servers
Although web application servers come with built-in web server functionality, SAP
BusinessObjects Business Intelligence platform also supports the separation of
web and web application servers into a de-paired configuration. In a de-paired
configuration, the web server will serve static and cached content to offset a portion of
the requests sent to the web application server.

Failover and load balancing
SAP BusinessObjects Business Intelligence platform supports clustered web
application servers with load balancing. Hardware or software load balancers can be
used as the entry-point for the web application servers to ensure that the processing is
evenly distributed among the web application servers.

Note:

• Load balancing a cluster of SAP BusinessObjects Business Intelligence
platform servers is not required, as the Central Management Server
(CMS) already distributes work between cluster nodes.

• The Central Management Console (CMC) web application does not
support session fail-over. However, BI launch pad is fault-tolerant,
and does support session fail-over, so users will not notice if a cluster
node fails.

Multi-homed environment
SAP BusinessObjects Business Intelligence platform supports multi-homed
environments, in which a server has two or more network addresses. This allows
servers to be configured to receive requests from one network and transmit requests to
another.

Security
Your organization's security policies affect how you deploy SAP BusinessObjects
Business Intelligence platform on your network. Do you plan to use the system's
built-in authentication, or do you need it to work with existing LDAP or Windows
Active Directory (AD) authentication? You also need to decide how your firewalls
are configured, and if you plan to use a reverse proxy.
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Performance and scalability
Before deciding how to deploy your system, consider whether the demand on the
system may change after it has been installed. This could be an increase in the number
of concurrent users, the volume of business data, report complexity, or any other
factor that could cause your SAP BusinessObjects Business Intelligence platform
system requirements to change.

Anticipate these changes before you deploy to save you time and money by making
architectural choices that will support a scalable solution. For example, if you are
expecting an increase in the number of concurrent users accessing your system, you
may consider deploying a small three-node cluster that can be expanded to five-nodes
when demand increases.

By monitoring and regularly re-evaluating your system's performance, schedule tuning
or configuration changes before potential issues become performance problems.

Designing for high availability
High availability refers to a system that is almost always operational. When designing
a system for high availability, consider how much down-time is acceptable for the
system. To minimize time down, consider a combination of failover processing, server
or server process redundancy, and frequent back-ups:

Product co-existence
Several SAP BusinessObjects Business Intelligence platform products can exist on
the same host.

Caution: All SAP BusinessObjects Business Intelligence platform products
installed at your organization must have the same patch level. For example,
if your organization upgrades SAP BusinessObjects Business Intelligence
platform server products to a service pack or fix pack, all add-ons, Client
Tools, and stand-alone products must also be upgraded. Similarly, if one
product is downgraded, all other products should also be downgraded.

Creating additional Adaptive Processing Servers
The installation program installs one Adaptive Processing Server (APS) per host
system. Depending on the features that you've installed, this APS may host a large
number of services, such as the Monitoring Service, Lifecycle Management Service,
Multi-Dimensional Analysis Service (MDAS), Publishing Service, and others.
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Deployment Checklist
This section provides a checklist for the steps you need to perform when planning a
deployment of SAP BusinessObjects Business Intelligence platform. The following
checklist outlines the major tasks to be completed for the planning phase of your SAP
BusinessObjects Business Intelligence platform deployment.

Checklist item Complete? (Y/N)

Understand the tiers that make up
the SAP BusinessObjects Business
Intelligence platform architecture.

Y_/N_

Understand the components and how
they communicate with each other.

Y_/N_

Understand the workflows (how
information travels through the
architecture).

Y_/N_

Identify the operating system you are
deploying the system on.

Y_/N_

Choose the database servers will you be
accessing.

Y_/N_

Choose a web application server. Y_/N_

Are you using third-party authentication,
secure sockets layer, firewalls, and/or
reverse proxy,

Y_/N_

Identify potential performance problems. Y_/N_

Case Study: Jade Publishing
This case study is to be used as a reference for facilitated discussions.
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Company information

Figure 21: Jade Publishing Company

The first Jade Publishing store opened in the year 2000 in China. It is a subsidiary
of a larger company called Crowns Mendocino. Jade Publishing continues the C.M.
brand's dedication to customer service and strong commitment to quality. Jade
Publishing has a strong direct mail business that distributes millions of catalogs a year
and has a highly successful e-commerce site.

Jade Publishing employs 2000 people. The Jade Publishing Beijing office will be the
early adopter of a BI system. The Beijing office is the main Jade Publishing office and
has employees in all aspects of the business including:

• Marketing
• Sales
• Designers
• Finance .
• Shipping
• IT

Jade Publishing also has other offices: Shanghai (Shanghai Province) and Guangzhou
(Guangdong Province). The company is running a province centric model, where each
main province office has a very similar structure. Shanghai and Guangzhou offices
are much smaller (250 employees each). The head office of the whole company, as
mentioned earlier, is in Beijing.
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Business Needs

• There is an immediate need for an enterprise-wide query and analysis, file
storage, and reporting distribution for Jade Publishing that will allow users to
modify documents on-the-fly and build new queries to get answers.

• Their mandate is to have the users view and analyze reports online whenever
possible. There may be highly formatted reports and interactive documents where
users can modify report structures or build brand new interactive documents.

• There is a need to allow for prebuilt reports as well as interactive documents
that can either be modified or newly created by sales people without asking
IT for assistance.

• Upper Management in all departments want to query and analyze their own
department's numbers and figures directly, to make better business decisions.

• They would like to standardize on a single BI framework that is scalable, fault
tolerant and supports the best BI tools.

• There is a need for interactive user-friendly documents and high quality
presentation reports that would provide users the ability to run their reports and
documents on an ad hoc or recurring scheduled basis.

• Taking advantage of personal categories and favorites or sending reports direct
to a user's email or Inbox would be helpful.

• The IT department would like to give each department the ability to manage
users within their business unit. This way IT can restrict one business unit to
impact how that unit can use the system while also being able to restrict what
data that unit can see.

• The delegated administrator would be able to manage the replication of their
content.

• Since this is the first implementation of a BI system within the Jade Publishing
Beijing office, there will be a development and production environment. There
will also possibly be the need to replicate the system in the Guangzhou office in
order to prove the effectiveness of the system. • Jade Publishing needs to burst
customized reports via email to all provincial outlets with sales information.

• Jade Publishing needs to burst customized reports via email to all provincial
outlets with sales information.
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User Requirements
While C.M. has offices worldwide we are only dealing with the implementation of a
BI system within the Jade Publishing office in Beijing.

• Beijing has 1500 employees
• Guangzhou has 250 employees
• Shanghai has 250 employees

Jade Publishing estimates the following system usage:

• 10% of the total users connect to the system concurrently (150 + 25 + 25 = 200).
• 10% of the concurrent active users will be heavy users of the system (logged into

the system and viewing reports nearly continuously, averaging one request per
second) (15 + 2.5 + 2.5 = 20).

• 10% of the concurrent active users will be active users of the system (logged
into the system frequently throughout the day averaging one request every four
seconds) (15 + 2.5 + 2.5 = 20).

• 30% of the concurrent active users will be moderate users of the system (logged
into the system from time to time throughout the day averaging one request
every eight seconds) (45 + 7.5 + 7.5 = 60).

• 50% of the concurrent active users will be light users of the system (logged
into the system infrequently and will view a couple of reports and log out) (75
+ 12.5 + 12.5 = 100).

You can estimate that the number of simultaneous requests pertaining to
viewing sessions will be an estimated 75 Crystal Reports simultaneous requests
(simultaneous viewing sessions) and 30 Web Intelligence simultaneous requests
(simultaneous document viewing/edit sessions).

•
• 5% of the users will use Crystal Reports to design reports.
• 30% of the users will use Web Intelligence to design reports.

Report processing requirements
Sales and Manufacturing data is stored provincially. Each province stores data in
various regional SQL 2000 databases. Your analysis of reporting requirements has
identified the following number of reports in the SAP BusinessObjects BI platform:
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Beijing office

• 100 total Crystal Reports.
• 50 Crystal Reports will run daily.
• 30 Crystal Reports will run weekly.
• 20 Crystal Reports will run at month end.
• 50 are highly analytical and interactive in nature Web Intelligence documents.
• 25 Web Intelligence documents will run daily.
• A few of the Crystal reports will be used in Publications to burst to regional

sales managers.
• 80% (80 at the end of the month) of Crystal Reports and (20 daily) Web

Intelligence documents will run after hours.
• 20% (20 at the end of the month) of Crystal Reports and (5 daily) Web

Intelligence documents will run during working hours.
• 50% of all Crystal Reports and Web Intelligence documents will require

prompting before being run, which may be common across different reports.
Many prompts will be based on information that is subject to change frequently.

• Because of backups and other maintenance duties, the after hours Crystal
Reports and Web Intelligence documents need to run within a five hour window.

• Each Crystal Reports on average takes about 10 minutes to run.
• Each Web Intelligence document takes about 2 minutes to run.
• The average Crystal report size is 1MB. The average Web Intelligence document

size is 500Kb.
• North Maple anticipates a 20% annual growth in the number of reports and

documents hosted by the system.
•

Guangzhou office (assume 16.6% of Beijing numbers). Shanghai office (assume
16.6% of Beijing numbers).

Shanghai office (assume 16.6% of Beijing numbers).

Report viewing requirements
Analysis of report viewing requirements has identified the following:
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Lesson Summary

You should now be able to:
• Consider the many different requirements that might affect a SAP

BusinessObjects Business Intelligence platform deployment
• Evaluate your organization's needs before you deploy your SAP BusinessObjects

Business Intelligence platform system
• Describe the checklist of criteria that helps you plan your SAP BusinessObjects

Business Intelligence platform deployment,
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Unit Summary
You should now be able to:
• Consider the many different requirements that might affect a SAP

BusinessObjects Business Intelligence platform deployment
• Evaluate your organization's needs before you deploy your SAP BusinessObjects

Business Intelligence platform system
• Describe the checklist of criteria that helps you plan your SAP BusinessObjects

Business Intelligence platform deployment,
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Test Your Knowledge

1. List two examples of customer information that pertains to deployment
requirements.
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Answers

1. List two examples of customer information that pertains to deployment
requirements.

Answer: Network infrastructure, Hardware information (although this could
also impact sizing), There is a DMZ zone for external customers, LDAP
authentication is used for internal customers
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Unit 3
Ensuring Availability of your SAP

BusinessObjects BI Solutions

Unit Overview
This unit focuses on the concepts that must be taken into account when you design
and deploy a Business Intelligence solution so that it is available to your business and
your users. Scalability, fault tolerance, deployment strategies, and disaster recovery
are key concepts to cover.

Unit Objectives
After completing this unit, you will be able to:

• Describe the challenges in a Business Intelligence solution
• Explain the key factors in making your systems fault tolerant and highly available
• Define the deployment strategies for high availability in SAP BusinessObjects

BI platform
• List deployment options for the application tier
• Explain vertical and horizontal scaling options
• Describe the new capabilities of the wdeploy tool and its role in creating high

availability in the application tier
• Understand high availability in the Intelligence tier
• Describe the process of CMS clustering
• Manage active/passive file repository servers
• Describe the SAP BusinessObjects BI platform servers in the Processing tier
• Understand the concept of server groups
• Create and work with server groups

Unit Contents
Lesson: Understanding Terms in SAP BusinessObjects Business Intelligence
Solution... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
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Lesson: Understanding Terms in SAP BusinessObjects
Business Intelligence Solution

Lesson Overview
To ensure that your system meets your requirements for reliability, you need to
consider a multitude of internal and external factors.

Lesson Objectives
After completing this lesson, you will be able to:

• Describe the challenges in a Business Intelligence solution
• Explain the key factors in making your systems fault tolerant and highly available
• Define the deployment strategies for high availability in SAP BusinessObjects

BI platform

Business Example

SAP Business Intelligence BI Solutions

The Challenges of Discussing how to Ensure Availability
A SAP Business Intelligence BI Solution is one that delivers information to you so
that you can make informed business decisions. SAP BusinessObjects BI platform
4.0 is an important component in this solution but there are other components that
are required in order to provide the functionality and reliability you need for your
business. Even the simplest single server deployment of SAP BusinessObjects BI
platform 4.0 depends on many complex systems and processes.

It is impossible to discuss how to ensure availability without including discussions
around:

• Process flows.
• Deployment strategies.
• Concepts such as disasters and corresponding recovery strategies.

The challenge is that these topics are so interrelated that it is not possible to explore
any one of these four areas in detail without touching upon another.
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Figure 22: Factors in Ensuring Availability

High Availability and Fault Tolerance Concepts
Line of Business Application

A line-of-business (LOB) application is a critical computer application that is vital to
running an organization such as accounting, supply chain management, and resource
planning applications. If a LOB application becomes unavailable, essential business
functions are lost or suffer.

For some companies, their Business Intelligence solution may not be as
mission-critical. If it fails, steps must be taken to correct that but the panic to do so
is minimal. For such companies, SAP BusinessObjects BI platformis not an LOB
application.

Conversely, for other organizations such as health care units, production systems
stop and patients' lives are threatened when BI solutions are unavailable. For such
companies, significant resources need to go into ensuring this LOB solution is
available.

Disaster
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A disaster is any unanticipated event that creates a defined problem. Disasters are
usually considered in terms of severity. Some examples of disasters include:

• A report is inadvertently deleted from the DEV system.
• A reporting database is unavailable.
• The primary administrator leaves the company suddenly.
• A software vender support contract expires.
• A server shuts down unexpectedly.
• The connection to the data center is lost.

Note: While planned downtime for maintenance creates unavailability, this
is not considered a disaster.

Business Continuity Planning

Business Continuity Planning (BCP) is an interdisciplinary concept used to create and
validate a practiced logistical plan on how an organization will recover and restore
partially or completely interrupted operations within a predetermined time after a
disaster or extended disruption. This logistical plan is called a Business Continuity
Plan. In simple terms, BCP is working out how to stay in business in the event of a
disaster or incidents such as lost systems, building fires, sudden loss of the CEO,
earthquakes, or wars.

Disaster Recovery

Disaster recovery planning is an important part of the larger process of Business
Continuity Planning. Disaster recovery is the process, policies, and procedures of
restoring operations that are critical to the resumption of business, including regaining
access to data (records, hardware, or software), communications (incoming, outgoing,
toll-free, or fax), workspace, and other business processes after a disaster. To increase
the opportunity for a successful recovery of valuable records, a well-established and
thoroughly tested disaster recovery plan must be developed. A disaster recovery plan
includes plans for coping with the unexpected or sudden loss of communications
and/or key personnel. Disaster recovery planning can also include how to manage
maintenance or planned unavailability as well.

Single Point of Failure

A single point of failure as it relates to ensuring availability of your BI solution is a
single failure that creates a denial of services or requests to the users.

In reality, removing all single points of failure is extremely difficult to achieve and
its cost is also enormous. For an example, it may be easy to implement a cluster
of three CMS servers in a cluster to remove a single point of failure in the CMS
availability but if the three CMS servers are connected to the same network switch,
then the switch becomes a single point of failure. To resolve this single point of
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failure, you connect each of the three CMS servers to independent switches. However
an unforseen disaster at the Internet Service Provider can interrupt your Wide Area
Network communication and create a situation where no one can connect to your BI
solution (even though it is running, it is unavailable).

As a result, your task is to reduce all the single points of failure as possible and create
a robust disaster recovery plan.

Fault tolerance

Fault tolerance or graceful degradation is the property that enables a system to
continue operating property in the event of the failure of (or one or more faults within)
some of its components. The basic characteristics of fault tolerance require:

• No single point of failure: All systems are fully redundant.
• Fault isolation to the failing component: A disaster cannot cause failures in other

areas. If the Output FRS fails, the Job Servers that process the schedule requests
will be impacted. However, if there is another Output FRS available to handle
the request, then the schedule and view requests can still function as normal
because all the failure is isolated to the single Output FRS itself.

• Fault containment to prevent propagation of the failure: A disaster cannot cause
a chain of further disasters. If your current workload demands two CMS servers
to work together in your cluster, when one goes down, the entire workload will
depend on the remaining server. This may cause too much workload for the
CMS to handle and thus the performance is severely degraded. The solution for
this potential problem is to have a cluster of three CMS servers so that if one
fails, the remaining two CMS servers can still handle the workload.

• No single point of repair: If a system experiences a failure, it must continue to
operate without interruption during the repair process.

Note: The key point in fault tolerance is "no denial of services". Should a
disaster occur, the system will still be available to your users.

High Availability
High availability is a system design protocol and associated implementation that
ensures a certain absolute degree of operational continuity during a given measurement
period. Fault tolerance means your systems are always available; high availability
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means your system is almost fault tolerant but a certain amount of down time (planned
or unplanned periods of unavailability) is expected. Many fault tolerant solutions are
used to create a highly available deployment.

Note: The terms "uptime" and "availability" are not synonymous. A system
can be up, but not available, as in the case of a network usage. Availability is
usually expressed as a percentage of uptime in a given year.

Availability is usually expressed as a percentage of uptime in a given year. In a given
year, the number of minutes of unavailability (planned and unplanned) is totaled for
a system and then divided by the total number of minutes in a year (approximately
525,600 minutes), producing a percentage of unavailability. The complement of this
is the percentage of uptime, which is what is typically referred to as the availability
of the system.

Availability % Downtime per year Downtime per
month

Downtown per
week

95% 18.25 days 36 hours 8.4 hours

99% 3.65 days 7.20 hours 1.68 hours

99.5% 1.83 days 3.60 hours 50.4 minutes

99.9% 52.6 minutes 4.32 minutes 1.01 minutes

The higher the percentage specified in your business case, the more resources that
must be employed to satisfy those requirements.

Failover

Failover is the capability to switch over automatically to a redundant or standby
computer server, system, or network upon the failure or abnormal termination of
the previously active server, system, or network. Failover happens without human
intervention and generally without warning, unlike switchover. There are many
types of failover. Some will maintain availability while others create a moment of
unavailability before becoming available again. During the moment of unavailability,
there may be a denial of services. Two CMS servers operating in a cluster is an
example of failover that maintains availability. If CMS 1 is managing your session
and it goes down, you will be automatically connected to CMS 2 without experiencing
any denial in service.
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Figure 23: Failover

Load Balancing

Load Balancing is a technique (usually performed by load balancers) to spread
work between two or more computers, network links, CPUs, hard drives, or other
resources, in order to get optimal resource utilization, throughput, or response time.
The balancing service is usually provided by a dedicated program or hardware
device (such as a multilayer switch). In the case of a CMS cluster, the workload can
come from multiple users managed by both CMS servers. The two CMS servers
then communicate their current load with each other to determine which one will
manage the other CMS responsibilities such as database maintenance and schedule
management. In the case of a hardware device that manages a load-balancing cluster,
it is common to have the entire workload come through a load-balancing front end.
This front end offers session persistence or "stickiness" by sending the client to the
same back-end server for the duration of the current session.
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Figure 24: Load Balancing

Note: BIG-IP by F5 is a common hardware load-balancing solution used
by many web farms.

Active/Active and Active/Passive Functionality

Active/Active and Active/Passive are general functionality that can be applied and
implemented in a variety of fashions. Active/Active refers to two redundant resources
(servers or services) that are both functioning to support the system as a whole. A
CMS cluster in which multiple CMS servers are running and sharing the workload at
the same time is an example of an Active/Active configuration. Active/Passive refers
to two or more redundant resources but only one is running and actively managing
requests; the other resource is either not running or running in a waiting state until
it is further promoted to active state by administrators following the failure of the
current active resource. Two Input File Repository Servers running at the same time is
an excellent example of Active/Passive.

High availability server clustering

High-availability clusters (also known as HA Clusters or Failover Clusters) are
computer clusters that are implemented primarily for the purpose of improving the
availability of services. They operate by having redundant computers or nodes
working together and sharing data to provide services and functionality. When a
service fails, those processes can be moved to be managed by other nodes so the
service is once again available. The shared data is always available. In addition, each
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node has many redundant elements to improve reliability such as multiple power
supplies and network cards. Many of these components are designed to be changed
while the server is still running thus reducing unavailability.

Figure 25: High Availability Server Clustering
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High Availability clusters can be configured in the following ways: •

• Active/Active

In active/active, traffic intended for the application can be processed by any one
of the active nodes. This is possible when all nodes have access to the same data.
Some clustered instances of database servers are good example of this. Database
queries go from a client to a virtual server name but the actual processing of the
query can be done by any available node that hosts the same instance of the
database. Allowing multiple instances to access the same database (storage)
simultaneously provides fault tolerance, load balancing, and performance
benefits by allowing the system to scale out. At the same time, since all nodes
access the same database, the failure of one instance hosted by a specific node
will not cause the loss of access to the database itself.

• Active/Passive

Active/passive configuration provides a fully redundant instance of each node
running but only one is actively processing requests; all others are in a waiting
state. Should a disaster occur on the current node, the process will be stopped
on that node, moved over to another redundant node and then started. This
configuration typically requires the most amount of extra hardware. The extra
hardware can be mitigated by splitting the hosted applications. Each node runs
some applications actively and is also acting as the passive node for applications
that run on other nodes. The challenge is to ensure that if a failure occurs, the
remaining nodes are able to support all applications.
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Figure 26: Active and passive fail-over architecture

Note: Some commonly used clustering services are 'Veritas Cluster Server'
and 'Microsoft Cluster Server' (MSCS). These servers are excellent options
for hosting highly available resources such as file shares for the FRS root
folders and cluster aware databases such as MS SQL Server and Oracle for
the CMS system database and other reporting databases.

Network Storage Solutions
Storage Area Network (SAN)

SAN is an architecture to attach remote computer storage devices (such as disk arrays,
tape libraries and optical jukeboxes) to servers in such a way that, to the operating
system, the devices appear as locally attached. Although cost and complexity are
dropping, as of 2007 SANs are still uncommon outside larger enterprises.
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Figure 27: Network Storage Solutions

Figure 28: SAN

Network Attached Storage (NAS)

2012 © 2012 SAP AG. All rights reserved. 95



Unit 3: Ensuring Availability of your SAP BusinessObjects BI Solutions BOE330

By contrast to a SAN, Network Attached Storage (NAS) is essentially a self-contained
computer that is connected to a network with the sole purpose of supplying the
file-based data storage services to other devices on the network. The operating system
and other software on the NAS unit provide the functionality of data storage, file
systems, access to files, and management of these components.

Unlike SAN where the remote file system appears to be local, it is clear to the operating
system that the NAS resource is remote. The NAS resource appears as a network share
accessed by a UNC path (for example \\Server_Name\File_Share\Sub_Folder\File).

NAS Heads

A NAS head refers to a NAS which does not have any on-board storage but connects
to a SAN. In effect, a NAS acts as a translator between the file-level NAS protocols
(NFS, CIFS) and the block-level SAN protocols (Fibre Channel, iSCSI). Thus NAS
heads combine the advantages of both SAN and NAS technologies.

Figure 29: The challenge of the SAN
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Figure 30: NAS Heads

Vertical and Horizontal Scaling
Scalability is a key success factor for business applications in a dynamic environment.
SAP BusinessObjects BI platform scales both vertically and horizontally.

Vertical scaling (otherwise known as scaling up) means adding more hardware
resources (for example processors and memory) to the same machine. In the context
of SAP BusinessObjects BI platform, this means the ability to add multiple servers on
the same machine.

Horizontal scaling (otherwise known as scaling out) means adding more machines
into the solution. In the context of SAP BusinessObjects BI platform, this means the
ability to run multiple servers on multiple machines seamlessly.

Backup
Backup refers to making copies of data so that these additional copies may be used for
restoration after a data loss event occurs. These additional copies are typically called
"backups". Backups are useful primarily for two purposes:

• To restore an entire system following a major disaster.
• To restore small numbers of files after they have been accidentally deleted or

corrupted.
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In SAP BusinessObjects BI platform context, the three critical pieces of data to
backup are:

• The CMS system database. This may also include the audit database.
• Input File Repository root folder.
• Output File Repository root folder.

Note: It is important that these components are synchronized.

Deployment Strategies for High Availability
Creating a true fault tolerant BI solution requires removing all single points in
failure. Since removing all single points of failure is an immense and extremely cost
prohibitive task, the reality is that ensuring availability means deploying a highly
available BI solution with backup and disaster recovery strategies that support your
organization’s business needs.

When designing a system for high availability, you need to consider:

• Availability requirements and how much time is acceptable for the system
to be down.

• Failover processing, system backup, and data storage.
• Vertical and horizontal scaling options.

Resources incorporated into a Business Intelligence solution are vast and there are
many different ways these resources can interact with each other. The next topic in
this lesson will focus specifically on SAP BusinessObjects BI platform and some of
its dependencies.

Designing a System for High Availability
Single server deployments are not highly available

In a single server deployment, you can duplicate many of the SAP BusinessObjects
BI platform servers to provide redundancy. If one service fails, the duplicate service
could continue to process requests. However, if there is a catastrophic failure
affecting the entire server, SAP BusinessObjects BI platform will become unavailable
until the problem is resolved. Planned maintenance can also create periods of
unavailability. Whether the downtime is planned or unplanned, if it supports the
business requirements of availability, a single server solution may be sufficient but it
is not regarded as a highly available deployment.

Designing a multiple-server system for high availability
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Depending on the number of machines you can dedicate to SAP BusinessObjects BI
platform, you have many options for designing a system for high availability, taking
the advantage of both vertical and horizontal scaling.

In a multiple-server deployment, duplicate services are running on different machines
and the SAP BusinessObjects BI platform architecture provides the redundancy and
reliable communications to ensure high availability of SAP BusinessObjects BI
platform. If one service fails or if there is a hardware failure on the machine running
the service, the duplicate service on another machine continues to process requests
with little impact to the system. What little impact there is can be managed through
configuration settings so there is no denial of services.

The architecture is commonly divided into 3 tiers. It is easier to design a highly
available deployment by looking at configuration options within each tier focusing on
how to utilize both vertical and horizontal scaling to maintain high availability for
both the servers and the resources they depend on.

The following diagram illustrates fault tolerance in a multiple server environment:
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Lesson Summary

You should now be able to:
• Describe the challenges in a Business Intelligence solution
• Explain the key factors in making your systems fault tolerant and highly available
• Define the deployment strategies for high availability in SAP BusinessObjects

BI platform
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Lesson: Ensuring Availability in Multiple Tiers

Lesson Overview
In this lesson, you will learn about creating high availability in the multiple tiers.

Lesson Objectives
After completing this lesson, you will be able to:

• List deployment options for the application tier
• Explain vertical and horizontal scaling options
• Describe the new capabilities of the wdeploy tool and its role in creating high

availability in the application tier
• Understand high availability in the Intelligence tier
• Describe the process of CMS clustering
• Manage active/passive file repository servers
• Describe the SAP BusinessObjects BI platform servers in the Processing tier
• Understand the concept of server groups
• Create and work with server groups

Business Example

Conceptual tiers
SAP BusinessObjects Business Intelligence platform can be thought of as a series
of conceptual tiers:
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Figure 31: Conceptual tiers in SAP BusinessObjects BI platform deployment

• Web tier

The Web Tier contains web applications deployed to a Java web application
server. Web applications provide SAP BusinessObjects Business Intelligence
platform functionality to end users through a web browser. Examples of web
applications include the Central Management Console (CMC) administrative
web interface and BI launch pad. The web tier also contains Web Services.
Web Services provides SAP BusinessObjects Business Intelligence platform
functionality to software tools via the web application server, such session
authentication, user privilege management, scheduling, search, administration,
reporting, and query management. For example, Live Office is a product that
uses Web Services to integrate SAP BusinessObjects Business Intelligence
platform reporting into Microsoft Office products.

• Management tier

The management tier coordinates and controls all of the components that make
up SAP BusinessObjects Business Intelligence platform. It is comprised of the
Central Management Server (CMS) and the Event Server. The CMS provides
maintains security and configuration information, sends service requests to
servers, manages auditing, and maintains the CMS system database. The Event
Server manages file based events, which occur in the storage tier.

• Processing tier

The processing tier analyzes data and produces reports. This is the only tier that
accesses the databases that contain report data.

• Storage tier

The storage tier is responsible to handling files, such as documents and reports.

The Input File Repository Server manages files that contain information to be
used in reports, such as the following file types: .rpt, .car, .exe, .bat, .js, .xls,
.doc, .ppt, .rtf, .txt, .pdf, .wid, .rep, .unv.

The Output File Repository Server manages reports created by the system, such
as the following file types: .rpt, .csv, .xls, .doc, .rtf, .txt, .pdf, .wid, .rep. The
storage tier also handles report caching to save system resources when users
access reports.
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High Availability in the Web tier

Web Client to Web Server
Obviously there is little that you can do to make Web Clients highly available so the
Web Server is usually the first place to begin planning for high availability.

You may wish to implement an external web server in front of the Business
Intelligence stack for one or many of the following reasons:

• You wish to implement a DMZ.
• You want the web server to serve up static web content only (for example .gif

files), thereby removing some of the load from the web application server
(WAS). You can separate dynamic and static content using the wdeploy tool,
which is included with SAP BusinessObjects BI platform to achieve this.

• You wish to offload the SSL work from Web Application Servers.

Here you encounter a problem however. If you have one web server then you have a
single point of failure. You can eliminate the single point of failure by introducing
multiple web servers. But this introduces a new problem; now your users have
multiple web servers and therefore multiple URLs to choose from. How can do you
get around this?

DNS round robin

"Domain Name Service round robin" is one solution whereby the DNS server sends
web requests to each web server in a round robin manner. DNS round robin is not
very popular, but it is very affordable to implement. One problem with this method
is that a DNS server cannot verify the availability of hosts in its records. Thus, it
might easily hand out the IP address of a server that is switched off or one that is up
but has a crashed service.

Hardware load balancer

These are hardware appliances that present a single URL to the end users, and then
forward traffic on to the web server farm behind it. Hardware load balancers can fail
too if but in practice they tend to be very reliable.

104 © 2012 SAP AG. All rights reserved. 2012



BOE330 Lesson: Ensuring Availability in Multiple Tiers

Hardware load balancers have several benefits, for example:

• Monitoring network availability of servers within a cluster

A load balancer can be configured to not direct traffic to a server that is switched
off.

• Accommodating session state

A loadbalancer can be configured with client affinity, so it can maintain session
state when necessary.

Note: Note: Client affinity is sometimes referred to as "session affinity"
or "sticky sessions". Client affinity is implemented using either IP-based
switching or cookie-based switching. Most organizations prefer cookie-based
switching since it does not suffer from problems associated with NAT
translation (where all of the user's behind a particular NAT device appear to
come from the same IP address and therefore are all sent to the same web
server).

Web Server to Web Application Server
Although web application servers come with built-in web server functionality, SAP
BusinessObjects Business Intelligence platform also supports the separation of
web and web application servers into a de-paired configuration. In a de-paired
configuration, the web server will serve static and cached content to offset a portion
of the requests sent to the web application server. A web server may also support a
reverse proxy configuration to improve site security.

Web application deployment
The SAP BusinessObjects Business Intelligence platform installation program can
deploy web applications only to the bundled Tomcat 6.0 web application server. All
other supported web application servers require that web applications be deployed
after the installation is complete.

Note: It is recommended that you use the WDeploy web application
deployment tool. However, you can deploy web applications with the server's
administrative console if you prefer.
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OSGi WAR files
The OSGi framework for Java web applications simplifies the deployment of
the web applications bundled with SAP BusinessObjects Business Intelligence
platform. It allows web applications, language packs, SDKs, plugins, and other
resources to exist in a single bundle that can be deployed to a web application
server in one step.
Deploying a single WAR file also means fewer web sessions are needed when a
user accesses multiple web applications, which reduces the memory, disk, and
processing load placed on a web application server.

Note: Load balancing a cluster of SAP BusinessObjects Business Intelligence
platform servers is not required, as the Central Management Server (CMS)
already distributes work between cluster nodes.

The Central Management Console (CMC) web application does not support
session fail-over. However, BI launch pad is fault-tolerant, and does support
session fail-over, so users will not notice if a cluster node fails.

Failover and load balancing
SAP BusinessObjects Business Intelligence platform supports clustered web
application servers with load balancing. Hardware or software load balancers can be
used as the entry-point for the web application servers to ensure that the processing is
evenly distributed among the web application servers.

SAP BusinessObjects Business Intelligence plat-
form WAR and EAR files
The functionality that makes up SAP BusinessObjects Business Intelligence
platform is divided between several web applications to make it easy to deploy
only the components required by your organization. In SAP BusinessObjects
Business Intelligence platform 4.0, many of the core web applications included with
previous releases have been bundled into a single OSGi archive. This saves web
application server memory and the reduces the number of web sessions needed for
web applications that previously had multiple archives.

For example, SAP BusinessObjects Business Intelligence platform XI 3.x included
the Central Management Console (CMC) and InfoView (now BI launch pad) web
applications archived as CMC.war and InfoView.war. SAP BusinessObjects Business
Intelligence platform 4.0 has consolidated the CMC and InfoView (now BI launch pad)
web applications, along with others, into a single archive named BOE.war or BOE.ear.
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The WDeploy tool is used to automate the process of tailoring web applications to
be deployable on a supported web application server. While it is possible for an
experienced administrator to manually tailor a web application for a specific web
application server, it is recommended that the WDeploy tool be used to automate the
process.

Overview of WDeploy
The WDeploy tool is included with SAP BusinessObjects Business Intelligence
platform to ease deployment of web applications to Java-based web application
servers. There are two different versions of WDeploy:

1. A traditional, text-based interface that processes commands and parameters
given on the command-line

2. A new Windows-based guided assistant similar to the SAP BusinessObjects
Business Intelligence platform installation program, which prompts the user to
enter deployment parameters.

While each supported web application server requires different commands and
web application package updates, WDeploy provides a consistent interface for
administrators, and automates the adjustments needed for deployment to a specific
web application server.

Deployment modes
WDeploy supports two different deployment modes:

1. Standalone mode (a web application server) The web application server serves
both static content (HTML pages, images, documents, JavaScript, Cascading
Style Sheets) and dynamic content (Java Server Pages, JAR files, XML files).

2. Split web tier mode (a web application server plus a dedicated web server) A
dedicated web server receives requests from web browsers and serves all static
content (HTML pages, images, documents, JavaScript, Cascading Style Sheets).
Requests for dynamic content (Java Server Pages, JAR files, XML files) are
forwarded to the dedicated application server and returned to the web browser
when the content has been formed.

Hint: This mode is suited to larger production deployments where
scalability and performance are key.

Note: It is also possible to use WDeploy to deploy web applications to a
web application server installed on the same system as SAP BusinessObjects
Business Intelligence platform. This configuration can be used for small
development or test systems, and is not recommended for production systems.
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High Availability in the Management Tier

Web Application Server to SAP BusinessObjects BI
platform Cluster
Once a user has initiated a session, the web application server then communicates with
the Intelligence tier, or SAP BusinessObjects BI platform tier.

When you log into SAP BusinessObjects BI platform through any of the client tools
you are typically asked to provide four pieces of information:

• A user name
• A password
• The "system" you wish to log into
• The authentication type in use with that system

The system you specify is really the hostname and the port number of a host running a
CMS.

Note: It is best to use the fully qualified domain name of the host.

Note: Interestingly due to the way that SAP BusinessObjects BI platform
failover works, the hostname you specify may not actually be the CMS you
end up connecting to.

CMS Clustering
With CMS clustering, a set of two or more server machines function as a single
Central Management Server. In the event of a network, power, hardware, or software
failure on one server, the workload of the failed CMS is picked up by another within
the same cluster.

Figure 32: CMS Clustering
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CMS clustering benefits include:

• Increased CMS availability

Clustered CMS machines use a heartbeat signal to determine clustered server
availability. In the event of a failure, the workload of the failed CMS is picked
up by an available CMS within the cluster.

• Providing for incremental growth and scalability

As the number of SAP BusinessObjects BI platform users grows, adding CMS
servers to the cluster allows ease of expansion and continued availability. CMS
clusters also allow for easy basic machine maintenance without hampering the
SAP BusinessObjects BI platform distribution. This maintenance might include
loading a service pack or updating hardware on your CMS. If you have two
CMS machines then you can work on one machine at a time without disturbing
the production system.

• Improved performance and consistency of Enterprise system

When users log into SAP BusinessObjects BI platform, they are authenticated
by one of the CMS servers. The CMS servers in a cluster use round robin
mechanism when taking on new users. If there are for example 50 users logged
on the cluster containing two CMS machines, it is very likely that 25 of the users
are logged on to CMS1 and the other 25 users are logged on the CMS2.

CMS machines in a cluster communicate via TCP/IP. The nature of a TCP/IP message
is that its signal will only be received by the intended service.

When CMSs start up, they communicate with the CMS system database to receive
a list of other CMSs in the system. Once the CMS receives the list of CMSs in the
system, it communicates with the other CMSs to establish a cluster connection.

Migrating and Backing up CMS System Data
Organizations often need to copy data from one SAP BusinessObjects BI platform
system to another SAP BusinessObjects BI platform system. This process can be used
to periodically backup a deployment's CMS system database.

SAP BusinessObjects BI platform provides the ability to migrate, or copy, the contents
of a CMS system database to another database type. You can also copy CMS data from
a different CMS database of an earlier version to your current CMS system database.

When you move the entire CMS system database to a different data source, the
migration process destroys any information already present in the destination data
source. If you are performing an off-site back up of your system database you would
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use this process to move the current system database to an empty database. This
migration process is performed in the CCM by clicking the Specify CMS Data Source
button on the toolbar.

Note: For more information on the procedure for migrating and backing up
CMS system data, please refer to the Administering Servers - Windows course.

Managing Active/Passive File Repository Servers
The SAP BusinessObjects BI platform environment may have multiple File
Repository Servers, but only one is active at any given time. The order of start up
determines which File Repository Server is active and which one is passive. The first
File Repository service to start is the active File Repository Server.

If the active File Repository Server shuts down for any reason, the backup (passive)
File Repository Server becomes active and takes over.

Tip: To determine which FRS is active and which is passive, you can use the Metrics
property of a server to verify the start time. The server that has been running the
longest is the active server.

Preferred high availability FRS filestore configuration

All the File Repository Servers point to a disk location where the actual report
templates and files reside. By default, the files are stored on the local host's file system
on the server upon which you install the SAP BusinessObjects BI platform. However
having just one FRS pointing to local file storage has two problems:

• It is a single point of failure
• The files are not visible to another server

It is recommended to use the following configuration for your FRS filestore. You
create a shared, common clustered folder on another host across the network then
point the FRS pairs to it. If one of the servers within the cluster where the files are
stored goes down, the backup FRS pairs will still be able to access the files through
the cluster.

Crystal Reports Cache Server
The Crystal Reports Cache Server is responsible for handling Crystal Reports report
viewing requests from the DHTML, ActiveX, and Java viewers. The Crystal Reports
Cache Server manages viewable pages. If the requested page is present on the Crystal
Reports Cache Server, it is sent back to the Web Application Server; otherwise, the
page is requested from the Crystal Reports Processing Server.
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Event Server
The Event Server manages file-based events. When you set up a file-based event
within SAP BusinessObjects BI platform, the Event Server monitors the directory that
you specified. When the appropriate file appears in the monitored directory, the Event
Server triggers your file-based event: that is, the Event Server notifies the CMS that
the file-based event has occurred. The CMS can then start any jobs that are dependent
upon the file-based event.

Note: Schedule-based and custom events are managed through the CMS.

High Availability in the Processing Tier

Adaptive Processing Servers
The installation program installs one Adaptive Processing Server (APS) per host
system. Depending on the features that you've installed, this APS may host a large
number of services, such as the Monitoring Service, Lifecycle Management Service,
Multi-Dimensional Analysis Service (MDAS), Publishing Service, and others.

If you are installing a production environment, do not use the default APS. Instead, it
is highly recommended that once the installation process is complete, you perform a
system sizing to determine: Create new APS server instances as determined by the
sizing process. For example, if the outcome of your sizing happens to suggest the
creation of one APS for each service category, then may end up creating eight APS
servers. One for each service category: Advanced Analysis Services, Connectivity
Services, Core Services, Crystal Reports Services, Dashboard Design Services, Data
Federation Services, Lifecycle Management Services, and Interactive Analysis
Services.

• The type and number of APS services.
• The distribution of services across multiple APS servers. •
• The optimal number of APS servers. Multiple APS servers provide redundancy,

better performance, and higher reliability.
• The distribution of APS servers across multiple nodes.

Crystal Reports Processing Server
The Crystal Reports Processing Server is primarily responsible for responding to page
requests by processing Crystal Reports and generating Encapsulated Page Format
(.EPF) pages. A single .EPF file represents one page of a Crystal report. The Crystal
Reports Processing Server retrieves data for the report from the latest instance or
directly from the database (depending on the user’s request and security level).

2012 © 2012 SAP AG. All rights reserved. 111



Unit 3: Ensuring Availability of your SAP BusinessObjects BI Solutions BOE330

Specifically, the Crystal Reports Processing Server responds to page requests made by
the Crystal Reports Cache Server. The Crystal Reports Processing Server and Crystal
Reports Cache Server interact closely, so cached .epf pages are reused as frequently as
possible, and new pages are generated as soon as they are required.

Report Application Server
The Report Application Server (RAS) is very similar to the Processing Server. It, too,
is primarily responsible for responding to page requests by processing reports and
generating EPF pages. However, the RAS uses an internal caching mechanism that
involves no interaction with the Cache Server. Specifically, the Report Application
Server (RAS) processes reports that BI Launch pad users view with the Interactive
DHTML viewer. The RAS also provides the reporting capabilities that allow BI
Launch pad users to create and modify Crystal reports over the web. Additionally,
the Report Application Server is used at the time of viewing or submitting schedule
requests for reports containing dynamic prompts and cascading lists of values.

Web Intelligence Processing Server
The Web Intelligence Processing Server is used to create, edit, view, and analyze Web
Intelligence documents (stored in the Input/Output File Repository Servers). It also
processes scheduled Web Intelligence documents and generates new instances of the
document, which it stores in the Output File Repository Server. Depending on the
user’s access rights and the refresh options of the document, the Web Intelligence
Processing Server will use cached information or it will refresh the data in the
document and then cache the new information.

Understanding Server Groups
Server groups provide a way of organizing your SAP BusinessObjects BI platform
servers to make them easier to manage. That is, when you manage a group of servers,
you need only view a subset of all the servers on your system. More importantly,
server groups are a powerful way of customizing SAP BusinessObjects BI platform to
optimize your system for users in different locations, or for objects of different types.

If you group your servers by region, you can easily set up default processing settings,
recurrent schedules, and schedule destinations that are appropriate to users who
work in a particular regional office. You can associate an object with a single server
group, so the object is always processed by the same servers. And you can associate
scheduled objects with a particular server group to ensure that scheduled objects are
sent to the correct printers, file servers, and so on. Thus, server groups prove especially
useful when maintaining systems that span multiple locations and multiple time zones.
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If you group your servers by type, you can configure objects to be processed by
servers that have been optimized for those objects. For example, processing servers
need to communicate frequently with the database containing data for published
reports. Placing processing servers close to the database server that they need to
access improves system performance and minimizes network traffic. Therefore, if you
had a number of reports that ran against a DB2 database, you might want to create a
group of Processing Servers that process reports only against the DB2 database server.
If you then configured the appropriate reports to always use this Processing Server
group for viewing, you would optimize system performance for viewing these reports.

After creating server groups, configure objects to use specific server groups for
scheduling, or for viewing and modifying reports. Use the navigation tree in the
Servers management area of the CMC to view server groups. The Server Groups List
option displays a list of server groups in the details pane, and the Server Groups option
allows you to view the servers in the group.

To Create a Server Group
To create a server group, you need to specify the name and description of the group,
and then add servers to the group.

1. Go to the Servers management area of the CMC.
2. Choose Manage → New → Create Server Group. The Create Server Group

dialog box appears.
3. In the Name field, type a name for the new group of servers.
4. Use the Description field to include additional information about the group.
5. Click OK.
6. In the Servers management area, click Server Groups in the navigation tree and

select the new server group.
7. Choose Add Members from the Actions menu.
8. Select the servers that you want to add to this group; then click the > arrow. Tip:

Use CTRL+click to select multiple servers.
9. Click OK. You are returned to the Servers management area, which now lists all

the servers that you added to the group. You can now change the status, view
server metrics, and change the properties of the servers in the group.

Working with Server Subgroups
Subgroups of servers provide you with a way of further organizing your servers. A
subgroup is just a server group that is a member of another server group. For example,
if you group servers by region and by country, then each regional group becomes a
subgroup of a country group. To organize servers in this way, first create a group for
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each region, and add the appropriate servers to each regional group. Then, create a
group for each country, and add each regional group to the corresponding country
group. There are two ways to set up subgroups: you can modify the subgroups of a
server group, or you can make one server group a member of another. The results are
the same, so use whichever method proves most convenient.

To Add Subgroups to a Server Group
1. Go to the Servers management area of the CMC.
2. Click Server Groups in the navigation tree and select the server group you want

to add subgroups to. This group is the parent group.
3. Choose Add Members from the Actions menu.
4. Click Server Groups in the navigation tree, select the server groups that you

want to add to this group, and then click the > arrow. Tip: Use CTRL+click to
select multiple servers.

5. Click OK. You are returned to the Servers management area, which now lists
the server groups that you added to the parent group.

To make one Server Group a Member of Another
1. Go to the Servers management area of the CMC.
2. Click the group that you want to add to another group.
3. Choose Add to Server Group from the Actions menu.
4. In the Available server groups list, select the other groups that you want to add the

group to, then click the > arrow. Tip: Use CTRL+click to select multiple servers.
5. Click OK.

Modifying the Group Membership of a Server
You can modify a server's group membership to quickly add the server to (or remove
it from) any group or subgroup that you have already created on the system.

For example, suppose that you created server groups for a number of regions. You
might want to use a single Central Management Server (CMS) for multiple regions.
Instead of having to add the CMS individually to each regional server group, you can
click the server's "Member of" link to add it to all three regions at once.
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To Modify a Server's Group Membership
1. Go to the Servers management area of the CMC.
2. Locate the server whose membership information you want to change.
3. Choose Properties from the Manage menu.
4. In the Properties dialog box, click Existing Server Groups in the navigation list.

In the details panel, the Available server groups list displays the groups you can
add the server to. The Member of Server Groups list displays any server groups
that the server currently belongs to.

5. To change the groups that the server is a member of, use the arrows to move
server groups between the lists, then click OK.
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Exercise 2: Create Server Groups

Exercise Objectives
After completing this exercise, you will be able to:
• Create and test server groups

Business Example
For distributive processing and load balancing, you have two server groups,
Vancouver Server Group and New York Server Group. These server groups will
be used to regionally distribute the processing load for Crystal Reports consumption.

Task 1: Create the server groups
1. In the CCM, create a new SIA with no servers (Name it ServerGroupSIA).

Field Name Value

Node Name ServerGroup##SIA

SIA Port <assigned port number>

2. Select a CMS.

3. Specify the CMS system database configuration.

4. Enter the CMS logon information.

Field Name Value

System <assigned hostname>

User Name administrator

Password <assigned password>

Authentication Enterprise

5. In the CMC, clone the following servers found under the existing SIANode4x
to ServerGroup##SIA Node:

Note: Make sure you change the Naming convention manually so
the cloned server will include the ServerGroup##SIA prefix. i.e.
ServerGroup##SIA. Crystal Reports 2011 Processing Server

Continued on next page
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Server

Crystal Reports 2011 Processing Server

Crystal Reports Cache Server

Adaptive Job Server

Crystal Reports 2011 Report Application Server

Crystal Reports Processing Server

6. Start and enable the newly cloned servers.

Task 2: Create a server group
1. Log on to the CMC and navigate to the Servers area to create a new server group.

2. Select the newly cloned Crystal Reports Servers and add the following servers to
the server group.

Server

ServerGroupSIACrystal Reports 2011 Processing Server

ServerGroupSIA.Crystal Reports Cache Server

ServerGroupSIA.Adaptive Job Server

ServerGroupSIA.Crystal Reports 2011Report Application Server

ServerGroupSIA.Crystal Reports Processing Server

3. Create a new Server Group called New York Server Group.

4. Add the following Servers to New York Server Group

Server

SIANode4x.Crystal Reports 2011 Processing Server

SIANode4x.Crystal Reports Cache Server

SIANode4x.Adaptive Job Server

SIANode4x.Crystal Reports 2011Report Application Server

SIANode4x.Crystal Reports Processing Server

Continued on next page
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Result
To test the server groups, create a new Crystal Report using Crystal Reports 2011
using the xtreme SQL Server 2005 database. The report will be simple and only
include Customer Name Field and Last Year’s Sales.

Task 3: Create the Crystal report
1. Launch Crystal Reports 2011

Server WDFLBMT2268

UserID boadmin

Password BOTraining

Database xtreme

2. In the Database Expert navigate to the xtreme ODBC connection that you have
just created. and select the tables Customer and Orders.

3. Enable visibility for the Field Explorer and place the fields Customer Name
from the Customer table and Order ID and Order Amount from the Orders
table in the Details section of the design area with a small space between the
fields.

4. Save the Report to the SAP Business Objects platform folder- Report Samples.

5. Log on to the CMS and navigate to the Crystal Report you just saved to the
Report Samples Directory. Go to the properties of the report and expand the
Default Settings option. In the Scheduling Server Group option, select Only
use servers belonging to the selected group. Ensure the group selected is the
Vancouver Server Group

6. Navigate to the Viewing Server Group option under Default Settings Properties.
Under Default servers to use for processing, select Only use servers belonging
to the selected group. Ensure the Vancouver Server Group is selected. Select
the same option under Default servers to use for caching.

Task 4: Test the report against the server groups
1. Log on to BI Launchpad and navigate to the Documents tab. Click the Folders

drawer and navigate to the Crystal Report created earlier.

2. View the Report and refresh it. Are you able to view? Yes

Continued on next page
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3. Schedule the report to run. Did it process successfully? Yes. Click on the
success link in the instance. What server was used to process the schedule ?
Vancouver Server Group

4. Stop all the servers that are members of the Vancouver Servers Group

5. Schedule and view the same Crystal Report created earlier.

Are you successful? Observe any error messages that you receive.

6. Restart servers in the Vancouver Server Group.
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Solution 2: Create Server Groups
Task 1: Create the server groups
1. In the CCM, create a new SIA with no servers (Name it ServerGroupSIA).

Field Name Value

Node Name ServerGroup##SIA

SIA Port <assigned port number>

a) Click Start → Programs → SAP BusinessObjects Enterprise XI 4.0 → SAP
BusinessObjects Enterprise → Central Configuration Manager.

b) In the Central Configuration Manager (CCM), on the toolbar, click Add
Node.

The Add Node Wizard page appears.

c) Click Next.

d) Enter the Node Name and SIA Port number for the new Server Intelligence
Agent (SIA).

e) Select Add node with no servers.

f) Click Next.

2. Select a CMS.

a) Select Use existing running CMS.

b) Click Next.

Continued on next page
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3. Specify the CMS system database configuration.

a) Click Specify....

b) Select SQL Server (ODBC).

c) Click OK.

A window appears asking you to select the data source.

d) Click the Machine Data Source tab.

e) Select the BOE4x Data Source.

f) Click OK.

Note: If you are prompted to enter the password and cluster key.
Use the assigned administrator's password and cluster key.

g) Click OK.

h) Click Next.

4. Enter the CMS logon information.

Field Name Value

System <assigned hostname>

User Name administrator

Password <assigned password>

Authentication Enterprise

a) Enter the logon information and click Next.

A confirmation box appears.

b) Review the confirmation page, and click Finish.

Hint: If any errors occur, review the log file.

The CCM creates a node. You can now use the CCM to manage this new
node.

Continued on next page
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5. In the CMC, clone the following servers found under the existing SIANode4x
to ServerGroup##SIA Node:

Note: Make sure you change the Naming convention manually so
the cloned server will include the ServerGroup##SIA prefix. i.e.
ServerGroup##SIA. Crystal Reports 2011 Processing Server

Server

Crystal Reports 2011 Processing Server

Crystal Reports Cache Server

Adaptive Job Server

Crystal Reports 2011 Report Application Server

Crystal Reports Processing Server

a) Click Start → Programs → SAP BusinessObjects Enterprise XI 4.0 → SAP
BusinessObjects Enterprise → SAP BusinessObjects Enterprise Central
Management Console.

b) Log on with your username and password.

c) In the CMC Home page, click Servers.

d) Click the + sign in front of Nodes.

You will see you newly created node is listed there, but it has no server.

e) In the Servers page, click Servers List.

f) Right-click the indicated server from SIANode4x and select Clone Server.

The Clone Server dialog box appears.

g) On the Clone to Node list, choose ServerGroup##SIA .

Note: This is where you want to add the cloned server.

h) Click OK.

i) Repeat the step for all the indicated servers.
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6. Start and enable the newly cloned servers.

a) In the Servers page, click the + sign in front of Nodes.

b) Select the node ServerGroup##SIA .

Note: The new server appears in the Servers management area of
the CMC.

Port number settings are also cloned. In many cases, such as
cloning a CMS, you will want to change the port number to avoid
port conflicts between the original server and its clone.

c) Navigate to each server and click Start Server and Enable Server.

Task 2: Create a server group
1. Log on to the CMC and navigate to the Servers area to create a new server group.

a) Log on to the CMC and navigate to the Servers area, Navigate to the Server
Groups container on the left panel and right click and select New → Server
Group.

The New Server Group Properties tab appears.

b) In the Server Group Name text box, type Vancouver Server Group.

c) Use the Description text box to include additional information about the
group.

d) Right click on the newly created Server Group and select the option Add
Members

2. Select the newly cloned Crystal Reports Servers and add the following servers to
the server group.

Server

ServerGroupSIACrystal Reports 2011 Processing Server

ServerGroupSIA.Crystal Reports Cache Server
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Server

ServerGroupSIA.Adaptive Job Server

ServerGroupSIA.Crystal Reports 2011Report Application Server

ServerGroupSIA.Crystal Reports Processing Server

a) Right-click the newly created Server Group and select Add Members.

b) Select the indicated servers and click > to add them to the server group.

c) Click OK.

This returns you to the Servers area in the CMC, which now lists all the
servers that you added to the server group. You can now change the status,
view server metrics and change the properties of the servers in the group

3. Create a new Server Group called New York Server Group.

a) In the Servers page, navigate to the Server Groups container on the left
panel and right click and select New → Create Server Group.

The Create Server Group Properties tab appears.

b) In the Server Group Name text box, type New York Server Group.
Use the Description text box to include additional information about the
group.

c) Click OK.

4. Add the following Servers to New York Server Group

Server

SIANode4x.Crystal Reports 2011 Processing Server

SIANode4x.Crystal Reports Cache Server
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Server

SIANode4x.Adaptive Job Server

SIANode4x.Crystal Reports 2011Report Application Server

SIANode4x.Crystal Reports Processing Server

a) Right-click the newly created Server Group and select Add Members.

b) Select the indicated servers and click > to add them to the server group.

c) Click OK.

This returns you to the Servers area in the CMC, which now lists all the
servers that you added to the server group. You can now change the status,
view server metrics and change the properties of the servers in the group

Result
To test the server groups, create a new Crystal Report using Crystal Reports
2011 using the xtreme SQL Server 2005 database. The report will be
simple and only include Customer Name Field and Last Year’s Sales.

Task 3: Create the Crystal report
1. Launch Crystal Reports 2011

Server WDFLBMT2268

UserID boadmin

Password BOTraining

Database xtreme

a) Click Start → Programs → Crystal Reports 2011 → Crystal Reports 2011.

b) On the Crystal Reports start page, choose Blank report.

c) In the Database Expert expand Create New Connection and click the [+]
icon next to ODBC (RDO)

d) Enter the connection information stated above and click Finish.
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2. In the Database Expert navigate to the xtreme ODBC connection that you have
just created. and select the tables Customer and Orders.

a) In the Database Expert navigate to ODBC (RDO) → WDFLBMT2268→
xtreme → dbo.

b) Select Customer and Orders. Transfer to the selected tables section by
clicking the [>] button and choose OK.

c) Do not change the tabe links that have been created automatically and
choose OK.

3. Enable visibility for the Field Explorer and place the fields Customer Name
from the Customer table and Order ID and Order Amount from the Orders
table in the Details section of the design area with a small space between the
fields.

a) Select the menu path View → Field Explorer.

b) In the Field Explorer, expand Database fields → Customer and drag
Customer Name into the Details section.

c) Expand Database Fields → Orders and drag Order ID and Order
Amount to the Details section of the report. Keep a slight distance between
the fields.

4. Save the Report to the SAP Business Objects platform folder- Report Samples.

a) Choose File → Save As ... in the menu. Choose Enterprise and log on
with the credentials stated above.

b) Navigate to the folder Report Samples and enter the file name U## Order
Amount per Country. Press Save
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5. Log on to the CMS and navigate to the Crystal Report you just saved to the
Report Samples Directory. Go to the properties of the report and expand the
Default Settings option. In the Scheduling Server Group option, select Only
use servers belonging to the selected group. Ensure the group selected is the
Vancouver Server Group

a) Click Start → Programs → SAP BusinessObjects Enterprise XI 4.0 → SAP
BusinessObjects Enterprise → Central Management Console.

b) Click Folders.

c) Navigate to the Report Samples folder and select U## Order Amount
per Country.

d) Right-click U## Order Amount per Country and select Properties.

e) In the Default Settings tab, click Scheduling Server Group. Select Only use
servers belonging to the selected group and ensure the group selected is the
Vancouver Server Group

f) Click Save.

6. Navigate to the Viewing Server Group option under Default Settings Properties.
Under Default servers to use for processing, select Only use servers belonging
to the selected group. Ensure the Vancouver Server Group is selected. Select
the same option under Default servers to use for caching.

a) In the Default Settings tab, click Default servers to use for processing.
Select Only use servers belonging to the selected group and ensure the
group selected is the Vancouver Server Group

b) In the Default Settings tab, click Default servers to use for caching. Select
Only use servers belonging to the selected group and ensure the group
selected is the Vancouver Server Group

c) Click Save & Close.

Task 4: Test the report against the server groups
1. Log on to BI Launchpad and navigate to the Documents tab. Click the Folders

drawer and navigate to the Crystal Report created earlier.

a) Click Start → Programs → SAP BusinessObjects BI platform 4.0 →
Custom Link to BI Launchpad

b) Log on with your username and password

c) Navigate to your U## Order Amount per Country report.
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2. View the Report and refresh it. Are you able to view? Yes

a) Right-click U## Order Amount per Country and select View.

3. Schedule the report to run. Did it process successfully? Yes. Click on the
success link in the instance. What server was used to process the schedule ?
Vancouver Server Group

a) Right-click U## Order Amount per Country and select Schedule.

b) Click Schedule.

4. Stop all the servers that are members of the Vancouver Servers Group

a) In the CMC, navigate to the Servers page.

b) Navigate to Server Groups → Vancouver Server Group.

c) Select all the servers under this group and click Stop.

5. Schedule and view the same Crystal Report created earlier.

Are you successful? Observe any error messages that you receive.

a) In the BI Launch pad, navigate to U## Order Amount per
Country.

b) Right-click U## Order Amount per Country and select View.

c) Right-click U## Order Amount per Country and select Schedule.

6. Restart servers in the Vancouver Server Group.

a) In the CMC, navigate to the Servers page.

b) Navigate to Server Groups → Vancouver Server Group.

c) Select all the servers under this group and click Start.
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Exercise 3: Configure the File Repository
Servers for High Availability

Exercise Objectives
After completing this exercise, you will be able to:
• Identify the root directory of the Input File Repository Server
• Set up active/passive File Repository Servers

Business Example
You need to set up active/passive File Repository Servers.

Task:
Using the Central Management Console, install a second and third Input File
Repository Server.

1. In the Central Management Console, add a second and third Input File
Repository Server.

Field Name Value

User name Administrator

Password <assigned password>

2. Start and enable the new Input File Repository Servers.

3. Ensure that the root directories of each Input File Repository Server is pointing
to the directory where the files are stored

4. Stop all the Input File Repository Servers and start them again in the following
order:

Order Server

1 Input File Repository Server

2 U## File Repository Server 2

3 U## File Repository Server 3

Continued on next page
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5. Go to: D:\Program Files (x86)\SAP Business Objects\SAP Business Objects
Enterprise XI4.0\Data\CrystalReportsCachingServer and delete the cache
directory. This ensures that you will not be able to view cached pages.

6. Using the BI Launch Pad, navigate to the Report Samples\Demonstration folder
and view theWorld Sales Report.

7. Stop the Input File Repository Server.

8. View the Order Processing efficiency Report.

Are you able to view the report? If so, which Input File Repository Server
handled the request to view this report?

9. ) Stop the U## File Repository Server 2.

10. View the Customer List report.

Are you able to view the report? If so, which Input File Repository Server
handled the request to view this report?

11. Stop the U## File Repository Server 3.

12. View the Comparative Income Statement report.

Are you able to view the report? If so, which Input File Repository Server
handled the request to view this report?

13. Restart the Input File Repository Server.

14. Remove both U## File Repository Server 2 and U## File Repository Server 3
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Solution 3: Configure the File Repository
Servers for High Availability
Task:
Using the Central Management Console, install a second and third Input File
Repository Server.

1. In the Central Management Console, add a second and third Input File
Repository Server.

Field Name Value

User name Administrator

Password <assigned password>

a) Click Start → Programs → SAP BusinessObjects BI platform 4.0→ SAP
BusinessObjects BI platform → SAP BusinessObjects BI platform Central
Management Console.

b) Log on with your username and password.

c) In the CMC Home page, click Servers.

d) Navigate to Servers List and click Manage → New → New Server.

e) In the Service Category field, select Core Services. Change the Select
Service to Input Filestore Service. Click Next. In the Available Additional
Service screen, click Next again.

In the Server Name field, enter U## File Repository Server
2. Click Create

f) Repeat the steps above to create U## File Repository Server 3.

2. Start and enable the new Input File Repository Servers.

a) Navigate to Servers List and select both U## File Repository Server 2 and
U## File Repository Server 3

b) Click Start and then Click Enable.
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3. Ensure that the root directories of each Input File Repository Server is pointing
to the directory where the files are stored

a) Right-click the Input File Repository Server and click Properties.

b) In the Properties tab, navigate to the File Store Directory field.

The value %DefaultInputFRSDir% specifies the directory where file
repository objects are stored.

Note: You may encounter performance issues if this directory does
not have adequate disk space.

c) Click the Placeholders tab.

d) Lookup the name %DefaultInputFRSDir% .

e) Write down the value for %DefaultInputFRSDir%.

4. Stop all the Input File Repository Servers and start them again in the following
order:

Order Server

1 Input File Repository Server

2 U## File Repository Server 2

3 U## File Repository Server 3

a) Navigate to Servers List and select all three servers and click Stop.

Hint: Wait a few moments for the servers to stop.

b) Select the first server on the list and click Start.

c) Select the second server on the list and click Start.

d) Select the third server on the list and click Start.

5. Go to: D:\Program Files (x86)\SAP Business Objects\SAP Business Objects
Enterprise XI4.0\Data\CrystalReportsCachingServer and delete the cache
directory. This ensures that you will not be able to view cached pages.

a) Navigate to the directory and delete all the cache directory.
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6. Using the BI Launch Pad, navigate to the Report Samples\Demonstration folder
and view theWorld Sales Report.

a) Click Start → Programs → SAP BusinessObjects BI platform 4.0→ SAP
BusinessObjects BI platform → SAP BusinessObjects BI platform Java
BI Launch Pad.

b) Log on with your username and password.

c) Click Documents.

d) Navigate to Folders → Public Folders → Report Samples →
Demonstration folder.

e) Right-clickWorld Sales Report and select View.

7. Stop the Input File Repository Server.

a) In the CMC, navigate to Servers List and select Input File Repository
Server.

b) Click Stop.

8. View the Order Processing efficiency Report.

Are you able to view the report? If so, which Input File Repository Server
handled the request to view this report?

a) In the BI Launch Pad, navigate to Folders → Public Folders → Report
Samples → Demonstration folder.

b) Right-click Order Processing efficiency Report and select View.

9. ) Stop the U## File Repository Server 2.

a) In the CMC, navigate to Servers List and select U## File Repository
Server 2.

b) Click Stop.

10. View the Customer List report.

Are you able to view the report? If so, which Input File Repository Server
handled the request to view this report?

a) In the BI Launch Pad, navigate to Folders → Public Folders → Report
Samples → Demonstration folder.

b) Right-click Customer List report and select View.
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11. Stop the U## File Repository Server 3.

a) In the CMC, navigate to Servers List and select U## File Repository
Server 3.

b) Click Stop.

12. View the Comparative Income Statement report.

Are you able to view the report? If so, which Input File Repository Server
handled the request to view this report?

a) In the BI Launch Pad, navigate to Folders → Public Folders → Report
Samples → Demonstration folder.

b) Right-click Comparative Income Statement and select View.

13. Restart the Input File Repository Server.

a) In the CMC, navigate to Servers List and select Input File Repository
Server.

b) Click Start.

14. Remove both U## File Repository Server 2 and U## File Repository Server 3

a) In the CMC, navigate to Servers List and select both U## File Repository
Server 2 and U## File Repository Server 3.

b) Click Delete.
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Exercise 4: Back up and Restore a SAP
BusinessObjects BI deployment

Exercise Objectives
After completing this exercise, you will be able to:
• Restore a failed SAP BusinessObjects BI deployment
• Back up respective file stores and databases
• Describe recovery process

Business Example
You need to restore a failed SAP BusinessObjects deployment. It consists of backing
up respective file stores and databases, as well as the recovery process.

Task 1: Back up SAP BusinessObjects deployment
1. Create a backup of the Input file store, the output file store, The SIA bootstrap

files, the server configuration, and the System Database.

2. Create a backup of the SAP business Objects Server Configuration using the
CCM

Task 2: Create a backup of the BIP40 system database
1. Using SQL Server 2005 Management Studio, create a new database and call it

BIP40_System_Backup

Field Value

Server type Database Engine

Server name <hostname>

Authentication SQL Server Authentication

User name <hostname>\boadmin

Password <assigned password>

Database name BIP40_System_Backup##

2. Create a an ODBC System DSN using the SQL NATIVE DRIVER and call
it BIP40_System_Backup##_DSN

Continued on next page
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3. In the CCM, copy the system data from BOE4X to BIP40_System_Backup##.

4. Start all functional SIAs in the CCM.

5. Restart Apache Tomcat.

6. Verify you can log on and view the World Sales Report found in the Report
Samples\Demostration folder.

Task 3: Restore a failed SAP BusinessObjects BI
platform 4.0 implementation.
1. Restore the SIA Bootstrap files from the BIP40 Back up directory to the

designated location

2. Restore the Input and Output Directory from the BIP40 Backup Directory
(ensure you override all existing files and subdirectories)

3. Restore the CMS system DB by going to the configuration tabs in the properties
for the SIANode4x. Use the Update Data Source Settings and point the CMS
to the BIP_System_Backup DSN.

4. Start SIANode4x and wait until all BOE servers have been started

5. Restore Server Configuration

Result
To test, log on to the CMC and verify you can view the World Sales Report in
the Report Samples\Demonstration directory
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Solution 4: Back up and Restore a SAP
BusinessObjects BI deployment
Task 1: Back up SAP BusinessObjects deployment
1. Create a backup of the Input file store, the output file store, The SIA bootstrap

files, the server configuration, and the System Database.

a) Create a folder in the Desktop and name it BIP40 Backup

b) Copy both the Input and Output directories from D:\Program
Files (x86)\SAP Business Objects\SAP Business Objects Enterprise
XI4.0\FileStore\

c) Copy the SIA bootstrap files for all of your functional nodes found in
D:\Program Files (x86)\SAP Business Objects\SAP Business Objects
Enterprise XI4.0\win64_x64

2. Create a backup of the SAP business Objects Server Configuration using the
CCM

a) Click Start → Programs → SAP BusinessObjects BI plaform 4.0 → SAP
BusinessObjects BI platform → Central Configuration Manager.

b) Click the Back up Server Configuration button (with a white Arrow
surrounded by red).

c) Click Next on the welcome screen.

d) Use the default option Use existing running CMS and click Next .

e) Enter the login information and click Next

.

f) Specify the path to the BIAR file and click Next.

Hint: Save the BIAR archive to the BIP40 Backup Folder.

g) Finish.

Task 2: Create a backup of the BIP40 system database
1. Using SQL Server 2005 Management Studio, create a new database and call it

BIP40_System_Backup
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Field Value

Server type Database Engine

Server name <hostname>

Authentication SQL Server Authentication

User name <hostname>\boadmin

Password <assigned password>

Database name BIP40_System_Backup##

a) Click Start → Programs → Microsoft SQL Server 2005 → SQL Server
Management Studio.

b) Enter the login information and click Connect.

c) From the Object Explorer, right-click Databases and select New
Database....

d) In the Database name field, enter BIP40_System_Backup##.

e) Click OK.

Continued on next page
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2. Create a an ODBC System DSN using the SQL NATIVE DRIVER and call
it BIP40_System_Backup##_DSN

a) Click Start → Programs → Administrative Tools → Data Sources (ODBC).

b) Click the System DSN tab.

c) Click Add....

d) Select SQL Server Native Client as the driver for which you want to set up
the data source.

e) Click Finish.

f) In the Name field, enterBIP40_System_Backup##_DSN for the data
source.

g) In the Description field, enter a brief description for your data source.

h) In the Server selection list, select your hostname for the SQL Server.

i) Click Next.

j) On the authentication screen, leave everything as default and click Next.

k) Change the default database to BIP40_System_Backup##.

l) Click Next.

m) Click Finish.

Hint: You can test the connectivity by clicking the Test Data
Source button. Ensure the result is successful. Click OK to exit
the window.
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3. In the CCM, copy the system data from BOE4X to BIP40_System_Backup##.

a) In the CCM, stop all functioning SIAs in your BIP40 deployment. Go to
the properties of the SIANode4x and navigate to the Configuration tab.

b) Under the CMS System Database Configuration area, click Specify.

CMS Database Setup window will appear.

c) Select Copy data from another Data Source and click OK. The specify
data source window appears

d) In the Copy to the following data source field, use the Browse button to
select the System DSN pointing to the BIP40_System_Backup## you
created earlier.

e) In the Get data from field, select the BOE4x System DSN and click OK.

Hint: BOE4x is found under theMachine Data Source tab in
the Data Source window.

f) A warning appears, click OK to proceed with the migration

g) Once the migration completes, you will need to re-point the CMS to the
original BOE4x DSN by clicking on the Specify button in the Configuration
tab, and select Update Data Source Settings to select the BOE4x DSN

4. Start all functional SIAs in the CCM.

a) Right-click Server Intelligence Agent (SiANode4x) and click Start.

b) Repeat this step for other SIAs in CCM.

5. Restart Apache Tomcat.

a) Right-click Apache Tomcat and click Start.

6. Verify you can log on and view the World Sales Report found in the Report
Samples\Demostration folder.

a) Click Start → Programs → SAP BusinessObjects BI platform 4.0 → SAP
BusinessObjects BI platform → SAP BusinessObjects BI platform Java
BI Launch Pad.

b) Log on with your username and password

c) Navigate to the Report Samples\Demostration folder

d) Right-click theWorld Sales Report and click View.

Continued on next page

142 © 2012 SAP AG. All rights reserved. 2012



BOE330 Lesson: Ensuring Availability in Multiple Tiers

Task 3: Restore a failed SAP BusinessObjects BI
platform 4.0 implementation.
1. Restore the SIA Bootstrap files from the BIP40 Back up directory to the

designated location

a) Copy the SIA bootstrap backup files back to the directory: D:\Program
Files (x86)\SAP Business Objects\SAP Business Objects Enterprise
XI4.0\win64_x64

2. Restore the Input and Output Directory from the BIP40 Backup Directory
(ensure you override all existing files and subdirectories)

a) Copy the backup Input and Output directories back to D:\Program
Files (x86)\SAP Business Objects\SAP Business Objects Enterprise
XI4.0\FileStore\

3. Restore the CMS system DB by going to the configuration tabs in the properties
for the SIANode4x. Use the Update Data Source Settings and point the CMS
to the BIP_System_Backup DSN.

a) In the CCM, go to the properties of the SIANode4x and navigate to the
Configuration tab.

b) Under the CMS System Database Configuration area, click Specify.

CMS Database Setup window will appear.

c) Select Update Data Source Settings and click OK.

d) Select SQL Server (ODBC) and click OK. Select the System DSN pointing
to the BIP_System_Backup DSN.

e) Enter the assigned Login ID and Password and click OK.

4. Start SIANode4x and wait until all BOE servers have been started

a) Select SIANode4x and click Start.

5. Restore Server Configuration

a) In the CCM, restore the server configuration settings from the BIAR file
saved to the BIP40 Backup directory in the Windows Desktop

Result
To test, log on to the CMC and verify you can view the World Sales Report
in the Report Samples\Demonstration directory
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Lesson Summary

You should now be able to:
• List deployment options for the application tier
• Explain vertical and horizontal scaling options
• Describe the new capabilities of the wdeploy tool and its role in creating high

availability in the application tier
• Understand high availability in the Intelligence tier
• Describe the process of CMS clustering
• Manage active/passive file repository servers
• Describe the SAP BusinessObjects BI platform servers in the Processing tier
• Understand the concept of server groups
• Create and work with server groups
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Unit Summary
You should now be able to:
• Describe the challenges in a Business Intelligence solution
• Explain the key factors in making your systems fault tolerant and highly available
• Define the deployment strategies for high availability in SAP BusinessObjects

BI platform
• List deployment options for the application tier
• Explain vertical and horizontal scaling options
• Describe the new capabilities of the wdeploy tool and its role in creating high

availability in the application tier
• Understand high availability in the Intelligence tier
• Describe the process of CMS clustering
• Manage active/passive file repository servers
• Describe the SAP BusinessObjects BI platform servers in the Processing tier
• Understand the concept of server groups
• Create and work with server groups
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Test Your Knowledge

1. What is a disaster?

2. Fault tolerance is also referred to as graceful degradation?
Determine whether this statement is true or false.
□ True
□ False

3. Name two benefits of hardware load balancers.

4. What is a CMS cluster?
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Answers

1. What is a disaster?

Answer: A disaster is any unanticipated event that creates a defined problem.
Disasters are usually considered in terms of severity.

2. Fault tolerance is also referred to as graceful degradation?

Answer: True

Fault tolerance is also referred to as graceful degradation.

3. Name two benefits of hardware load balancers.

Answer:

1. Monitoring network availability of servers within a cluster.
2. Accommodating session state.

4. What is a CMS cluster?

Answer: CMS clusters are a set of two or more CMS servers that function as
a single CMS. The CMSs in a cluster work together to maintain the common
system database.
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Unit 4
Performance, Scalability and Sizing

Unit Overview
This unit provides an overview of how SAP BusinessObjects BI platforms is designed.
It discusses the various reasons for sizing a system including the concept of scalability.
The lesson includes a methodology you can use to calculate a sizing solution.

Unit Objectives
After completing this unit, you will be able to:

• Define scalability
• List and describe general SAP BusinessObjects BI platform scalability

considerations
• Define the sizing process
• Size a SAP BusinessObjects BI platform deployment
• Determine system usage, reporting, document interaction, and general

deployment requirements
• Analyze deployment requirements to determine the size and configuration of a

deployment
• Identify service thresholds

Unit Contents
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Lesson: Designing a Scalable System

Lesson Overview
The SAP BusinessObjects BI platform architecture is scalable in that it allows
for a multitude of server configurations, ranging from standalone, single-machine
environments to large-scale deployments supporting global organizations. The
flexibility offered by the product’s architecture allows you to set up a system that
suits your current report requirements without limiting the possibilities for future
growth and expansion.

Lesson Objectives
After completing this lesson, you will be able to:

• Define scalability
• List and describe general SAP BusinessObjects BI platform scalability

considerations

Business Example

What is Scalability?
Scalability is the capacity to address additional system load by adding resources
without fundamentally altering the implementation architecture or implementation
design.

When building a scalable system, the main objective is to achieve a linear relationship
between the amount of resources added and the resulting increase in performance,
while maintaining the speed of the transactions after additional users are added and
more requests need to be processed.

There are two methods of scaling SAP BusinessObjects BI platform: vertical and
horizontal. Vertical scaling, also referred to as scaling up, is the ability to improve
system performance by taking advantage of the hardware on a single server.
Horizontal scaling, also referred to as scaling out, is the ability to improve system
performance by adding computers to the same enterprise solution. Adding memory to
the machine on which the Web Intelligence Processing Server is running to improve
performance is an example of vertical scaling. Adding a new machine to the enterprise
system and configuring additional Crystal Reports Processing Server services on it,
thus improving performance, is an example of horizontal scaling.
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Depending on your situation, you can run all services on one machine or you can
run them on separate machines. For example, you can run the Central Management
Server and the Event Server on one machine, while you run the Adaptive Processing
Server on a separate machine. The same service can also run in multiple instances on
a single machine.

General SAP BusinessObjects BI platform Scalability
Goals
When scaling your system, it is important to understand the general considerations for
system scalability and how each of the SAP BusinessObjects BI platform servers is
responsible for particular aspects of your system. You can scale a system to:

• Increase overall system capacity.
• Increase schedule reporting capacity.
• Increase report viewing capacity.

– Increase on-demand viewing capacity.
– Increase interactive viewing capacity.

• Improve web response speeds.

– Configure a web farm for load balancing.
– Optimize custom web applications.

This section focuses on the different aspects of your system’s capacity, discusses the
relevant components, and provides a number of ways in which you might modify
your configuration accordingly.

The overall performance and scalability of SAP BusinessObjects BI platform can
be affected by external factors. When thinking about the overall performance and
scalability of SAP BusinessObjects BI platform, keep in mind these points:

• SAP BusinessObjects BI platform depends upon your existing IT infrastructure.
SAP BusinessObjects BI platform uses your network for communication
between servers and for communication between SAP BusinessObjects BI
platform and client machines on your network. Make sure that your network has
the bandwidth and speed necessary to provide SAP BusinessObjects BI platform
users with acceptable levels of performance.

• SAP BusinessObjects BI platform processes reports against your database
servers. If your databases are not optimized for the reports you need to run, the
performance of SAP BusinessObjects BI platform may suffer.

• The way in which your network is configured and the third-party tools that
are used in correlation with SAP BusinessObjects BI platform may affect the
performance of SAP BusinessObjects BI platform.
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Increasing Overall System Capacity
As the number of report objects and users on your system increases, you can increase
the overall system capacity by clustering two (or more) Central Management Servers
(CMS). You can install multiple CMS services on the same machine. However, to
provide server redundancy and fault tolerance, you should ideally install each cluster
member on its own machine.

CMS clusters can improve overall system performance because every SAP
BusinessObjects BI platform request results, at some point, in a server component
querying the CMS for information stored in the CMS database. When you cluster
two CMS machines, you instruct the new CMS to share in the task of maintaining
and querying the CMS database.

Increasing Scheduled Reporting Capacity
Increasing Scheduled Reporting Capacity

All reports (Crystal Reports and Web Intelligence Reports) that are scheduled are
processed by a job server. You can expand SAP BusinessObjects BI platform by
running individual job servers on multiple machines or by running multiple job servers
of different types on a single multi-processor machine.

Note: The Web Intelligence Processing Server is added because it is
responsible for scheduling the physical processing of a Web Intelligence
document.
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If the majority of your reports are scheduled to run on a regular basis, there are several
strategies you can adopt to maximize your system’s processing capacity:

• Install all Adaptive Job Servers and Adaptive Processing Server in close
proximity to (but not on the same machine as) the database server against which
the reports run. Ensure that the File Repository Servers are readily accessible to
the installed services (so you can send a read report objects request from the Input
File Repository Server and send a request to write report instances to the Output
File Repository Server quickly). Depending upon your network configuration,
these strategies may improve the processing speed of your scheduled documents
because there is less distance for data to travel over your corporate network.

• Verify the efficiency of your reports. When designing reports in Crystal Reports,
there are a number of ways in which you can improve the performance of the
report itself by modifying record selection formulas, using the database server’s
resources to group data, incorporating parameter fields, and so on.

• Use event-based scheduling to create dependencies between large or complex
reports. For instance, if you run several very complex reports on a regular nightly
basis, you can use Schedule events to ensure that the reports are processed
sequentially. This is a useful way of minimizing the processing load that your
database server is subject to at any time.

• If some reports are much larger or more complex than others, consider
distributing the processing load through the use of server groups. For instance,
you might create two server groups, each containing one or more Adaptive
Job Servers. When you schedule recurrent reports, you can specify that it be
processed by a particular server group to ensure that especially large reports are
executed by more powerful servers.

• Increase the hardware resources that are available to your scheduling services.
If the server is currently running on a machine along with other SAP
BusinessObjects BI platform components, consider moving the server to a
dedicated machine. If the new machine has multiple CPUs, you can install
multiple Adaptive Job and Adaptive Processing Servers on the same machine
(typically no more than one service per CPU).

Increasing Report Viewing Capacity
Increasing on-demand viewing capacity

When you provide many users with View On Demand access to reports, you allow
each user to view live report data by refreshing reports against your database server.
For most requests, the Crystal Reports Processing Server retrieves the data and
performs the report processing, and the Crystal Reports Cache Server stores recently
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viewed report pages for possible reuse. If users use the Advanced DHTML viewer, the
Report Application Server (RAS) processes the request. If users use Web Intelligence,
the Web Intelligence Processing Server processes the request.

If your reporting requirements demand that users have continual access to the latest
data, you can increase capacity in the following ways:

• Increase the maximum allowed size of the cache for Crystal Reports.
• Verify the efficiency of your reports. When designing reports in Crystal Reports,

there are a number of ways in which you can improve the performance of the
report itself by modifying record selection formulas, using the database server’s
resources to group data, incorporating parameter fields, and so on. The efficiency
of the design of your universes impacts the processing speed of Crystal Reports.

• Increase the number of Crystal Reports Processing Servers that serve requests on
behalf of any single Crystal Reports Cache Server. You can install additional
Crystal Reports Processing Servers on multiple machines.

• Increase the number of Crystal Reports Processing Servers, Crystal Reports
Cache Servers, Web Intelligence Processing Servers, and Connection Servers
on the system, and then distribute the processing load through the use of server
groups. For instance, you might create two server groups, each containing one
or more Crystal Reports Processing Servers along with one or more Report
Application Servers. You can then specify individual reports that should always
be processed by a particular server group.

Increasing interactive viewing capacity

When you provide many users with interactive viewing capability, you allow each user
to interact with live data by refreshing reports against your relational database server or
OLAP data source. If your reporting requirements demand users have continual access
and interactivity with live data, you can increase capacity in the following ways:

• Verify the efficiency of your reports. When designing reports with Web
Intelligence you will gain the most improvement by carefully investigating the
efficiency of the underlying universe.

• Increase the number of Web Intelligence Processing Servers that create, view,
and edit Web Intelligence portal requests.
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Improving Web Response Speeds
Because all user interaction with SAP BusinessObjects BI platform occurs over
the web, you may need to investigate a number of areas to determine exactly
where you can improve web response speeds. These are some common aspects
of your deployment that you should consider before deciding how to expand SAP
BusinessObjects BI platform:

• Assess your web server’s ability to serve the number of users who connect
regularly to SAP BusinessObjects BI platform. Use the administrative tools
provided with your web server software (or with your operating system) to
determine how well your web server performs. If the web server is limiting web
response speeds, consider increasing the web server’s hardware and/or setting
up a “web farm” (multiple web servers responding to web requests to a single
IP address).

• If web response speeds are slowed only by report viewing activities, you can
increase scheduled reporting capacity and on-demand viewing capacity.

• Take into account the number of users who regularly access your system. If you
are running a large deployment, ensure that you have set up a CMS cluster.

If you find that a single application server (for example, the Tomcat Java Web
Application Server) inadequately serves the number of scripting requests made by
users who access your system on a regular basis, consider the following options:

• Increase the hardware resources that are available to the application server. If the
application server is currently running on the web server or on a single machine
with other SAP BusinessObjects BI platform components, consider moving the
application server to a dedicated machine.

• Consider setting up two (or more) Java application servers. Consult the
documentation for your Java Web Application Server for information on
load-balancing, clustering, and scalability.

Note: If your deployment requires a higher level of failover and fault
tolerance, exceeds three or more servers, or serves a large number of users who
would be severely affected by any system outage, then it is strongly advised
that you distribute the load of the application tier over multiple application
servers balanced through a hardware load balancer. Each application server
will connect to any CMS service running in the cluster, so the failure of one
application server would only affect the application tier, not the processing tier.

Using a web farm for load balancing

A web farm is a group of two or more web servers working together to handle browser
requests. Web farms are not currently supported by SAP BusinessObjects BI platform.
However, that is not to say that they won’t work together. Some customers have
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successfully deployed using web farms, but it is not a scenario that is tested during
the QA cycle, as a web server is not required as part of a SAP BusinessObjects BI
platform deployment. For Java environments specifically, there are no known issues
with the use of any web server proxy components that are supported by the application
server vendor or provider.

Note: For proxy load balancing, just as with hardware-based load balancing,
the use of sticky sessions is required.

Optimizing custom web applications

If you are developing your own custom desktops or administrative tools with the SAP
BusinessObjects BI platform Software Development Kits (SDK), be sure to review
the libraries and APIs. You can now, for instance, incorporate complete security
and scheduling options into your own web applications. You can also modify server
settings from within your own code to further integrate SAP BusinessObjects BI
platform with your existing intranet tools and overall reporting environment.

In addition, be sure to check the developer documentation available on your SAP
BusinessObjects BI platform product CD for performance tips and other scalability
considerations. The query optimization section in particular provides some preliminary
steps to ensuring that custom applications make efficient use of the query language.
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Lesson Summary

You should now be able to:
• Define scalability
• List and describe general SAP BusinessObjects BI platform scalability

considerations
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Lesson: Sizing an SAP BusinessObjects BI platform
deployment

Lesson Overview
Every SAP BussinessObjects BI deployment is unique and careful sizing calculations
and additional post-install testing is necessary in creating a successful deployment.

Lesson Objectives
After completing this lesson, you will be able to:

• Define the sizing process
• Size a SAP BusinessObjects BI platform deployment

Business Example
You want to maximize the value of any sizing you conduct, you need to determine
the differences between your user mix and landscape versus the deployment used
to generate the sizing guide data. You also want to find additional tuning and
configuration information which you can use to increase the performance of your BI
4.0 deployments.

About Sizing
Sizing for versions 3.1 and earlier were conducted using CPU Units. As of BI 4.0, CPU
Units are deprecated – they are no longer used for sizing BI 4.0 and later deployments.
There are many advantages to providing sizing estimates in SAPS including:

• Each hardware partners generates the SAPS rating for the systems that they
sell. This means the SAPS ratings are always current – there is built in
anti-obsolescence.

• SAPS are O/S independent, scalar units of capacity
• SAP Business Objects BI 4.0 sizing approach is now consistent with how SAP

provides sizing information for other products like Business Suite 7
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The Sizing Process
Since CPU Units are deprecated for sizing and each deployment is reliant on SAP
hardware partners, the sizing process of determining the system load and determining
the number of services required are no longer applicable for BI 4.0 implementation.
Instead the following step is recommended:

1. Determine the active-current users for each of the BI4.0 Client tools (Analysis,
edition for OLAP, BI Workspace, Crystal Reports 2011, Crystal Reports
Enterprise, Dashboards (Dashboard Design), Connection Server and Web
Intelligence

2. Work with SAP certified hardware partners using SAPS to secure the required
resources following the detailed description and guidelines for BI 4.0 Services.

What is a SAPS?
SAP Application Performance Standard (SAPS) is a scalar, architecture and O/S
independent measure of capacity. It has been developed over the last 19 years and
every hardware platform we support has a SAPS value which is calculated by the
hardware partner using the SAP SD Benchmark (the “SAP Standard Benchmark Kit”).
Each Tshirt sizing guide describes SAPS in more detail.

Hint: An active-concurrent user is a user who is actively executing a
workflow. In the benchmarks used to create this document, all users are
active-concurrent. No user is idle (i.e. sitting at the BI Launch Pad home
page).

Service Capacity
This section contains service capacity as measured against concurrent-active users
utilizing each particular service.

Service Name Recommended Maximums

Central Management
Server

500 concurrent-active users per instance.

Crystal Reports Cache
Server

400 simultaneous requests per instance.
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Service Name Recommended Maximums

Crystal Reports
Processing Server (CR
2011)

If maximum simultaneous report jobs is set to auto, 1
service per CPU will default to 25 simultaneous requests
– except single CPU machine which defaults to 50. Only
configure 1 CR Processing Server instance per machine
(unless you’re using server groups).

Web Intelligence
Processing Server

25 simultaneous connections per instance.

Web Application Server 100 simultaneous requests per core for Java viewer. 50
simultaneous requests per core for HTML viewer.

Server Intelligence Agent
One Server Intelligence Agent (SIA) is required to run on each machine regardless
of CPU configuration. The SIA maintains server status according to the settings
you specify in the CMC. It processes the CMC's requests to start, stop, monitor,
and manage all servers on the node, and it also monitors potential problems and
automatically restarts servers that have shut down unexpectedly. The SIA ensures
optimal performance by continually monitoring server status information, which is
stored in the CMS database. When you change a server's settings or add a new server
in the CMC, the CMS notifies the SIA, and the SIA performs the task.

Memory Requirement
Only RAM memory consideration is required to maintain the execution of SIA. The
recommended RAM memory is 350MB.

Central Management Server
The principle component of the SAP Business Objects BI 4.0 system is the Central
Management Server. Its primary responsibilities include (but are not limited) to the
following:

• Management of Users & User Groups
• Management of object security
• Central system configuration
• Management of scheduled tasks
• Management of historical tasks. (such as success or failed instances) Cluster

management
• Management of system objects (i.e., Info Objects)
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• License management
• System database management
• Name service
• Cluster management

General Considerations
The CMS manages many areas as described above. The state of various activities
is persisted in the CMS repository. This is what enables multiple CMSs to run in
a cluster as well as providing for fault tolerance. The CMS depends heavily on
the repository for the proper functioning of BI 4.0. It is therefore imperative that
the DBMS where the repository is optimally tuned and running on a machine with
sufficient capacity (memory, CPU, fast disk and network bandwidth) and reliability.
Stated another way, if access to the repository database is slow or the reliability is at
question, then the BI 4.0 deployment will not deliver maximum performance and
reliability. This also means network throughput between any node running a CMS
and the repository database must not be affected by other heavy traffic (like backups
running during production hours). This cannot be overstated.

Note: It is recommend that the maximum number of CMS services in a
cluster to be 4. This is where the best balance of CMS performance and
network traffic occurs.

CMS Clustering Across Subnets
A cluster that has 2 or more CMS cluster members on different subnets is technically
possible and has been QA tested. This configuration is supported by SAP, strictly
providing that no significant additional network latency is created as a result of an
additional subnet.

The most important factor to ensure efficient CMS clustering performance is to
eliminate excessive latency between CMS services and the CMS Database.

For example: CMS1 and the CMS system database are located in the same datacenter
in New York. CMS2 is a member of the same cluster as CMS1 but is located in China
and must communicate with the CMS database in New York. Excessive network
latency of CMS2 in China to the CMS database in New York would be problematic.

Make sure that all CMS members of a cluster have uniform communication speeds
to the system database.

Note: For best performance, run each CMS cluster member on a machine that
has the same type of CPU, same O/S, same amount of memory and so forth –
the machines should be as identical as possible to ensure uniform performance.
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Processor Requirements
The number of cores (and, by association, SAPS) required to support CMS services
will be highly dependent on the type of CMS activity. For example, large updates to
the CMS system database (i.e. adding or deleting a large number of users; viewing or
querying a large number of objects) will use significant CPU time. For increased CMS
throughput and response times allocate additional CPU resources.

Memory Requirements
For best performance, run each CMS cluster member on a machine that has the
same amount of memory. Memory usage is controlled (roughly) by the number of
objects stored in the object cache. The table earlier in this section covers how to
adjust the maximum number of objects in the cache. This specifies the maximum
number of objects that the CMS stores in its memory cache. Increasing the number
of objects reduces the number of database calls required and greatly improves CMS
performance. The memory restrictions that existed in earlier versions with respect
to the number of objects in cache has been removed.

Crystal Reports Cache Server
The Cache Server stores report pages generated by the Processing Server. By storing
report pages in cache, the Processing Server and/or database server does not need to
be accessed each time the report is requested. The Cache Server is used for viewing
of Crystal Reports only, and if viewer’s preference is set to any viewer other than
Interactive DHTML.

When a report is requested for viewing, the system will first check the Cache Server to
see if there are any current available cache pages generated for that report. If there
are pages, the Cache Server will send available report pages to the Web Application
Server. If there are no cached pages, the Cache Server will request a Processing
Server to generate these pages.

The threshold that determines the number of Cache Server services required is the
“maximum simultaneous processing threads” per Cache Server service. The number
of “simultaneous processing threads” is equal to the number of simultaneous requests.

Parameters for the Crystal Reports Cache Server
These parameters are set in the CMC. Note for parameters that affect the caching of
user data, you should make sure the interval length is not any longer than the shortest
interval for refresh of any referenced data source. Note the Oldest on-Demand Data
settings will ensure that data is kept in cache no longer than the set interval no matter
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how often the cached data is referenced. You should also make sure that any properties
that apply to both the Crystal Reports Cache server and Crystal Reports Processing
Server are set to the same respective value.

Option Values Behavior Recommended
Setting(s)

Oldest On-Demand
Data Given to
Clients

seconds Specifies the
amount of time
that the server uses
cached data to
meet request from
ondemand reports.

Default value
is 0 seconds –
which means
ODD is disabled
Recommended
setting is 300000

Viewer Refresh
Always Yields
Current Data

On/Off Control caching
effectiveness

ON

Share Report Data
Between Client

On/Off Control caching
effectiveness

ON

Disk Requirements
For the Cache Server service, sufficient hard drive disk space should be available
for the generation of cache files as well as in the temp directory for the creation of
temp files (located in %DefaultDataDir%/CrystalReportsCachingServer/temp). The
location of Cache Server cache files can be specified from the Central Management
Console. The highest volume of cache files will likely be the encapsulated page
file or .epf. A single .epf file represents one page of a Crystal report and the size of
the individual file is variable dependent on the complexity of the report page (e.g.,
a single .epf file from the sample Statement of Account report is 88kb in size). A
sufficient amount of disk space should be made available to support all potential
cache pages generated at a given period.

File Repository Servers (FRS)
There is an Input and an Output File Repository Server in every SAP BusinessObjects
BI 4.0 implementation.

• The Input File Repository Server manages the underlying report files, agnostic
documents and other file content which is persisted on disk. Examples include
Crystal Reports 2011 and Enterprise reports, Analysis, edition for OLAP reports,
Web Intelligence reports, program objects, Microsoft Excel files, Microsoft
Word files, Microsoft PowerPoint files, Adobe Acrobat PDFs, rich text format
files, text files, hyperlinks, object packages. These are published to the system
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by administrators or end users (using the Publishing Wizard, the Central
Management Console, or a Business Objects designer component such as Crystal
Reports or the Web Intelligence Java or HTML Report Panels)

• The Output FRS maintains all the instances that have been produced from
reports (Crystal, or Web Intelligence), programs, and object packages that have
been scheduled.

Repository location
You may have multiple FRS (input) and FRS (output) services on one or several
different machines to support a high-availability environment, however the FRS
services will behave in an Active/Passive fashion where the first available FRS will be
Active and all other FRS services will remain passive unless the Active FRS becomes
unavailable. The Input and Output Repository do not have to reside on the same
machine. The location of the FRS repositories is managed through the CMC in the
Servers section under the Properties tab.

Parameters for the FRS

Option Values Behavior Recommended
Setting(s)

Maximum Idle
Time

Minutes This setting limits
the length of time
that the server
waits before it
closes inactive
connection.

Default value is
20. Note: Setting
a value too low
can cause a user’s
request to be closed
prematurely.
Setting a value
too high can cause
excessive user of
system resources
such as processing
and disk space.

Calculate Number of File Repository Servers (FRS) Required
One of each Input and Output File Repository Servers are required. In larger
deployments, there may be multiple Input and Output File Repository Servers, for
redundancy. In this case, all Input File Repository Servers must share the same
directory. Likewise, all Output File Repository Servers must share a directory.
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Processor Requirements
The File Repository Servers require higher I/O resources (faster disk, network)
and fewer CPU resources. When estimating resource requirements in the SAP
BusinessObjects BI platform the File Repository Servers are not considered.

Memory Requirements
The File Repository Servers will have little impact on system memory.

Disk Requirements
Enough disk space must be available to store files. We recommend “fast” disk for both
the input and output FRS file systems – especially for high volume publications.
Typically the Output FRS will require more disk space than the Input FRS. The
Output FRS maintains all the instances (with Saved Data) that have been produced
from reports (Crystal or Web Intelligence), programs, and object packages that have
been scheduled, and as such will require proportionately more disk space. For both
the Input and Output FRS, the amount of space required will vary from system to
system, however, knowing the average file size and multiplying this by the number of
projected instances will assist in estimating total disk needs.

Adaptive Processing Servers and Adaptive Job Servers
Adaptive Processing Server (APS) and Adaptive Job Servers (AJS) are java host
containers that run other services. The APS is for ‘on-demand’ processing and the AJS
is for delegating the processing for scheduled jobs. The APS can host one or more
of the following services: Search Service, Client Auditing Proxy Service, MDAS,
DSL Bridge Service, CVOM, Publishing Post Processing Service and Publishing
Service. The AJS can host one or more services including the Destination Delivery
Scheduling Service, the Publication Scheduling Service, the Program Scheduling
Service, the Replication Service, the Crystal Reports Job Service, the LOV Job
Service, the Web Intelligence Job Service and the Destination Configuration Service.
This is not an exhaustive list.

Note: The DSL Bridge Service that runs in the APS is used by any BI 4.0
client tool which accesses BW data via the transient universe. Note the
APS and AJS are not the same as the Java components of Crystal Reports
Enterprise and the other products (like the Crystal Reports Processing Server).
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Parameters for the Adaptive Processing Server

Option Behavior Recommended Setting

Log level Default setting is
“unspecified”. Changing
this to a higher logging
level will increase the
amount of disk space
consumed which can
grow quite large (i.e.
setting this at a higher
level on a production
system which will also
impact performance).
Only increase the log level
when troubleshooting.

Recommended to leave as
“Unspecified”. Other
values are “None”,
“Low”, “Medium” and
“High”. Consult the
Administrator’s Guide for
more information.

-Xmx1024M This command line flag
will increase the server’s
heap size A 1GB heap size
is recommended unless
otherwise noted – check
the specific sections below
for exceptions.

Enables to server to handle
more requests. Ensure
you have sufficient free
memory at peak before
increasing this value.
Note that certain clients
like Analysis, edition for
OLAP may recommend
a 4GB heap size for an
APS running the MDAS
service

For APS instances running publication services, we recommend having 1 APS
instance for every 3 concurrent publications.

For small deployments (running a dozen or less users) like development systems,
small demo systems or sandbox systems where performance isn’t critical, you can run
multiple types of services in a single APS.

For medium to large deployments, it is a general recommendation that an APS
instance host only one service for those services which are critical to performance and
that you will need to scale out as capacity is added. For example, you would not have
one APS instance hosting the CVOM and DSL Session Service – you would have at
least one for each. The memory requirements of the some of the services hosted by
the APS can be quite large. By separating services across APS instances (and nodes),
you gain better manageability for memory and scalability considerations.
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Adaptive Job Server- Web Intelligence Job Service
Processor Requirements

The Web Intelligence Job Service has a comparable function to the Crystal Reports
Job Service in that it is responsible for handling Scheduled Jobs. However, the
Web Intelligence Job Service does not actually “process” reports, but only acts as a
scheduling manager or “router” sending jobs to be processed by the Web Intelligence
Processing Server

Disk Requirements

For the Web Intelligence Job Server service, sufficient hard drive disk space should be
available in the temp directory for the creation of temp files during report processing.
The data from the database server is stored in these files until it can be saved and
compressed in the report

Adaptive Job Server- Crystal Reports Job Service
Memory Requirements

Depending on the design of a report, the number of records retrieved from the
database, memory requirements may vary. When a report is executing and loaded into
memory the report is decompressed and expanded up to as much as 40 times the
original report file size (with saved data/retrieved records).

Disk Requirements

For a Crystal Reports Job Service, sufficient hard drive disk space should be
available in the temp directory for the creation of temp files during report processing
(%DefaultDataDir%). The data from the database server is stored in these files until
it can be saved and compressed in the report. Hard drive access speed to the temp
directory may have an impact on the speed at which a report processes

Search Service
The Search Service manages the delivery of search content.

• Memory: 500MB
• Disk space: same size as FRS

Client Auditing Proxy Service
The Client Auditing Proxy Service manages the loggings of events of all clients.

• Load: N/A Memory:
• 500MB Disk space: N/A
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Services for Publishing
In order for the Publishing service to be available, the Publishing Post Processing
Service, Publishing Service, and the destination Delivery Service need to be hosted.

Program Scheduling Service
The Program Scheduling Service manages schedule executable objects. Memory
and disk space consumption varies depending of individual executable runtime
requirements.

Dashboard Design
The tables below assume all BI 4.0 services are deployed on the same machine and
the only load on the machine are Dashboard Design scenarios. Note the scenarios
run at the suite level differ slightly from the workflows that form the basis of these
observations. The differences were slight (a little less think time in one case and 100
more rows run in the Suite sizing case).

Dashboard Design
Processing Server

Dashboard Design
Cache Server

CPU Only one instance is
needed per machine.
The processing server
will manage its own
child processes to take
advantage of the systems
resources

Only one instance is
needed per machine.

Memory Parent 40MB base to
40MB under typical
operation.
Children 40MB base
to 40MB under typical
operation. The Java JVM
is allowed up to 858 MB
in heap memory.

80MB base to 120MB
under typical operation.
The in-process Java JVM
is allowed up to 858 MB
in heap memory.

Disk No significant disk space
is required for this server.

Disk consumption is
configurable. The default
cache size is up to 250 MB
but is used only as needed.
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Dashboard Design
Processing Server

Dashboard Design
Cache Server

Process/Instance CPU Core dependent. 25
users per CPU core is the
recommendation.

CPU Core dependent. 25
users per CPU core is the
recommendation.

Optimal Configuration
Parameter

Idle Connection Timeout
= 2 minutes
Idle Job Timeout = 2
minutes

Oldest On-Demand Data
Given to Clients = 900
seconds
Idle Connection Timeout
= 2 minute

Sizing/Scale Note Adding additional
processing servers should
only be done if the
processing server parent is
the CPU bottleneck. This
has never been the case in
any test scenario.

Adding additional cache
servers should only be
done if the cache server
is the CPU bottleneck.
Since each cache server
maintains a separate
cache, adding more
cache servers can have
a negative effect since
there is no guarantee that
similar requests will reach
the same cache server,
thus prompting additional
processing.

BI Workspaces
The tables below assume all BI 4.0 services are deployed on the same machine and the
only load on the machine are BI Workspace scenarios. Note the scenarios run at the
suite level differ slightly from the workflows that form the basis of these observations.

Server Specific Comments

CPU Most of the BI Workspace code is now Java code being
run by the Java Application Server (usually Tomcat). It is
best to have one Java AS instance per each BOE instance
in a clustered installation.

Memory It is critical that there is enough RAM available to the
server instance so as not to require paging. If the Java AS
is configured with a heap size of 2GB, and the operating
system requires another 1GB, and other processes require
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Server Specific Comments
another 2GB, then 6GB of RAM should be installed on
the server to preserve a buffer for memory usage. Our
load tests show that about 500MB of memory is recycled
per hour during load. If possible, a heap size of 2GB
should be allocated to the Java AS and another 2GB
should be reserved for use by the C++ processes such
as the CMS.

Disk There is no critical requirement for disk space for BIW.

Process/Instance On our hardware, we brought the server to 100% CPU
usage with 250 users. However, you should plan for no
more than 100 concurrent users per instance to keep the
load on the server low and reserve server resources for
peak usage times.

Optimal Configuration
Parameter

N/A

Sizing/Scale N/A

Web Intelligence Processing Server
The Web Intelligence Processing Server is used to create, edit, view, and analyze Web
Intelligence documents (stored in the Input/Output FRS). It also processes scheduled
Web Intelligence documents and generates new instances of the document, which it
stores on the Output File Repository Server (OFRS). Depending on the user's access
rights and the refresh options of the document, the Web Intelligence Processing
Server will use cached information, or it will refresh the data in the document and
then cache the new information.

Processor Requirements

The Web Intelligence Processing Server will expand to as many CPUs as needed by
scaling-up the number of Web Intelligence Server service and can process several
documents in parallel, so only 1 Web Intelligence report server is required per machine
as a starting point

Memory Requirements

Depending on the design of a report, the types of actions being performed (viewed,
modified, refreshed) memory requirements will vary. A “refresh” request demands
the greatest amount of memory for a Web Intelligence document as the database is
queried and the entire dataset will be transferred to the Web Intelligence server.
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When using several very large documents, it is not necessary to increase the number
of Web Intelligence Processing Server instances to more than 1 per machine because
in BI 4.0, the platform and all services are native 64 bit. You may choose to create
more than one Web Intelligence Processing Server instance per machine for tuning
reasons not related to memory.

Load balancing between the Web Intelligence Processing servers is handled by the
CMS services automatically.

Crystal Reports Processing Server -
Note there are two different types in BI 4.0. The Crystal Reports 2011 Processing
Server utilizes the same architecture as previous versions. However, the Crystal
Reports Enterprise Processing Server has a new architecture. Whereas the child
processes were single threaded in previous versions, in Crystal Reports Enterprise,
they run as threads in a Java component. This means additional tuning can be applied
to the Crystal Reports Enterprise Processing Server.

Both Processing Servers are primarily responsible for responding to page requests by
processing crystal reports and generating Encapsulated Page Format (EPF) pages. A
single .epf file represents one page of a Crystal report. The Processing Server retrieves
data for the report from the latest instance or directly from the database (depending on
the user’s request and user’s security level).

Specifically, both Processing Servers respond to page requests made by the Cache
Server. The Processing Server and Cache Server interact closely, so cached EPF
(encapsulated page files) pages are reused as frequently as possible, and new pages
are generated as soon as they are required. The InfoView portal takes advantage of
this behavior by ensuring that the majority of report-viewing requests are made to
the Cache Server and Processing Server. However, if a user’s default viewer is the
Interactive DHTML viewer, the Report Application Server processes the report.

The Crystal Reports 2011 Processing Server creates Processing Server Sub Processes.
Each Sub Process loads CRPE and then instantiates threads or Print Jobs as needed.
With the Crystal Reports 2011 Processing Server, if an individual Print Job were to
fail for any reason, only those threads contained in the Processing Server Sub-Process
would be affected. All other Sub Processes within the Processing Server service
would be unaffected. In addition, individual Sub Processes are shut down after
so many requests and a new Sub Process is started, if required, so as to maximize
resource management
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Crystal Reports Enterprise Processing Server

Option Values Behavior Recommended
Setting(s)

Max. Concurrent
Jobs

0 for
automatic

Max. Lifetime
Jobs per child

Number Default value is 1000

Max. No. of
Prestarted Children

Number Default value is 1

Idle Connection
timeout

Minutes Default value is 20

Idle Job Timeout Minutes Default value is 60
secs.

Oldest On-Demand
Data Given to
Clients

Seconds Specifies the amount
of time that the server
uses cached data to
meet request from
on-demand reports.

Default value
is 0 (disabled)
Recommended setting
is 300000

Crystal Reports 2011 Processing Server

Option Values Behavior Recommended
Setting(s)

Database Records
Read When
Previewing or
Refreshing (0 for
unlimited)

Specifies the max.
no. of DB records to
read when the report
is being previewed
or refreshed. Allows
you to limit the no. of
records that the server
retrieves from the DB
when a user runs a
query report.

Default value
is 20000.
Recommendation
is to schedule large
reports to reduce the
load on your DB from
these large queries.

Idle Job Timeout Minutes Specifies the length
of time, the CR
Processing server

Default value is 60
min.
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Option Values Behavior Recommended
Setting(s)

waits between
requests for a given
job.

Allow Report Jobs
to Stay connected
to the DB until
the Report Job is
closed

On/Off On

Oldest On-Demand
Data seconds
Given to Clients

seconds Specifies the amount
of time that the
server uses cached
data to meet request
from on-demand
reports. (disabled)
Recommended

Default value
is 0 (disabled)
Recommended setting
is 300000

Report Application Server
The Report Application Server (RAS) is very similar to the Processing Server. It, too,
is primarily responsible for responding to page requests by processing reports and
generating EPF pages. Additionally, Report Application Server is used at the time
of viewing or submitting schedule requests for reports containing dynamic prompts
and cascading lists of values.

The default Maximum Simultaneous Report Jobs is set at 75 for each RAS service.
This value, as with the Crystal Reports Processing Server, may be adjusted
according to anticipated load and available hardware resources. The ideal setting
for your reporting environment, however, is highly dependent upon your hardware
configuration, your database software, and your reporting requirements. Additionally,
a recommended guideline is to run 1 Report Application Server per CPU.

Depending on the design of a report, the number of records retrieved from the
database, memory requirements may vary. When a report is viewed and loaded into
memory the report is decompressed and expanded up to as much as 40 times the
original report file size (with saved data/retrieved records).

These parameters are settable in the CMC.

2012 © 2012 SAP AG. All rights reserved. 175



Unit 4: Performance, Scalability and Sizing BOE330

Option Argument Units Behaviour Recommended
Setting(s)

Browse Data Size
(records)

Number Specifies the # of
distinct records
returned from the
database when
browsing through
a particular field's
values.

Default value is
100 records.

Idle Connection-
Timeout

Minutes Specifies the
amount of time, in
min.that the RAS
waits for requests
from an idle client
before timing out.

Default value is 30
min.

Batch Size Records Specifies how
many rows from
the result set are
returned by the
database during
each data transfer

Default value is
100 records.

Number of
database records
to read when
previewing or
refreshing a report

Records Specifies the
number of database
records that will be
read when viewing
or refreshing a
report.

Default value is
20000 records (-1
for unlimited)

Maximum
Concurrent Report
Jobs

Jobs Specifies the max.
no of independent
jobs allowed to run
concurrently on the
RAS.

Default value is
75 jobs (0 for
unlimited)

Oldest on-demand
data given to a
client

Minutes Specifies the
amount of time,
in minutes,an
on-demand report
will serve cached
report data.

Default value is 20
minutes
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Example (minimum memory requirements on RAS machine): 500KB Report File
Size (contains saved data) = 500KB * 40 (decompression ratio) = 20MB 25 Reports *
20MB = 500MB minimum memory required

Analysis, edition for OLAP
Factors that influence performance

The first category is factors that aren’t specific to Analysis, edition for OLAP:

• Network bandwidth and quality
• Other services that are enabled that would have a small effect on performance

(like monitoring or auditing)

The second category is factors specific to Analysis, edition for OLAP:

• Hardware settings (HDD RAID settings, memory tuning)
• Defining an optimum server deployment
• JVM memory and GC settings
• Number of MDAS services on the same server machine

Testing has shown a practical limit of 45 users per machine. This is due to a number
of factors including the memory needed to support 45 users (for the MDAS instances
alone this is 12 GB). Supporting 45 users implies three MDAS instances (3 MDAS
instances * 15 users recommended max/MDAS instance). Keep in mind it is better to
scale out than up for BI 4.0 in general. You have more flexibility in terms of allocating
services with more nodes, not less.

So, if you wanted to have 3 MDAS instances running, that means you have 3 APS
instances which are only running the MDAS service.

An alternate way to configure for 45 users would be to run one APS running the
MDAS service supporting 45 sessions. Testing shows this performs better – likely due
to the elimination of load balancing. However, as we recommend 4GB heap size per
15 users, that would mean an APS with a heap size of 12 GB.

Connection Server
Connection Server performance is highly dependent on the backend database
performance. Most of query time will be spent in the database middleware. However,
performance can be improved by adjusting the array fetch size: this parameter
determines the number of rows that will be retrieved during a fetch cycle. Larger
array fetch sizes reduce the number of network calls, but increase memory footprint.
Smaller values put more load on the network, but reduce memory use. In addition,
different Connection Server modes can also have an impact on performance. By
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default the “Extended” smart switchboard is used to maximize available connections
and performance. Different deployment scenarios can also improve performance,
for instance by making sure a database middleware is available locally for a Web
Intelligence node.

Event Server
The Event Server under normal enterprise usage is not a processing or memory
intensive server and as such will not be weighted in the sizing process. If Event Server
functionality is required, allocate this service into the system but do not estimate any
additional cores for this service.

Web Application Server
Below are the suggested settings for some of the web servers.

Web Application
Server

Java Heap Recommended Settings

Tomcat 6 Change the JVM Heap size in the 'Java Options' box.
Add the line '-XX:MaxPermSize=256m' Fill out the
"Maximum memory pool" field with the host machine's
memory (e.g., 1024).

WebLogic 10.0 -Xms1024m -Xmx1024m -XX:MaxPermSize=512m

Oracle Application
Server 10gR3 (10.1.3.0)

-Xms1024m -Xmx1024m

SAP NetWeaver CE
7.20

Use default settings for NetWeaver

WebSphere Community
Edition 2.0

Use default setting for WebSphere CE 2.0

Tomcat 5.5 Change the JVM Heap size in the 'Java Options' box.
Add the line '-XX:MaxPermSize=512m'
Fill out the "Maximum memory pool" field with the host
machine's memory (e.g. 1024). This is in MB.

178 © 2012 SAP AG. All rights reserved. 2012



BOE330 Lesson: Sizing an SAP BusinessObjects BI platform deployment

Web Application
Server

Java Heap Recommended Settings

WebLogic 9.2.2 Update the following in the file (substitute your
drive letter as appropriate) C:\bea\user_projects\do-
mains\boe_domain\bin\setDomainEnv.cmd before
starting up WebLogic

From: MEM_ARGS="-Xms256m
-Xmx512m" To: #MEM_ARGS="-Xms256m
-Xmx512m" MEM_ARGS="-Xms820m -Xmx820m"
Also change the MaxPermSize under the
JAVA_VENDOR section inside setDoaminEnv.cmd
from: "-XX:MaxPermSize=128m" To:
"-XX:MaxPermSize=512m”

WebSphere 7.0 Use default setting for WebSphere 7.0

WebLogic 10.3 -Xms512m -Xmx1024m -XX:PermSize=256m
-XX:MaxPermSize=1024m

Sun Java System
Application Server
9.1

Use default setting.

JBoss 5.0 -Xms128m -Xmx512m -XX:MaxPermSize=256m

Performance Criteria
Some terminology is necessary to understand how database access may be optimized:

• Lock:

Locks are used to control concurrency in a database. When a process locks
a row or table, no other process can access it until the lock is released. The
level at which a lock is requested, that is, row or table level, is referred to as the
lock granularity.

• Deadlock:

A deadlock occurs when two or more processes conflict in such a way that each
must wait for the other to release its lock in order to complete.

• Lock wait:

A lock wait occurs when a process must wait for another process to release a
lock on a row or table.

• Lock escalation:
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A lock escalation occurs when the number of locks on rows or tables in the
database equals the maximum number of locks specified in the database
configuration settings.

Meeting the following five criteria helps to avoid the most common performance
bottlenecks.

• The database system's cache hit rates are over 90%.
• The optimizer statistics are not older than 24 hours.
• Lock granularity is row locking.
• There are no lock escalations.
• There are no log write waits. The average disk write queue length to the disk

drives which contain the database log files is smaller than five.

90% or higher cache
hit rates

Offers:
• A relatively low number of physical disk reads and

writes.
• A relatively low number of SQL compiler

executions.

Are important to avoid:
• Disk access being unable to keep up with the level

of I/O that the database server requests.
• Long disk read or disk write queues.
• Unnecessary SQL statement compilations or long

SQL statement compilation times.

Are achieved by:
• Providing sufficient physical memory.
• Configuring sufficient cache sizes.

Up-to-date optimizer
statistics

Offers:
• Good selectivity estimates of predicates in SQL

expressions, especially for expressions including
columns with unequal or skewed distribution of
column values.

Are important to avoid:
• Long response times and low throughput.
• Long execution times for queries.
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• Full table scans.
• Lock escalations.
• Lock waits or deadlocks.
• Significant differences between the estimated

number of rows for each operator in the query plan
from the actual number of rows.

Are achieved by:
• Implementing a procedure to periodically update

the statistics or to update the statistics after frequent
changes to the database.

• Creating statistics for tables, columns, and indexes
that are not stale.

• Setting the sample size (percentage of data that is
analyzed to gather statistical information) to a value
which is sufficient for the skewed data distribution.

• Setting the number of histogram buckets to a value
which is sufficient for the skewed data distribution.

Lock granularity is
row locking

Offers:
• Increased concurrent execution of transactions.
• Reduced transaction processing time due to fewer

lock waits.

Lock granularity is
row locking

Are important to avoid:
• Lock waits or deadlocks.

Are achieved by:
• Setting the lock granularity of your database to row

level.
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No lock escalations

Offers:
• Increased concurrent execution of transactions.

Are important to avoid:
• Lock waits or deadlocks.

Are achieved by:
• Configuring a sufficient size of the lock list.
• Setting the lock escalation threshold to an

appropriate level.
• Keeping the optimizer statistics up to date.

No log write waits

Offers:
• Reduced transaction processing time due to no I/O

waits.

Are important to avoid:
• Lock waits or deadlocks.

Are achieved by:
• Providing an I/O subsystem with sufficient

throughput.
• Providing a Disk Controller Cache and setting the

Disk Controller cache to 100% write cache.

Note: Find more information at http://service.sap.com/sizing.

Using Quick Sizer
Quick Sizer is the online sizing tool of SAP. The tool helps prospects, customers
and hardware vendors to

• Speed up hardware planning phase by asking structured questions relating to
usage of business processes that might affect sizing

• Facilitate tendering procedure by including links to hardware vendors so that
they can make an offer based on the information provided in the tool
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• Provide content for GoingLive check to analyze, if the hardware is sufficient to
smoothly run SAP software

Hint: Keep in mind that Quick Sizer is a tool for initial sizings only. Out of
scope are post go-live sizings such as upgrade or re-sizing (except delta sizing
of a new SAP solution), configuration, landscaping, and customer coding.

Note: For more information on the principles of sizing and the theoretical
background of SAP‟s sizing initiative see the background sizing document at
service.sap.com/sizing -> Sizing Guidelines -> General Sizing

Figure 33: Using Quick Sizer
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Figure 34: Quick Sizer Tool
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Lesson Summary

You should now be able to:
• Define the sizing process
• Size a SAP BusinessObjects BI platform deployment
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Lesson: Designing an Architecture Plan

Lesson Overview
Designing an architecture plan involves gathering requirements from key stakeholders,
analyzing the requirements, and then using the information to perform sizing
calculations to determine the size and configuration of the SAP BusinessObjects
BI platform system. A thorough architecture plan identifies system usage, report
viewing and scheduling requirements, and other system deployment requirements,
such as the level of high availability required, the location of users, and standard
hardware configurations. To gather the information required to design an architecture
plan, you need to perform an analysis of stakeholder requirements. The stakeholders
are groups of individuals impacted by the SAP BusinessObjects BI platform
implementation. Stakeholders may include users who consume reports and
information, business managers who analyze the business value of the software
implementation, and IT individuals who are responsible for managing and supporting
the SAP BusinessObjects BI platform implementation.

Lesson Objectives
After completing this lesson, you will be able to:

• Determine system usage, reporting, document interaction, and general
deployment requirements

• Analyze deployment requirements to determine the size and configuration of a
deployment

• Identify service thresholds

Business Example

Determining Number of Simultaneous Requests
The number of simultaneous requests

The number of simultaneous requests is difficult to estimate. Typically, the number of
simultaneous requests is 10% to 20% of the number of concurrent users (for example,
folders within BI Launch Pad being expanded). To more accurately estimate the
number of simultaneous requests, you can group users by how they use the system,
calculate the percentage of concurrent users by usage type, and then determine the
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simultaneous usage rate. For instance, a simultaneous request to view a report or
document causes the server(s) responsible for rendering pages to fulfill the request
right away. Also, the request causes the server to use resources for a configurable
amount of time (for instance, 20 minutes) in anticipation of future viewing requests.
When it comes to dealing with simultaneous viewing requests, the estimated ratio of
concurrency could be higher than the documented 10 to 20% range (for example, if
there are 100 users and each user is viewing a report). In total there would be 50
reports being viewed (some of the reports are being viewed by more than one user). In
this example, the simultaneous request rate would be 50%.

Determining Reporting Requirements
When determining reporting requirements, you need to consider the number of Crystal
Reports and Web Intelligence documents that will be stored in the system. The
number of Crystal Reports and Web Intelligence documents stored in the system will
influence the number of report/document viewing requirements, and the number of
report/ document scheduling requirements. It is important to point out that you need to
perform separate calculations for viewing and scheduling needs for each document
type that you will be using in the system.

Report viewing requirements

Analyzing the report viewing requirements helps to determine the load on the Crystal
Reports Cache Server, Crystal Reports Processing Server, Web Intelligence Processing
Server, Report Application Server, and Connection Server. When determining
report/document viewing requirements, you need to estimate:

• The number of unique report/document viewing sessions there will be at any
given time.

• The percentage of users who will view reports/documents on demand.
• The percentage of users who will view report /document instances.
• The percentage of report/document viewing requests by geographic location.
• The number of users viewing OLAP reports.

Report scheduling requirements
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Analyzing the report/document scheduling requirements helps to determine the load
on the Web Intelligence Processing Server. When determining report scheduling
requirements, you need to estimate:

• The percentage of users who will schedule reports.
• The total number of reports/documents that will be scheduled by geographic

location.
• The frequency that reports/documents will be scheduled (for example, 100

reports/documents scheduled daily) by geographic location.
• The percentage of reports/documents that will be scheduled after work hours

and during work hours.
• The time window required for reports/documents to run.
• The average time it takes to process the report/document.

Determining System Deployment Requirements
Gathering general system deployment information allows you to consider other factors
that may affect how the system is configured. For instance, you may need to determine:

•
• The level of high availability that is required.
• The standard hardware configurations that you need to follow.
• The geographic location of the users who will access the system.
• The type of network and firewalls used.
• The individuals who will be responsible for managing and maintaining the

system.
• The location of the production database(s).

It is also recommended to talk with key stakeholders to identify the business issues
that require solutions. By understanding the underlying business problem, you are
better able to identify the high-level requirements for the system architecture and
deployment configuration.
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Lesson Summary

You should now be able to:
• Determine system usage, reporting, document interaction, and general

deployment requirements
• Analyze deployment requirements to determine the size and configuration of a

deployment
• Identify service thresholds
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Unit Summary
You should now be able to:
• Define scalability
• List and describe general SAP BusinessObjects BI platform scalability

considerations
• Define the sizing process
• Size a SAP BusinessObjects BI platform deployment
• Determine system usage, reporting, document interaction, and general

deployment requirements
• Analyze deployment requirements to determine the size and configuration of a

deployment
• Identify service thresholds
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Test Your Knowledge

1. What is scalability?

2. What is scalability?

3. List the four main SAP BusinessObjects BI platform scalability goals.

4. List the three estimates necessary when determining system load.
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Answers

1. What is scalability?

Answer: Scalability is the capacity to address additional system load by adding
resources without fundamentally altering the implementation architecture or
implementation design.

2. What is scalability?

Answer: Scalability is the capacity to address additional system load by adding
resources without fundamentally altering the implementation architecture or
implementation design.

3. List the four main SAP BusinessObjects BI platform scalability goals.

Answer: Increase overall system capacity, Increase schedule reporting capacity,
Increase report viewing capacity and Improve web response speeds

4. List the three estimates necessary when determining system load.

Answer:

1. Total number of potential users who will have access to the system
2. Total number of concurrent active users that will access the system
3. Total number of simultaneous requests that will be made
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Unit 5
Deploying a System

Unit Overview
After you have designed a system architecture plan, you then deploy the system in a
test environment to ensure that it is operating as expected.

Unit Objectives
After completing this unit, you will be able to:

• Describe clustering Central Management Servers
• Explain how to secure your deployment
• Understand how web applications are deployed

Unit Contents
Lesson: Clustering Central Management Servers.. . . . . . . . . . . . . . . . . . . . . . . . . . . . .196

Exercise 5: Cluster a SAP BusinessObjects Business Intelligence Platform
Deployment.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .201
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Lesson: Clustering Central Management Servers

Lesson Overview
This lesson explains how to cluster Central Management Servers

Lesson Objectives
After completing this lesson, you will be able to:

• Describe clustering Central Management Servers
• Explain how to secure your deployment
• Understand how web applications are deployed

Business Example
If you have a large or mission-critical implementation of SAP BusinessObjects
Business Intelligence platform, you will probably want to run several CMS machines
together in a cluster. A cluster consists of two or more CMS servers working together
against a common CMS system database. If a machine that is running one CMS fails,
a machine with another CMS will continue to service SAP BusinessObjects Business
Intelligence platform requests. This "high availability" support helps to ensure that
SAP BusinessObjects Business Intelligence platform users can still access information
when there is an equipment failure.

Clustering Central Management Servers
When you add a new CMS to an existing cluster, you instruct the new CMS to connect
to the existing CMS system database and to share the processing workload with any
existing CMS machines. For information about your current CMS, go to the Servers
management area of the CMC.
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Clustering requirements

• For best performance, the database server that you choose to host the system
database must be able to process small queries very quickly. The CMS
communicates frequently with the system database and sends it many small
queries. If the database server is unable to process these requests in a timely
manner, SAP BusinessObjects Business Intelligence platform performance will
be greatly affected.

• For best performance, run each CMS cluster member on a machine that has the
same amount of memory and the same type of CPU.

• Configure each machine similarly:

– Install the same operating system, including the same version of operating
system service packs and patches.

– Install the same version of SAP BusinessObjects Business Intelligence
platform (including patches, if applicable).

– Ensure that each CMS connects to the CMS system database in the same
manner: whether you use native or ODBC drivers. Make sure that the
drivers are the same on each machine, and are a supported version.

– Ensure that each CMS uses the same database client to connect to its
system database, and that it is a supported version.

– Check that each CMS uses the same database user account and password
to connect to the CMS system database. This account must have create,
delete, and update rights on the system database.

– Ensure that the nodes on which each CMS is located are running under
the same operating system account. (On Windows, the default is the
"LocalSystem" account.)

– Verify that the current date and time are set correctly on each CMS machine
(including settings for daylight savings time).

– Ensure that the same WAR files are installed on all web application servers
in the cluster.

• Ensure that each and every CMS in a cluster is on the same Local Area Network.
• If you want to enable auditing, each CMS must be configured to use the same

auditing database and to connect to it in the same manner. The requirements for
the auditing database are the same as those for the system database in terms of
database servers, clients, access methods, drivers, and user IDs.

Hint: By default, a cluster name reflects the specific name of the first CMS
that you install.
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Adding a CMS to a cluster
There are several ways to add a new CMS cluster member. Follow the appropriate
procedure:

• You can install a new node with a CMS on a new machine.
• If you already have a node with CMS binary files, then you can add a new CMS

server from the CMC.
• If you already have a node with CMS binary files, you can also add a new CMS

server by cloning an existing CMS server.

Note: Back up your current CMS system database and the contents of you
Input and Output File Repositories before making any changes.
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General recommendations for securing your deployment
The following are recommended guidelines for securing your BI platform
deployments.

• Use firewalls to protect the communication between the CMS and other system
components. If possible, always hide your CMS behind the firewall. At the very
least, ensure that the system database is safely behind the firewall.

• Add additional encryption to the File Repository Servers. Once the system is up
and running, proprietary content will be stored in these servers. Add additional
encryption through the OS or use a third party tool.

• • Deploy a reverse proxy server in front of the web application servers in order
to hide them behind a single IP address. This configuration routes all Internet
traffic that is addressed to private web application servers through the reverse
proxy server, therefore hiding private IP addresses.

• Strictly enforce corporate password policies. Ensure that user passwords are
routinely changed.

• If you have opted to install the system database and web application server
provided with BI platform, you should access the relevant documentation to
ensure these components are deployed with adequate security configurations.

• The platform includes Apache Tomcat as the default web application server. If
you plan to use this server, please regularly refer to the Apache site for security
updates. In some cases, you may need to manually update your version of
Tomcat to ensure that the latest security fixes are installed.

• Use the Secure Sockets Layer (SSL) protocol for all network communication
between clients and servers in your deployment.

• Ensure that the platform installation directory and subdirectories are secured
- sensitive temporary data may be stored in these directories during system
operation.

• Access to the Central Management Console (CMC) should be restricted to local
access only.

Understanding how web applications are deployed
BI platform web applications are deployed on a web application server. The
applications are deployed automatically during installation through the WDeploy tool.
The tool can also be used to manually deploy the applications after BI platform is
deployed. The web applications are located in the following directory on a default
Windows installation:

C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI
4.0\warfiles\webapps
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WDeploy is used to deploy two specific WAR files:

• BOE: includes the Central Management Console (CMC), BI launch pad, Open
Document,

• dswsbobje: contains the Web Service application

Note: If the web application server is located behind a reverse proxy server,
the reverse proxy server should be configured with the correct context paths
of the WAR files. To expose all of the BI platform functionality, configure a
context path for every BI platform WAR file that is deployed.

Adding or removing additional WACS to your deployment
Adding additional WACS to your deployment can give you a number of advantages:

• Faster recovery from a misconfigured server.
• Improved server availability.
• Better load balancing.
• Better overall performance.

There are three ways to add additional WACS to your deployment:

• Installing WACS on a machine.
• Creating a new WACS.
• Cloning a WACS.

Note: It is recommended that you run a single WACS on the same machine
at the same time due to high resource utilization. However, you can deploy
more than one WACS on the same machine, and only run one of them, to help
you recover in the event of a misconfigured WACS.
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Exercise 5: Cluster a SAP BusinessObjects
Business Intelligence Platform Deployment

Exercise Objectives
After completing this exercise, you will be able to:
• Create new Cluster DSN
• Create the BIP 4.0 Cluster

Business Example
As a system administrator, you need configure a highly available, fault tolerant,
horizontally scaled BIP 4.0 solution. WDFLBMT2268 will be the Database Server
and original Node source for cloning servers onto WDFLBMT2287. Both servers will
serve as a highly available Web farm each housing one instance of Apache Tomcat.

Task 1: Create new Cluster DSN
Create new Cluster DSN on WDFLBMT2287 pointing to WDFLBMT2268 Database
Server

1. Log in to WDFLBMT2287 Windows Server and navigate to Data Sources
ODBC.

Field Value

Server Computer WDFLBMT2287.

User name Boadmin

Password <Assigned password>

2. In the System DSN Tab, add a new DSN using SQL Server Native Client. Call
the DSN BIP_CLUSTER##_DSN. In the Database Server name field, type
WDFLBMT2268.Use SQL Server authentication and provide user credentials.

Task 2: Create the BIP 4.0 Cluster
1. From WDFLBMT2287 CCM, stop all functional SIAs

2. Create a new SIA. Name it U##SIA. Use port 641. Select the Option Add Node
with CMS.

Continued on next page
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3. Start Your Name SIA. Restart Apache Tomcat. You have successfully created
a BIP 4.0 cluster.

Result
As a follow-up and extension to this exercise, you may want to clone the Web
Intelligence Processing tier to your new U##SIA. Start and enable the servers
under this SIA. Then you can create a Web Intelligence Server Group with the
newly cloned Web Intelligence servers and call it Web Intelligence Processing
Server Group. Configure an existing Web Intelligence document to be processed
by this server group for both viewing and scheduling.
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Solution 5: Cluster a SAP BusinessObjects
Business Intelligence Platform Deployment
Task 1: Create new Cluster DSN
Create new Cluster DSN on WDFLBMT2287 pointing to WDFLBMT2268 Database
Server

1. Log in to WDFLBMT2287 Windows Server and navigate to Data Sources
ODBC.

Field Value

Server Computer WDFLBMT2287.

User name Boadmin

Password <Assigned password>

a) Ensure you are log into WDFLBMT2287. If not use remote desktop to
log into this server.

b) Click Start → Programs → Administrative Tools → Data Sources (ODBC).

Continued on next page
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2. In the System DSN Tab, add a new DSN using SQL Server Native Client. Call
the DSN BIP_CLUSTER##_DSN. In the Database Server name field, type
WDFLBMT2268.Use SQL Server authentication and provide user credentials.

a) Click the System DSN tab.

b) Click Add....

c) Select SQL Server Native Client as the driver for which you want to set up
the data source.

d) Click Finish.

e) In the Name field, enter BIP_CLUSTER##_DSN for the data source.

f) In the Description field, enter a brief description for your data source.

g) In the Server selection list, select your hostname for the SQL Server.

h) Click Next.

i) On the authentication screen, enter the login ID and Password and click
Next.

j) Change the default database to BOE4x.

k) Click Next.

l) Click Finish.

Hint: You can test the connectivity by clicking the Test Data
Source button. Ensure the result is successful. Click OK to exit
the window.

Task 2: Create the BIP 4.0 Cluster
1. From WDFLBMT2287 CCM, stop all functional SIAs

a) Click Start → Programs → SAP BusinessObjects Enterprise XI 4.0 → SAP
BusinessObjects Enterprise → Central Configuration Manager.

b) Select all the SIAs and click Stop.

Continued on next page
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2. Create a new SIA. Name it U##SIA. Use port 641. Select the Option Add Node
with CMS.

a) In the Central Configuration Manager (CCM), on the toolbar, click Add
Node.

The Add Node Wizard page appears.

b) Click Next.

c) Enter the Node Name and SIA Port number for the new Server Intelligence
Agent (SIA).

d) Select Add node with CMS..

e) Select the option Use existing running CMS. Click Next.

f) In the New CMS port field, ensure you use port 6400.

g) In the CMS System Database Data Source Name filed, click Specify, select
SQL Server ODBC and click OK.

h) Click the Machine Data Source tab and select the BIP_Cluster##_DSN
you created. Click OK.

i) Specify SQL Server credentials and click OK.

j) Enter cluster key and click Next.

Note: Obtain the cluster key from your instructor.

k) In the CMS Logon screen change the system name to WDFLBMT2268 and
log on as Administrator. Click Finish.

3. Start Your Name SIA. Restart Apache Tomcat. You have successfully created
a BIP 4.0 cluster.

a) Navigate to U##SIA in the CCM and click Start.

b) Navigate to the Apache Tomcat server in the CCM and click Restart.

Result
As a follow-up and extension to this exercise, you may want to clone
the Web Intelligence Processing tier to your new U##SIA. Start and
enable the servers under this SIA. Then you can create a Web Intelligence
Server Group with the newly cloned Web Intelligence servers and call
it Web Intelligence Processing Server Group. Configure an existing
Web Intelligence document to be processed by this server group for both
viewing and scheduling.
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Lesson Summary

You should now be able to:
• Describe clustering Central Management Servers
• Explain how to secure your deployment
• Understand how web applications are deployed

206 © 2012 SAP AG. All rights reserved. 2012



BOE330 Unit Summary

Unit Summary
You should now be able to:
• Describe clustering Central Management Servers
• Explain how to secure your deployment
• Understand how web applications are deployed
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Test Your Knowledge

1. What are the steps that you would perform to cluster two CMS servers?
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Answers

1. What are the steps that you would perform to cluster two CMS servers?

Answer:

• Create a separate SIA on the joining CMS
• Using CMC add CMS service to the newly created SIA
• Using CCM configure CMS to point to the source CMS System Database
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Unit 6
Content Management

Unit Overview
Once you have deployed a SAP BusinessObjects BI platform you need to design and
implement a content management plan.

Unit Objectives
After completing this unit, you will be able to:

• Describe the roles of the upgrade management tool
• Migrate objects using the upgrade management tool
• Explain Lifecycle Management
• Describe the Lifecycle management console
• Manage promotion jobs
• Use Monitoring
• Use Auditing
• Recognize when to use the different types of replication
• Manage replication conflict resolution

Unit Contents
Lesson: Understanding the Upgrade Management Tool .. . . . . . . . . . . . . . . . . . . . .214

Exercise 6: Migrate Objects Using Upgrade Management Tool.. . . . . . . . .217
Lesson: Using Lifecycle Management Console.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .223

Exercise 7: Manage the Promotion of Lifecycle Management Jobs ... . .233
Exercise 8: Compare Objects and Files using Visual Difference ... . . . . .255

Lesson: Using Monitoring and Auditing ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .267
Exercise 9: Monitor Server Performance... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .279

Lesson: Managing the Federation ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .285
Exercise 10: Manage Federation Services ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .297
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Lesson: Understanding the Upgrade Management Tool

Lesson Overview
Lesson Understanding the Upgrade Management Tool

Lesson Objectives
After completing this lesson, you will be able to:

• Describe the roles of the upgrade management tool
• Migrate objects using the upgrade management tool

Business Example

Business Intelligence Archive Resource (BIAR) files
A Business Intelligence Archive Resource (BIAR) file contains compressed business
intelligence content. This content can be easily moved to a different location or SAP
BusinessObjects Business Intelligence platform deployment.

During an incremental upgrade, you can select a BIAR file as the source or destination
if you cannot connect to two Central Management Servers directly (for example, if
your destination and source deployments are on different physical networks).

Note:

• You can use the upgrade management tool to import a BIAR file
generated using the Import Wizard from XI Release 2 or XI 3.x.

• You cannot export a BIAR file generated using the 4.0 upgrade
management tool into another 4.0 deployment. Use the lifecycle
management console to promote content between two 4.0 deployments.

Upgrade paths
You can migrate your system data and business intelligence content to SAP
BusinessObjects Business Intelligence platform 4.0 from XI 3.x, XI Release 2 SP2 (or
higher), or a Business Intelligence Archive Resource (BIAR) file generated from XI
R2 SP2 (or higher, except 4.0). If you have an older deployment, use the following
guidelines to upgrade your existing deployment:
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Caution:

• To upgrade to XI 3.1 from XI R2, XI MHF1, or XI R2 SP1, you must
first upgrade to XI R2 SP2 (or higher).

• To upgrade from BusinessObjects 5 or 6, Crystal Enterprise 9 or 10, or
BusinessObjects Business Intelligence platform, you must first upgrade
to XI 3.x, or XI R2 SP2 (or higher).

Note: The upgrade management tool upgrades only the Server and Web Tier
features in your deployment. To upgrade the client tools, run the Client Tools
installation program. If you have an existing Information platform services
4.0 deployment, you can migrate your data to 4.0, using the same Central
Management Server (CMS) database, or using different databases.

Using the upgrade management tool
The upgrade management tool guides you through the process of exporting business
intelligence content (user accounts, groups, folders, reports, universes, security, and
other objects) and upgrading it to the most recent version.

The upgrade involves the following steps:

• Complete Upgrades

1. Select an upgrade scenario.
2. Specify the source and destination deployments.
3. (Optional) Specify object parameters.
4. Perform the upgrade.

• Incremental Upgrades

1. Select an upgrade scenario.
2. Specify the source and destination deployments.
3. Select objects to upgrade.
4. (Optional) Specify object parameters.
5. Specify object dependencies.
6. Perform the upgrade.

Complete upgrade
The SAP BusinessObjects Business Intelligence platform upgrade management tool
performs a complete upgrade by copying content from one deployment to another.
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Complete upgrades allow you to copy business intelligence content (including
dependencies and permissions) from your old deployment to the new deployment, and
to upgrade it. Any objects that exist in the destination deployment are automatically
overwritten by objects with the same unique identifiers from the source deployment.
Objects from the source deployment with different unique identifiers but the same
name and location as objects on the destination deployment are renamed when they
are upgraded.

This is the simplest and fastest way to upgrade the content of your entire Central
Management Server (CMS) database.

Incremental upgrade
Incremental upgrades allow you to copy individual objects to your new deployment,
and to upgrade them. You can select which objects in the source deployment can be
copied and renamed, if they have different unique identifiers but the same name and
location as objects on the destination deployment.

Selecting and copying specific objects from a Central Management System (CMS)
with an incremental upgrade is the best way to import a limited subset of source
objects into the destination deployment.

Side-by-side deployments
In addition to choosing between a complete upgrade or an incremental upgrade,
you may want to consider performing a side-by-side deployment. A side-by-side
deployment allows you to install the most recent version of SAP BusinessObjects
Business Intelligence platform on a machine with an existing, older deployment. Use
the upgrade management tool to export your business intelligence content from your
existing deployment. You can then make sure that the new deployment is configured
and running smoothly before you uninstall your previous deployment.

Side-by-side deployments can also involve life cycle management: moving resources
from one system to another system without affecting the dependencies of those
resources. The platform uses the Lifecycle management console and the BIAR
command-line tool to manage different versions of BI resources between systems.
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Exercise 6: Migrate Objects Using Upgrade
Management Tool

Exercise Objectives
After completing this exercise, you will be able to:
• Migrate a BIAR file to a Live system
• Perform a incremental migration

Business Example
Using a BIAR file, you can perform migration from a SAP BusinessObjects XI 3.1
repository to a live BIP 4.0 platform.

Task 1: Perform a incremental migration
You will perform a incremental migration from a SAP BusinessObjects XI 3.1
repository to a live BIP 4.0 platform using a BIAR file.

Note: This BIAR file was prepared in a XI 3.1 system and it contains two
folders:

• Marketing Reports folder

– CRMarketing Crystal Reports
– WebiMarketing Crystal Reports

• Sales Reports folder

– CRSales Crystal Reports
– WebiSales Crystal Reports

1. Launch the Upgrade management tool on the server.

Note: This step needs to be performed on the server side where Upgrade
management tool is installed. Remote desktop to the server assigned to
you to perform this exercise.

2. Use the Incremental Upgrade option and use the BIAR to Live option to perform
a migration from a prepared BIAR file to another live system that is assigned to
you. Configure the source and destination system options as follows:

Continued on next page
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Field Value

Source:

BIAR File XI31_ FoldersObjects.biar (found in the D
drive\BOE330 folder on the server)

Destination:

CMS Name: Your assigned system (For example:
wdflbmt2268)

User Name: Administrator

Password: BOTraining4x

3. In the Object Selection screen, expand the Folders and Objects folder and select
the Marketing Reports and Sales Reports sub folders..

4. Ensure that the option: Export all instances of an object if the objects is
selected to have its dependencies exported is selected.

5. In the summary screen, click Upgrade Options and select the following options:

Overwrite object content

Overwrite object security

Result
The migration process begins. Review the General Info tab for warnings and
errors. Click OK when the upgrade is complete.

Task 2: Validate the migration
Log onto the CMC of the assigned system and validate the migration by verifying the
folder structure, reports and universes exist in the repository. As well, verify that you
can view and refresh the migrated content documents and reports.

1. Log on to Central Management Console and navigate to the Auditor folder.
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Solution 6: Migrate Objects Using Upgrade
Management Tool
Task 1: Perform a incremental migration
You will perform a incremental migration from a SAP BusinessObjects XI 3.1
repository to a live BIP 4.0 platform using a BIAR file.

Note: This BIAR file was prepared in a XI 3.1 system and it contains two
folders:

• Marketing Reports folder

– CRMarketing Crystal Reports
– WebiMarketing Crystal Reports

• Sales Reports folder

– CRSales Crystal Reports
– WebiSales Crystal Reports

1. Launch the Upgrade management tool on the server.

Note: This step needs to be performed on the server side where Upgrade
management tool is installed. Remote desktop to the server assigned to
you to perform this exercise.

a) Click Start → Programs → SAP BusinessObjects BI Platform 4.0 → SAP
BusinessObjects BI Platform → Upgrade management tool.

2. Use the Incremental Upgrade option and use the BIAR to Live option to perform
a migration from a prepared BIAR file to another live system that is assigned to
you. Configure the source and destination system options as follows:

Field Value

Source:

BIAR File XI31_ FoldersObjects.biar (found in the D
drive\BOE330 folder on the server)

Destination:

Continued on next page
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Field Value

CMS Name: Your assigned system (For example:
wdflbmt2268)

User Name: Administrator

Password: BOTraining4x

a) Select English in the language selection box, Click Incremental Upgrade
and click Next.

b) In the Upgrade Scenario selection box, select BIAR to Live.

c) Enter the source and destination system information as provided.

d) Click Next.

3. In the Object Selection screen, expand the Folders and Objects folder and select
the Marketing Reports and Sales Reports sub folders..

a) In the left pane under Object type, navigate to Folders and Objects.

b) Select theMarketing Reports folder check box.

c) Select the Sales Reports folder check box.

4. Ensure that the option: Export all instances of an object if the objects is
selected to have its dependencies exported is selected.

a) Click Options.

b) Under the Object Instances, select Export all instances of an object if the
objects is selected to have its dependencies exported.

c) Click OK.

d) Click Next.

Note: You should see there are many dependent objects

5. In the summary screen, click Upgrade Options and select the following options:

Overwrite object content

Continued on next page
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Overwrite object security

a) Navigate to Folders and ensure the Auditor and en folders are checked.

b) Click Upgrade Options.

c) Under the Incremental Export, select Overwrite object content.

d) Under the Incremental Export, select Overwrite object security.

e) Click OK.

f) Click Start.

Result
The migration process begins. Review the General Info tab for warnings
and errors. Click OK when the upgrade is complete.

Task 2: Validate the migration
Log onto the CMC of the assigned system and validate the migration by verifying the
folder structure, reports and universes exist in the repository. As well, verify that you
can view and refresh the migrated content documents and reports.

1. Log on to Central Management Console and navigate to the Auditor folder.

a) Click Start → Programs → SAP BusinessObjects Enterprise XI 4.0 → SAP
BusinessObjects Enterprise → SAP BusinessObjects Enterprise Central
Management Console.

b) Log on with your username and password.

c) In the CMC Home page, click Folders.

d) Navigate to Marketing Reports folder.

e) Right-click the CRMarketing report and click View.

f) Click Refresh.

g) Repeat the same step to view and refreshWebMarketing document.

h) Navigate to Sales Reports folder.

i) Right-click the CRSales report and click View.

j) Click Refresh.

k) Repeat the same step to view and refreshWebSales document.
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Lesson Summary

You should now be able to:
• Describe the roles of the upgrade management tool
• Migrate objects using the upgrade management tool
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Lesson: Using Lifecycle Management Console

Lesson Overview
This lesson explains how to perform lifecycle management in SAP BusinessObjects
BI deployments.

Lesson Objectives
After completing this lesson, you will be able to:

• Explain Lifecycle Management
• Describe the Lifecycle management console
• Manage promotion jobs

Business Example
Many BI deployments contain different stages such as development, testing, and
production. Reports and other BI objects often require modification or enhancement
due to the changing information and business requirements. Administrators must
control how objects are promoted through these stages, whether the objects are
completely new or the objects have the rights to overwrite or update the objects that
already exist in the destination environment.

LifeCycle Management
At SAP, lifecycle management refers to the complete process surrounding an
application, from gathering the initial requirements, to designing the solution, to
building and testing the solution, to deploying the solution, to the ongoing operation
of that solution, and the optimizing of that solution to improve it over time, which
can in turn lead to further requirements that would be then rolled into a subsequent
iteration. So in this usage of the term, “lifecycle management” covers many topics:
installation, deployment, change management, administration, auditing, monitoring,
troubleshooting, to name just a few. The Lifecycle Management Console for
SAP BusinessObjects BI 4.0 is only for BI content lifecycle. BI content lifecycle
management services really are focused on the problem of managing the ongoing
lifecycle for BI content specifically. BI content lifecycle management is a subset of
this larger topic, primarily in Test and Deploy phases. In this lesson you will learn
how to manage BI content lifecycle using LifeCycle Management Console for SAP
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BusinessObjects BI 4.0, which is the tool that allows BI administrators and operations
teams to package BI content and associated dependencies and promote that content in
an efficient, reliable, and repeatable fashion through multiple environments.

Figure 35: SAP Application LifeCycle Management

Figure 36: System Landscape
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What is Lifecycle management console?
The lifecycle management console refers to the set of processes involved in managing
information related to a product life cycle, from the stage of concept through delivery.
It establishes procedures for governing the entire product life cycle, which includes
phases such as development, testing, and production. These phases can occur at the
same site or at different geographical locations.

The BI resources that are present in the development repository must be transferred to
the testing repository for testing deployment. The time required to transfer resources
from one repository to another repository must be minimal, to obtain a high-quality
and competitive product. These resources also have dependencies that have to
be moved from one repository to another. The dependencies of resources adds
complexity to the movement of resources, because these resources have to move
along with the dependents.

Lifecycle management console for SAP BusinessObjects Business Intelligence
platform 4.0 is a web-based tool that enables you to move BI resources from one
system to another system, without affecting the dependencies of these resources. It
also enables you to manage different versions of BI resources, manage dependencies
of BI resources, and roll back a promoted resource to restore the destination system to
its previous state.

Caution: The lifecycle management console tool is a plug-in for the SAP
BusinessObjects Business Intelligence platform application. You can promote
a BI resource from one system to another system only if the same version
of the SAP BusinessObjects Business Intelligence platform application is
installed on both the source and destination systems.
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Figure 37: LifeCycle Management for SAP BusinessObjects BI 4.0 – Standalone
Deployment

Promotion Upgrade/Migration

LifeCycle Management Console (LCM)

Promotion: “Transport content from
like system to like system” Systems
are the same version. E.g. Dev to Test
to Production. Content is primarily
document templates, metadata and
schedules. Not document instances.

Upgrade Manager

Upgrade: “Transport and transform
content from previous version to newer
version” Content includes all objects.

Migrate: “Transport and transform
content from a previous platform to a
new platform or architecture”

Lifecycle management console Features
The lifecycle management console supports the following features: •

• Promotion - This feature enables you to create or update infoobjects in the
destination system. Apart from promoting infoobjects, it enables you to perform
the following tasks:

– Create a new job • Copy an existing job • Edit a job • Schedule a job
promotion • View the history of a job •

• Managing Dependencies - This feature enables you to select, filter, and manage
dependents of infoobjects in the job that you want to promote.

• Scheduling - This feature enables you to specify a time for job promotion, rather
than promote a job as soon as it is created. You can specify the time for job
promotion by using any of the following parameters: hourly, daily, weekly, or
monthly.

• Security - This feature enables you to promote infoobjects along with the
associated security rights. You can also use this feature to promote infoobjects
associated with application rights.

• Test Promotion - This feature enables you to check or test the promotion to
ensure that all the preventive measures are taken before the actual promotion of
the infoobjects. •

• Rollback - This feature enables you to restore the destination system to its
previous state, after a job is promoted. You can roll back an entire job or a part
of the job.
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• Auditing - The events generated by the lifecycle management console are stored
in the audit database. The Auditing feature enables you to monitor the events
that are logged in the audit database.

• Administration options - This feature enables the administrator to configure the
parameters of the lifecycle management console. •

• Version Management - This feature enables you to manage different versions of
the same document. It also enables you to track the changes in the directory.

• Promoting Overrides - This feature enables you to promote the overrides through
a job promotion.

Using the Administration Options
The Administration options enable you to configure settings before promoting
infoobjects from one SAP BusinessObjects Enterprise deployment to another SAP
BusinessObjects Enterprise deployment and SAP deployment. This section describes
how to use the administration options.

The Administration Options link displays the following options:

• Manage Systems - This option enables you to add and remove the host systems.
• Override Settings - This option enables you to override the properties of

infoobjects within the job that were promoted to the destination system. It
overrides the properties of infoobjects that were promoted from the source
system.

• Rollback Settings - This option enables you to configure the rollback process at
the system level.

• Job Settings - This option enables you to specify the number of job instances that
can exist in lifecycle management console system at any instance of time. If the
number of jobs exceed the specified number, they are automatically deleted. It
also enables the user to specify the number of days for a job, after which the job
must be deleted from the lifecycle management console.

• VMS Settings - This option enables you to configure version management
systems.

Creating a New Job
This section describes how to create a new job by using the lifecycle management
console tool. The following table discusses the GUI elements and fields that you can
use to create a new job:
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Item Description

Name Name of the job that you want to create.

Description Description of the job you want to create.

Keywords The keywords for the contents of the job
you want to create

Save Job in You must browse and select a folder to
create a job.

Source System The name of the SAP BusinessObjects
Business Intelligence platform system
from which you want to promote a job.

Destination System The name of the SAP BusinessObjects
Business Intelligence platform system to
which you want to promote a job.

User name The login ID that you must use to log
into the source or destination system.

Password The password that you must use to log
into the source or destination system.

Authentication The authentication type that is used
to connect to the source or destination
system.

Figure 38: Best Practices for Creating Promotion Jobs
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Managing Job Dependencies
In an SAP BusinessObjects Business Intelligence platform environment, infoobjects
are dependent on other infoobjects. For example, a Web Analysis document is
dependent on the underlying Universe for its structure, content, and so on. While
promoting an object, you can select and filter the dependents that you want to promote,
or permit the promotion of all the dependents to another SAP BusinessObjects
Business Intelligence platform system. To select and filter the dependents you want to
promote along with the infoobject, you must use theManage Dependencies option.
If you do not use this option, the dependents are not promoted along with the job.

The following table discusses options that you can use to manage the dependents:

Types of Dependency objects Description

Universe for selected reports Promotes the universe on which the
selected infoobject is dependent.

Selected universes, Universe restriction
set

Promotes universes that are dependent
on other Universe restriction set.

Access levels set on selected objects Promotes access levels that are used on
the selected infoobjects.

Connections used by selected universes Promotes universe connection objects
that are used by the selected infoobjects.

Business Views for selected reports Promotes Business Views, Business
elements, Data foundation, data
connection, and List of Values (LoVs)
that the selected infoobjects depend on.

Events, calendars, profiles used by
selected publication

Promotes event, calendar, and user
profile objects that are used by a selected
publication.
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Figure 39: Promotion Jobs - Dependences

Note:

• Dependent objects are computed automatically by the lifecycle
management console tool. These dependents are computed based either
on the infoobject relationships or infoobject properties.

• If you select a folder for promotion, then the contents in the selected
folder are considered as primary resources.

• In the "Manage Dependencies" screen, when you place the cursor on the
scheduled infoobject, a tool tip appears describing the file name, file
path, created date and time, last modified date and time, next run, expiry,
owner, and recurrence of the schedule.

Scheduling a Job in Lifecycle management console
The lifecycle management console tool enables you to specify when a job must
be promoted, rather than promote it as soon as it is created. It also enables you to
schedule job promotion at fixed intervals. This feature is useful for promoting large
jobs when the load on the server is at its minimum. To schedule a job promotion, you
must specify a time in future or select a recurrence pattern, and specify additional
parameters.

Figure 40: Testing and Running Promotion Jobs

Rolling Back a Job
The Rollback option enables you to restore the destination system to its previous
state, after a job is promoted.
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Figure 41: Roll Back

Managing Different Versions of an Infoobject
The lifecycle management console tool enables you to manage versions of BI
resources that exist in the SAP BusinessObjects Business Intelligence platform
repository. It supports both Subversion and ClearCase version management systems.
This section describes how to use the Version Management feature in the lifecycle
management console tool.

Figure 42: Version Management

2012 © 2012 SAP AG. All rights reserved. 231



Unit 6: Content Management BOE330

232 © 2012 SAP AG. All rights reserved. 2012



BOE330 Lesson: Using Lifecycle Management Console

Exercise 7: Manage the Promotion of
Lifecycle Management Jobs

Exercise Objectives
After completing this exercise, you will be able to:
• Manage the promotion of LifeCycle Management jobs

Business Example
You need to manage the promotion jobs. One system will be configured as the
origin site while another system will be the destination site. You need to manage
the promotion of a Crystal report, Web Intelligence document , their universes, and
universe connections.
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Task 1: Manage Crystal reports
Create a Crystal Report using the xtreme database using Crystal reports 2011. Call
it LCM Crystal Sample

Figure 43: Sample Solution (Partial)

1. Launch Crystal Reports 2011and create a new report. Create a new Connection
via ODBC to the database XtremeSQL2005. Use the following ODBC
connection information:

Server XtremeSQL2005

UserID boadmin

Password BOTraining

Database xtreme

2. Still in Database Expert navigate to the xtreme ODBO connection that you have
just created. and select the tables Customer and Orders.

Continued on next page
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3. Enable visibility for the Field Explorer and place the fields Customer Name
from the Customer table and Order ID and Order Amount from the Orders
table in the Details section of the design area with a small space between the
fields.

4. Insert a Group on the Country field of the Customer table.

5. Use the Select Expert on record level and filter the records displayed in the
report so that only records with an Order Amount value greater than 10000
are displayed.

Task 2: Format the Crystal Report (Optional)
1. Insert a Group Summary for all levels for the field Order Amount

2. Remove decimal places from the Group Summary of Order Amount.

3. Insert a single border above and double border line below the grand total
summary figure.

4. Move the Group Summary results from the Group Footer to the Group Header.

5. Insert a title for the report: Order Amount over $ 10000 per
country. Make the font color Navy and font size 16.

6. Change the font style for the column headings to bold and underlined and
change the font size to 12.

7. Insert a page number in the center of the Page Footer.

8. Insert a pie chart in the Report Header visualizing the sums of the order amounts
per country. Change the Chart Title to Sum of Order Amounts per
country

9. Preview your report and check the results. Afterwards save the report to the My
Documents folder of your local drive with the file name U## Order Amount
per Country.

Task 3: Save the Report
1. Make your report available to other users by Saving it under the same name U##

LCM Crystal Reports in the BI Platform repository. Use the following
credentials to log on to BI Platform:

Continued on next page

2012 © 2012 SAP AG. All rights reserved. 235



Unit 6: Content Management BOE330

Server wdflbmt2268

User administrator

Password Your password

Authentication Enterprise

Task 4: Manage promotion jobs
Configure LCM settings and create \ promote LCM Job

Note: Make sure to use remote desktop and log into the server machine to
perform this task.

1. Log on to the Life Cycle Management console as administrator

Field Value

System wdflbmt2268

User Name administrator

Password <assigned password>

Authentication Enterprise

2. Configure the server wdflbmt2268 to be the Origin.

3. Create a new LCM folder under the Promotion Jobs folder.

4. Highlight the newly created folder and create a new job. Fill out the name field
and ensure you save this job in the folder you created.

5. Ensure that the Source system is WDFLBMT2268 and the destination system is
WDFLBMT2287.

6. In the Add objects from the system window, select the LCM Crystal Report
you created earlier.

7. Promote the LCM job.

Task 5: Log into BI Launch Pad on the destination side
Log into BI Launch Pad on the destination side to verify you can view the report
and refresh it.

1. Launch SAP BusinessObjects BI Launch Pad.

Continued on next page
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2. Log in to BI Launch Pad using the following information:

Field Name Value

System wdflbmt2287:6400

User Name Administrator

Password <Assigned password>

Authentication Enterprise

Task 6: Create a Web Intelligence document
Create a new Web Intelligence document based on the existing eFashion.unx.

1. Launch SAP BusinessObjects Web Intelligence Desktop.

2. Create a query with the dimensions State, Store name and the measure Sales
revenue (in that order) and execute it to view the results.

3. Rename the Report Title to Sales Revenue Report.

4. Edit the document you just created to include a listing for Quantity sold by
Year and Quarter.

5. Create a query filter to show only data for the store e-Fashion Dallas.

6. Create a report filter to show only data for the year 2004.

7. Switch from the Design mode to Reading mode and compare the displayed
toolboxes and toolbars.

Note: In the Reading mode you perform simple viewing tasks, while the
Design mode lets you modify the document that you are viewing.

8. Save your report in the BusinessObjects BI platform folder Public Folders →
BI Training → User Area → User ## with the name U## Sales Revenue
Report

Task 7: Promote Web Intelligence Document
Promote Web Intelligence Document to Destination System

Note: Make sure to use remote desktop and log into the server machine to
perform this task.

1. Log on to the Life Cycle Management console as administrator

Continued on next page
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Field Value

System wdflbmt2268

User Name administrator

Password <assigned password>

Authentication Enterprise

2. Configure the server wdflbmt2268 to be the Origin.

3. Create a new LCM folder under the Promotion Jobs folder.

4. Highlight the newly created folder and create a new job. Fill out the name field
and ensure you save this job in the folder you created.

5. Ensure that the Source system is WDFLBMT2268 and the destination system is
WDFLBMT2287.

6. In the Add objects from the system window, select the LCM Crystal Report
you created earlier.

7. Promote the LCM job.

8. In the Manage Dependencies tab, select both the Universe and Universe
Connection.

9. Complete and verify the promotion job.

Result
The Web Intelligence document has been promoted. To check, you can log on
to BI Launch pad on WDFLBMT2287 system to view and refresh the Web
Intelligence document.

Task 8: Promote the Universe Connection
Promote the Universe Connection override to the Destination System

1. Navigate to the Administration Options.

2. Navigate to the Override settings and to the Connection Overrides tab to see a
list of connections resident in the CMS Repository.

3. Log in and select the origin system WDFLBMT2268. Navigate to the
efashion-webi connection and change the status to Active.

4. Log in and select the destination system WDFLBMT2287. Navigate to the
connection override tab where you will find the promoted connection override
efashion-webi. Change the status to Active.
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Solution 7: Manage the Promotion of
Lifecycle Management Jobs
Task 1: Manage Crystal reports
Create a Crystal Report using the xtreme database using Crystal reports 2011. Call
it LCM Crystal Sample

Figure 44: Sample Solution (Partial)

1. Launch Crystal Reports 2011and create a new report. Create a new Connection
via ODBC to the database XtremeSQL2005. Use the following ODBC
connection information:

Continued on next page
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Server XtremeSQL2005

UserID boadmin

Password BOTraining

Database xtreme

a) Click Start → Programs → Crystal Reports 2011 → Crystal Reports 2011.

b) On the Crystal Reports start page, choose Blank report.

c) In the Database Expert expand Create New Connection and click the [+]
icon next to ODBC (RDO)

d) Enter the connection information stated above and click Finish.

2. Still in Database Expert navigate to the xtreme ODBO connection that you have
just created. and select the tables Customer and Orders.

a) In the Database Expert navigate to ODBC (RDO) → XtremeSQL2005 →
xtreme → dbo.

b) Select Customer and Orders. Transfer to the selected tables section by
clicking the [>] button and choose OK.

c) Do not change the table links that have been created automatically and
choose OK.

3. Enable visibility for the Field Explorer and place the fields Customer Name
from the Customer table and Order ID and Order Amount from the Orders
table in the Details section of the design area with a small space between the
fields.

a) Select the menu path View → Field Explorer.

b) In the Field Explorer, expand Database fields → Customer and drag
Customer Name into the Details section.

c) Expand Database Fields → Orders and drag Order ID and Order
Amount to the Details section of the report. Keep a slight distance between
the fields.

4. Insert a Group on the Country field of the Customer table.

a) Open the Group Expert by selecting Report → Group Expert.

b) Drag the Country field to the Group By: section and choose OK.

Continued on next page
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5. Use the Select Expert on record level and filter the records displayed in the
report so that only records with an Order Amount value greater than 10000
are displayed.

a) Select the menu path Report → Select Expert → Record.

b) Within the Choose Field dialog select the Orders.Order Amount field and
click OK.

c) Choose is greater than as operator and enter 10000 as the value. ClickOK.

d) Choose Refresh Data.

Task 2: Format the Crystal Report (Optional)
1. Insert a Group Summary for all levels for the field Order Amount

a) Right-click the field Order Amount in the detail section and then choose
Insert → Summary from the context menu.

b) Choose Order Amount as the field, Sum as the summary function, and
Grand Total in the summary location.

c) Select the checkbox Add to all group levels and click OK.

2. Remove decimal places from the Group Summary of Order Amount.

a) Switch to Design View by choosing View → Design .

b) Right-click Order Amount summary field in the Group Footer #1 and
Report Footer. Use the Ctrl key to select both fields.

c) Within the formatting tool bar press the icon Decrease Decimals twice.
(This is the last icon on the formatting tool bar.)

3. Insert a single border above and double border line below the grand total
summary figure.

a) Right click the grand total of the field Order Amount in the Report Footer
section and select the Format Field option. Click on the Border tab.

b) Choose Top: Single, Bottom: Double.

c) Click OK.

4. Move the Group Summary results from the Group Footer to the Group Header.

a) Click the Order Amount summary in the Group Footer and drag it to the
Group Header.

Continued on next page
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5. Insert a title for the report: Order Amount over $ 10000 per
country. Make the font color Navy and font size 16.

a) Right click in the Report Header section and select Insert Text Object from
the context menu.

b) Expand the text object to the size that is needed in the Report Header
section.

c) Double-click the text object and enter Order Amount over $ 10000
per country.

d) Select the text, then right-click and select Format Text from the context
menu.

e) Select the Font tab and change the Style to Bold, the Size to 16, and the
Color to Navy.

f) Click OK.

6. Change the font style for the column headings to bold and underlined and
change the font size to 12.

a) Select all headings in the Page Header section. Use the Ctrl key to select
and highlight both fields.

b) Right click on top of one of the headings and select Format Objects from
the context menu.

c) Click the Font tab and select bold from the Style drop down box and select
12 in the Size drop down box. Mark the check box underline.

d) Click OK.

7. Insert a page number in the center of the Page Footer.

a) Within the Field Explorer expand Special Fields.

b) Drag the special field Page Number into the center of the Report Footer.

Continued on next page
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8. Insert a pie chart in the Report Header visualizing the sums of the order amounts
per country. Change the Chart Title to Sum of Order Amounts per
country

a) Select the Insert option in the menu bar and choose Chart.

b) Drag the chart into the Report Header section.

c) Right-click on the chart and select the Chart Expert from the context menu.

d) Click the Type tab and then select Pie from the Choose your chart type list.

e) Click the Text tab and uncheck Auto-Text for the Title field. Enter Sum of
Order Amounts per country and click OK.

9. Preview your report and check the results. Afterwards save the report to the My
Documents folder of your local drive with the file name U## Order Amount
per Country.

a) View the report by choosing View → Preview.

b) Align the field size if required.

c) Save your report. Choose File → Save As ... in the menu. Choose the
folder My Documents and enter the description U## Order Amount
per Country. Press Save.

Task 3: Save the Report
1. Make your report available to other users by Saving it under the same name U##

LCM Crystal Reports in the BI Platform repository. Use the following
credentials to log on to BI Platform:

Server wdflbmt2268

User administrator

Password Your password

Authentication Enterprise

a) Choose File → Save As ... in the menu. Choose Enterprise and log on
with the credentials stated above.

b) Navigate to the folder BI Training → UserArea → User## and enter the
file name U## LCM Crystal Reports. Press Save

c) Click Save.

Continued on next page
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Task 4: Manage promotion jobs
Configure LCM settings and create \ promote LCM Job

Note: Make sure to use remote desktop and log into the server machine to
perform this task.

1. Log on to the Life Cycle Management console as administrator

Field Value

System wdflbmt2268

User Name administrator

Password <assigned password>

Authentication Enterprise

a) Click Start → Programs → SAP BusinessObjects BI platform 4.0 → SAP
BusinessObjects platform → SAP BusinessObjects BI platform Lifecycle
Management Console.

b) Enter the login information stated above and click Log On.

2. Configure the server wdflbmt2268 to be the Origin.

a) Navigate to Administration Options on the top right hand corner

b) Under the Manage Systems tab, observe that both wdflbmt2268 and
wdflbmt2287 are listed.

c) Place a checkmark on WDFLBMT2268 and click on the origin button
above.

Hint: This will make this system the point of origin when
managing connection, Crystal Reports, and QAAWS, and Universe
connection override jobs.

d) Click Close.

3. Create a new LCM folder under the Promotion Jobs folder.

a) Click Folder on the menu bar.

b) In the Enter a new folder name field, enter U##_Promotion_Folder.

Continued on next page
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4. Highlight the newly created folder and create a new job. Fill out the name field
and ensure you save this job in the folder you created.

a) Right-click the newly created folder and select New Job. Fill out the name
field and ensure you save in the folder you created by clicking the browse
folder link.

b) In the Name field, enter U##_Job1.

c) In the Description field, enter Promoting U## Crystal Report.

d) Click Browse beside the Save Job in field. enter U##_Promo-
tion_Folder.

5. Ensure that the Source system is WDFLBMT2268 and the destination system is
WDFLBMT2287.

a) In the Source field, select wdflbmt2268:6400.

b) In the Destination field, select Login to a New CMS.

c) select wdflbmt2287 and enter the login information and click Login.

d) Ensure you have a green chec kmark next to each server indicating
successful communication to the servers.

e) Click Create.

6. In the Add objects from the system window, select the LCM Crystal Report
you created earlier.

a) Navigate to U##_LCM Crystal Report and select the check box beside
the report.

b) Select Add & Close.

7. Promote the LCM job.

a) Select the check box beside the Crystal report.

b) Click Promote in the toolbar area.

c) Click History in the tool bar area to verify successful promotion. Click the
Success blue link to verify job details.

Continued on next page
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Task 5: Log into BI Launch Pad on the destination side
Log into BI Launch Pad on the destination side to verify you can view the report
and refresh it.

1. Launch SAP BusinessObjects BI Launch Pad.

a) Choose Start → Programs → SAP BusinessObjects BI platform 4.0→
SAP BusinessObjects BI platform → SAP BusinessObjects BI platform
Java BI Launch Pad..

2. Log in to BI Launch Pad using the following information:

Field Name Value

System wdflbmt2287:6400

User Name Administrator

Password <Assigned password>

Authentication Enterprise

a) Enter the given information and click Log On.

b) Navigate to find the U##_LCM Crystal Report.

c) View the report.

Task 6: Create a Web Intelligence document
Create a new Web Intelligence document based on the existing eFashion.unx.

1. Launch SAP BusinessObjects Web Intelligence Desktop.

a) Select Start → Programs → SAP BusinessObjects BI platform 4.0 → SAP
BusinessObjects BI platform Client Tools → Interactive Analysis Desktop

Continued on next page
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2. Create a query with the dimensions State, Store name and the measure Sales
revenue (in that order) and execute it to view the results.

a) Select the Universe data source.

b) Enter your user information and click Log On.

Field Name Value

System Assigned system

User name train## (replace ## with your assigned group number)

Password Enter your password

Authentication Enterprise

c) In the Universe window, select the eFashion.unx universe.

d) In the Query Panel, expand the folder Store and drag State into the Result
Objects pane.

e) Expand the folder Store and drag Store name into the Result Objects pane.

f) Expand the folderMeasures and drag Sales revenue into the Result Objects
pane.

g) Click Run Query .

3. Rename the Report Title to Sales Revenue Report.

a) Double-click the title Report 1 tab and enter Sales Revenue Report
in the New value field.

Continued on next page
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4. Edit the document you just created to include a listing for Quantity sold by
Year and Quarter.

a) Open the Data Access tab and click Edit .

b) Expand the folder Time period and drag Year and Quarter into the Result
Objects pane left to State.

c) Expand the folderMeasures and dragQuantity sold into the Result Objects
pane.

d) Click Run Query .

e) Drag the added objects into the report panel. Your report should appear
as shown below:

Figure 45: Sales Revenue Report

Continued on next page
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5. Create a query filter to show only data for the store e-Fashion Dallas.

a) In the Data Access tab, click Edit .

b) Select Store name and drag it into the Query Filters pane

c) Click the arrow on the right of the query filter and select Value(s) from List.

d) Select the store name e-Fashion Dallas and add it to the Selected Value(s)
pane.

e) Click OK.

f) Execute the report by clicking Run Query .

6. Create a report filter to show only data for the year 2004.

a) Click on the year column and navigate to the Analysis tab.

b) Select Filter → Add Filter.

c) Add the year 2004 to the Selected Value(s) and click OK.

7. Switch from the Design mode to Reading mode and compare the displayed
toolboxes and toolbars.

Note: In the Reading mode you perform simple viewing tasks, while the
Design mode lets you modify the document that you are viewing.

a) Click Reading in the main toolbar and compare it with the Design mode.

8. Save your report in the BusinessObjects BI platform folder Public Folders →
BI Training → User Area → User ## with the name U## Sales Revenue
Report

a) Click the arrow next to Save on the toolbar in the File tab and select Publish
to... to display the Publish a document to the server dialog box.

b) Navigate to the folder Public Folders → BI Training → User Area → User
## and enter the name U## Sales Revenue Report.

c) Click Save.

d) Close Interactive Analysis Desktop.

Continued on next page

2012 © 2012 SAP AG. All rights reserved. 249



Unit 6: Content Management BOE330

Task 7: Promote Web Intelligence Document
Promote Web Intelligence Document to Destination System

Note: Make sure to use remote desktop and log into the server machine to
perform this task.

1. Log on to the Life Cycle Management console as administrator

Field Value

System wdflbmt2268

User Name administrator

Password <assigned password>

Authentication Enterprise

a) Click Start → Programs → SAP BusinessObjects BI platform 4.0 → SAP
BusinessObjects platform → SAP BusinessObjects BI platform Lifecycle
Management Console.

b) Enter the login information stated above and click Log On.

c)

2. Configure the server wdflbmt2268 to be the Origin.

a) Navigate to Administration Options on the top right hand corner

b) Under the Manage Systems tab, observe that both wdflbmt2268 and
wdflbmt2287 are listed.

c) Place a check mark on WDFLBMT2268 and click on the origin button
above.

Hint: This will make this system the point of origin when
managing connection, Crystal Reports, and QAAWS, and Universe
connection override jobs.

d) Click Close.

3. Create a new LCM folder under the Promotion Jobs folder.

a) Click Folder on the menu bar.

b) In the Enter a new folder name field, enter U##_Promotion_Folder.

Continued on next page
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4. Highlight the newly created folder and create a new job. Fill out the name field
and ensure you save this job in the folder you created.

a) Right-click the newly created folder and select New Job. Fill out the name
field and ensure you save in the folder you created by clicking the browse
folder link.

b) In the Name field, enter U##_Job1.

c) In the Description field, enter Promoting U##_Web_Intelligence.

d) Click Browse beside the Save Job in field. enter U##_Promo-
tion_Folder.

5. Ensure that the Source system is WDFLBMT2268 and the destination system is
WDFLBMT2287.

a) In the Source field, select wdflbmt2268:6400.

b) In the Destination field, select Login to a New CMS.

c) select wdflbmt2287 and enter the login information and click Login.

d) Ensure you have a green check mark next to each server indicating
successful communication to the servers.

e) Click Create.

6. In the Add objects from the system window, select the LCM Crystal Report
you created earlier.

a) Navigate to U## Sales Revenue Report and select the check box beside
the report.

b) Select Add & Close.

7. Promote the LCM job.

a) Select the check box beside the Crystal report.

b) Click Promote in the toolbar area.

c) Click History in the tool bar area to verify successful promotion. Click the
Success blue link to verify job details.

Continued on next page
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8. In the Manage Dependencies tab, select both the Universe and Universe
Connection.

a) Navigate to the Manage Dependencies tab in the toolbar area. You will
observe the Web Intelligence Document dependencies listed: Universe
and Universe Connection.

b) Select both the Universe and Universe Connection.

c) Click Apply & Close.

9. Complete and verify the promotion job.

a) Click Promote.

b) In the Objects to be promoted window, confirm all the objects that will be
promoted in this job.

c) Click Promote.

d) After a few seconds, click History to ensure the job ran successfully.

Result
The Web Intelligence document has been promoted. To check, you can log
on to BI Launch pad on WDFLBMT2287 system to view and refresh the
Web Intelligence document.

Task 8: Promote the Universe Connection
Promote the Universe Connection override to the Destination System

1. Navigate to the Administration Options.

a) In the Life Cycle Manager Console, click Administration Options.

2. Navigate to the Override settings and to the Connection Overrides tab to see a
list of connections resident in the CMS Repository.

a) Click Override Settings.

b) To ensure all connections have been accounted for, click the Log Off link
under Configure Override Settings at the top.

c) Click Login and log back into WDFLBMT2268 (origin).

d) The Scan drop down option is now activated.

Continued on next page
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3. Log in and select the origin system WDFLBMT2268. Navigate to the
efashion-webi connection and change the status to Active.

a) From the Scan drop down, select Start to begin connection scan on source
system.

b) Find the efashion-webi connection and change the status from Inactive to
Active.

c) Click Save.

d) Select the check box beside the efashion-webi connection you just activated
and click Promote Overrides.

Note: This will promote the connection to the destination system
(WDFLBMT2287)

e) Under the Configure Override Settings area at the top, click Log off.

4. Log in and select the destination system WDFLBMT2287. Navigate to the
connection override tab where you will find the promoted connection override
efashion-webi. Change the status to Active.

a) Click Login and log into WDFLBMT2287. Enter the login information
and click Log On.

b) Navigate to the connection override tab where you will find the promoted
connection override efashion-webi.

c) Change the status to Active.

d) Place a check mark on the connection. Select edit button from the toolbar
area at the top and verify database parameters including credentials.

Hint: Do not make any changes as the WDFLBMT2287 is
configured with the identical database settings as WDFLBMT2268.

e) Click Save.
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Exercise 8: Compare Objects and Files
using Visual Difference

Exercise Objectives
After completing this exercise, you will be able to:
• View the differences two versions of the same LCM BIAR file.
• Provide a comparison status between the source and the destination versions.

Business Example
Visual Difference enables you to view the differences between two versions of the
same file or an object (LCM Biar files or LCM Job Objects). You can use this
feature to determine the difference between files or objects to develop and maintain
different report types. This feature gives a comparison status between the source
and the destination versions. For example, if a previous version of the user report
is accurate and the current version is inaccurate, you can compare and analyze the
file to evaluate the exact issue.

Task 1: Create a Web Intelligence document
Note: If you have not created a Web Intelligence document, follow these
instructions. If you already have an existing Web Intelligence document from
other exercises, you may skip this task and proceed to the next task.

Create a new Web Intelligence document based on the existing eFashion.unx.

1. Launch SAP BusinessObjects Web Intelligence Desktop.

2. Create a query with the dimensions State, Store name and the measure Sales
revenue (in that order) and execute it to view the results.

3. Rename the Report Title to Sales Revenue Report.

4. Edit the document you just created to include a listing for Quantity sold by
Year and Quarter.

5. Create a query filter to show only data for the store e-Fashion Dallas.

6. Create a report filter to show only data for the year 2004.

Continued on next page
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7. Switch from the Design mode to Reading mode and compare the displayed
toolboxes and toolbars.

Note: In the Reading mode you perform simple viewing tasks, while the
Design mode lets you modify the document that you are viewing.

8. Save your report in the BusinessObjects BI platform folder Public Folders →
BI Training → User Area → User ## with the name U## Sales Revenue
Report

Result
You have created a Web Intelligence document and this document will be
exported into a BIAR file later.

Task 2: Create a LCM Job
Create a LCM Job that will export WEBI LCM document (U## Sales Revenue
Report) to a LCMBIAR file and save it to the Desktop location of the server.

1. Log in to the LCM Console.

Field Value

System wdflbmt2268

User Name administrator

Password <assigned password>

Authentication Enterprise

2. Create a new LCM Job called U##_Webi LCMBIAR Job.

3. Configure the Source system to be WDFLBMT2268 and the Destination will
be a LCMBIAR file.

4. Add the U## Sales Revenue Report document to the Job. Ensure all dependencies
are selected in the Manage dependencies button.

5. Promote the job and save the file to the desktop as U##_LCMBIAR WEBI.biar.

6. Create a folder in the desktop of WDFLBMT2268 called LCM and share it
(this will require basic Microsoft File management knowledge) . Ensure the
everyone group has co-owner rights to the LCM folder. Copy the LCMBIAR
WEBI file to the LCM folder.

Continued on next page

256 © 2012 SAP AG. All rights reserved. 2012



BOE330 Lesson: Using Lifecycle Management Console

7. Log off WDFLBMT2268 and log on to WDFLBMT2287 using Remote Desktop
Connection in Windows.

8. Go to the windows start menu on WDFLBMT2287 and type \\WDFLBMT2268.
Copy the LCMBIAR file from WDFLBMT2268 to WDFLBMT2287.

9. Import the contents of LCMBIAR to WDFLBMT2287 repository, log on to the
LCM console on WDFLBMT2287. Browse to the desktop and select LCMBIAR
WEBI.biar file you copied to the DESKTOP (from WDFLBMT2268 share).

Task 3: Compare LCMBIAR Webi Job
You can only compare LCMBIAR files or LCM Jobs with Visual Difference. In this
task, you will compare LCMBIAR Webi Job on WDFLBMT2268 and LCMBIAR
Webi Job on WDFLBMT2287.

1. Log into the CMC application.

2. The compared files are stored in the "Differences" folder, or in any of the user
created sub-folder.

Note: To create a new sub-folder, click the Folder icon.

3. Create a new Comparison using the LCMBIAR WEBI JOB BIARFILE in the
Reference system WDFLBMT2268..

4. Enter the target system, select the object to be compared and add this comparison.

5. Click the Compare button to compare the objects or folders.

6. Save the difference report.
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Solution 8: Compare Objects and Files
using Visual Difference
Task 1: Create a Web Intelligence document

Note: If you have not created a Web Intelligence document, follow these
instructions. If you already have an existing Web Intelligence document from
other exercises, you may skip this task and proceed to the next task.

Create a new Web Intelligence document based on the existing eFashion.unx.

1. Launch SAP BusinessObjects Web Intelligence Desktop.

a) Select Start → Programs → SAP BusinessObjects BI platform 4.0 → SAP
BusinessObjects BI platform Client Tools → Interactive Analysis Desktop

2. Create a query with the dimensions State, Store name and the measure Sales
revenue (in that order) and execute it to view the results.

a) Select the Universe data source.

b) Enter your user information and click Log On.

Field Name Value

System Assigned system

User name train## (replace ## with your assigned group number)

Password Enter your password

Authentication Enterprise

c) In the Universe window, select the eFashion.unx universe.

d) In the Query Panel, expand the folder Store and drag State into the Result
Objects pane.

e) Expand the folder Store and drag Store name into the Result Objects pane.

f) Expand the folderMeasures and drag Sales revenue into the Result Objects
pane.

g) Click Run Query .

Continued on next page
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3. Rename the Report Title to Sales Revenue Report.

a) Right-click the title Report 1 tab. Select Rename and enter Sales
Revenue Report in the New value field.

4. Edit the document you just created to include a listing for Quantity sold by
Year and Quarter.

a) Open the Data Access tab and click Edit .

b) Expand the folder Time period and drag Year and Quarter into the Result
Objects pane left to State.

c) Expand the folderMeasures and dragQuantity sold into the Result Objects
pane.

d) Click Run Query .

e) Drag the added objects into the report panel. Your report should appear
as shown below:

Figure 46: Sales Revenue Report

Continued on next page
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5. Create a query filter to show only data for the store e-Fashion Dallas.

a) In the Data Access tab, click Edit .

b) Select Store name and drag it into the Query Filters pane

c) Click the arrow on the right of the query filter and select Value(s) from List.

d) Select the store name e-Fashion Dallas and add it to the Selected Value(s)
pane.

e) Click OK.

f) Execute the report by clicking Run Query .

6. Create a report filter to show only data for the year 2004.

a) Click on the year column and navigate to the Analysis tab.

b) Select Filter → Add Filter.

c) Add the year 2004 to the Selected Value(s) and click OK.

7. Switch from the Design mode to Reading mode and compare the displayed
toolboxes and toolbars.

Note: In the Reading mode you perform simple viewing tasks, while the
Design mode lets you modify the document that you are viewing.

a) Click Reading in the main toolbar and compare it with the Design mode.

8. Save your report in the BusinessObjects BI platform folder Public Folders →
BI Training → User Area → User ## with the name U## Sales Revenue
Report

a) Click the arrow next to Save on the toolbar in the File tab and select Publish
to... to display the Publish a document to the server dialog box.

b) Navigate to the folder Public Folders → BI Training → User Area → User
## and enter the name U## Sales Revenue Report.

c) Click Save.

d) Close Interactive Analysis Desktop.

Result
You have created a Web Intelligence document and this document will
be exported into a BIAR file later.

Continued on next page
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Task 2: Create a LCM Job
Create a LCM Job that will export WEBI LCM document (U## Sales Revenue
Report) to a LCMBIAR file and save it to the Desktop location of the server.

1. Log in to the LCM Console.

Field Value

System wdflbmt2268

User Name administrator

Password <assigned password>

Authentication Enterprise

a) Click Start → Programs → SAP BusinessObjects BI platform 4.0 → SAP
BusinessObjects platform → SAP BusinessObjects BI platform Lifecycle
Management Console.

b) Enter the login information stated above and click Log On.

2. Create a new LCM Job called U##_Webi LCMBIAR Job.

a) Click New Job.

b) In the Name field, enter U##_Compare_Job.

c) In the Description field, enter Comparing objects..

d) Click Browse beside the Save Job in field. enter U##_Promo-
tion_Folder.

3. Configure the Source system to be WDFLBMT2268 and the Destination will
be a LCMBIAR file.

a) In the Source field, select wdflbmt2268:6400.

b) In the Destination field, select Output to LCMBIAR File.

c) Click Create.

4. Add the U## Sales Revenue Report document to the Job. Ensure all dependencies
are selected in the Manage dependencies button.

a) Navigate to U## Sales Revenue Report and select the check box beside
the report.

b) Select Add & Close.

Continued on next page
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5. Promote the job and save the file to the desktop as U##_LCMBIAR WEBI.biar.

a) Select the check box beside the Web Intelligence document.

b) Click Promote in the toolbar area.

c) Click Export.

d) From the File Download window, click Save to save the BIAR to the
desktop of the server.

6. Create a folder in the desktop of WDFLBMT2268 called LCM and share it
(this will require basic Microsoft File management knowledge) . Ensure the
everyone group has co-owner rights to the LCM folder. Copy the LCMBIAR
WEBI file to the LCM folder.

a) Navigate to the desktop of the server machine WDFLBMT2268.

b) Right-click the desktop area and select New → Folder.

c) Name the folder U## LCM Share.

d) Copy the LCMBIAR file to this folder.

e) Right-click the folder and click Share.

f) In the Choose people to share with field, select Everyone (All users in
this list) and click Add.

g) Click Share.

h) Write down the path to your folder and click Done.

7. Log off WDFLBMT2268 and log on to WDFLBMT2287 using Remote Desktop
Connection in Windows.

a) Click Start → Log Off boadmin...

b) Click Start → Remote Desktop Connection. and enter wdflbmt2287.

c) Log into wdflbmt2287 using provided login information.

Continued on next page
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8. Go to the windows start menu on WDFLBMT2287 and type \\WDFLBMT2268.
Copy the LCMBIAR file from WDFLBMT2268 to WDFLBMT2287.

a) In the window explorer, type the folder link you created earlier.

Hint: For example: \\WDFLBMT2268\users\boadmin\desk-
top\U## LCM Share

b) Press Enter. The shared resources on WDFLBMT2268 will appear.

c) Navigate to the directory and copy the LCMBIAR file to WDFLBMT2287
desktop.

9. Import the contents of LCMBIAR to WDFLBMT2287 repository, log on to the
LCM console on WDFLBMT2287. Browse to the desktop and select LCMBIAR
WEBI.biar file you copied to the DESKTOP (from WDFLBMT2268 share).

a) Click Start → Programs → SAP BusinessObjects BI platform 4.0 → SAP
BusinessObjects platform → SAP BusinessObjects BI platform Lifecycle
Management Console.

b) Click Import → Import LCMBIAR.

c) Click Browse to select LCMbiar file from the file system.

d) Browse to the desktop and select U##_LCMBIAR WEBI.biar file you
copied.

e) Click OK.

f) In the next screen, ensure that the destination is set to WDFLBMT2287.
Ensure you save the job under Promotion Jobs Folder. Click Create. You
have successfully promoted a Webi document using the LCMBIAR option.

Note: You cannot change the Job name

Continued on next page
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Task 3: Compare LCMBIAR Webi Job
You can only compare LCMBIAR files or LCM Jobs with Visual Difference. In this
task, you will compare LCMBIAR Webi Job on WDFLBMT2268 and LCMBIAR
Webi Job on WDFLBMT2287.

1. Log into the CMC application.

a) Click Start → Programs → SAP BusinessObjects BI platform 4.0 → SAP
BusinessObjects platform → SAP BusinessObjects BI platform Central
Management Console.

b) Enter the login information and click Log On.

2. The compared files are stored in the "Differences" folder, or in any of the user
created sub-folder.

Note: To create a new sub-folder, click the Folder icon.

a) In the CMC homepage, under the "Manage" tab, click the Visual Difference
link.

The Visual Difference page appears.

3. Create a new Comparison using the LCMBIAR WEBI JOB BIARFILE in the
Reference system WDFLBMT2268..

a) Click New Comparison.

The "Visual Difference - Comparisons" screen appears.

b) Click Browse to select LCMBIAR WEBI JOB

Continued on next page
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4. Enter the target system, select the object to be compared and add this comparison.

a) Select the target system from the Select System drop-down under Target.
WDFLBMT2287

Note: If you login to CMS, the selected object in the reference
system can also be automatically matched with an object having
the same name in the reference system

b) Click the Browse button to select LCMBIAR WEBI job on
WDFLBMT2287

c) Click Add.

Note: The objects are added to the comparison. If there are more
than one pair of objects added, the objects must be scheduled for
comparison at a later point of time. However, if the comparison
object contains just one pair of objects, you can compare these
objects.

5. Click the Compare button to compare the objects or folders.

a) Click Compare.

Note: The comparison of LCMBIAR/LCM Job file includes: If
the objects other than LCMBIAR or LCM job are selected, the
following error message is displayed: Plugin not found.

The comparison process starts immediately and the differences
if any are displayed in the "Visual Difference viewer". The
differences are highlighted in orange color, and the missing objects
are highlighted in red color.

You can also use the filter option to view the compared objects by
type, and with differences or with common attributes.

6. Save the difference report.

a) Click Save to save the difference report.
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Lesson Summary

You should now be able to:
• Explain Lifecycle Management
• Describe the Lifecycle management console
• Manage promotion jobs
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Lesson: Using Monitoring and Auditing

Lesson Overview
Auditing provides you with a detailed historical view of user and object interaction
and system usage. Auditing allows you to fine-tune system performance, retire unused
reports, and provide business units with a comprehensive snapshot of their usage
patterns.

Lesson Objectives
After completing this lesson, you will be able to:

• Use Monitoring
• Use Auditing

Business Example

Monitoring
Monitoring is a new application in SAP BusinessObjects Business Intelligence
platform 4.0. This application provides the ability to capture the runtime and historical
metrics of SAP BusinessObjects Business Intelligence platform 4.0 servers, for
reporting and notification. The monitoring application helps system administrators
to identify if an application is functioning normally and if the response times
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are as expected. By providing key business metrics, the monitoring application
provides better insight into SAP BusinessObjects Business Intelligence platform
4.0 . Monitoring allows you to:

• Check the performance of each server: This is possible with the help of watches,
which show the state of each server as traffic lights. The system administrator
can set thresholds for these watches and receive alerts when these thresholds
are breached. This helps in taking proactive action if there is an impending
failure or outage.

• View critical system Key Performance Indicators (KPIs): This helps in activity
and resource monitoring. These KPIs are displayed on the dashboard page of the
monitoring application.

• Check system availability and response time: Using probes, you can simulate
workflows to check if the servers and services in the platform deployment are
functioning as expected. By analyzing the roundtrip time of these probes at
periodic intervals, the system administrator can assess the system usage pattern.

• Analyze peak load and peak period for the CMS: This helps the system
administrator determine if more licenses or system resources are required.

• Integrate with other enterprise applications: The SAP BusinessObjects Business
Intelligence platform 4.0 monitoring application can be integrated with other
enterprise applications like SAP Solution Manager and IBM Tivoli Monitoring.

Dashboard
The Dashboard page provides a centralized view for the system administrator
to monitor the performance of all servers. It provides real-time information on
the system KPIs, recent alerts, watches, and corresponding graphs based on the
watch state.

Watch
Watches provide real-time status and historical trends of servers and workflows
within the SAP BusinessObjects Business Intelligence platform environment.
Users can associate thresholds and alerts to a watch. You can create a watch
using data from probes, servers, SAPOSCOL or Derived Metrics.

Derived Metrics
Derived metric gives you the flexibility to create metrics based on the user's
requirements, and then create a watch using this metric. You can create a derived
metric by combining two or more existing metrics in a mathematical equation.

268 © 2012 SAP AG. All rights reserved. 2012



BOE330 Lesson: Using Monitoring and Auditing

KPI
KPIs (key performance indicators) are standard metrics in the SAP
BusinessObjects Business Intelligence platform deployment. They provide
information about the schedules and log on sessions. For example, a higher
number of RunningJobs indicates good performance of the servers. Alternatively,
a higher number of PendingJobs indicates poor performance and high system
load.

Probes
Probes monitor different services and simulates the different functionalities
of SAP BusinessObjects Business Intelligence platform components. By
scheduling probes to run at specified intervals, the system administrator can
track the availability and performance of key services provided by SAP
BusinessObjects Business Intelligence platform 4.0. This data can also be used
for capacity planning.

Traffic lights
Traffic lights represent the watch state at any given time. The colors Green,
Amber, and Red are used to indicate the state of a watch. Users can choose
to set two or three states to a watch.

Trending graph
A trending graph is a graphical representation of historical metric data generated
by probes and servers. It helps the system administrator monitor the system at
different time intervals, and assess the system usage pattern.

Alert
An alert is a notification generated by the monitoring application, when a
user-defined threshold value set for different metrics applied to a watch is
breached. You can choose to receive alerts either through email or view on
the "Dashboard" page.

Auditing
Auditing allows you to keep a record of significant events on servers and applications,
which helps give you a picture of what information is being accessed, how it's being
accessed and changed, and who is performing these operations. This information is
recorded in a database called the Auditing Data Store (ADS). Once the data is in the
ADS, you can design custom reports to suit your needs. You can look for sample
universes and reports on the SAP Developer Network. For the purposes of this
chapter, an auditor is a system responsible for recording or storing information on an
event, and an auditee is any system responsible for performing an auditable event.
There are some circumstances where a single system can perform both functions.
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How Auditing works
The Central Management Server (CMS) acts as the system auditor, while each server
or application that triggers an auditable event acts as an auditee. When an audited
event is triggered, the auditee will generate a record and store it in a local temporary
file. At regular intervals, the CMS communicates with the auditees to request these
records and writes the data to the ADS. The CMS also controls the synchronization of
auditing events that occur on different machines. Each auditee provides a timestamp
for the auditing events that it records. To ensure that the timestamps of events on
different servers are consistent, the CMS periodically broadcasts its system time to the
auditees. The auditees then compare this time to their internal clocks. If differences
exist, they correct the time recorded for subsequent auditing events. Depending on the
type of auditee, the system uses one of the following workflows to record the events.

270 © 2012 SAP AG. All rights reserved. 2012



BOE330 Lesson: Using Monitoring and Auditing

1. Server auditing

Figure 47: Server auditing

1. An auditable event is performed by the server.

Note: A port should be opened in the firewall between the client and
CMS.

2. The auditee writes events in a temporary file.
3. The auditor polls the auditee and requests a batch of auditing events.
4. The auditee retrieves the events from the temporary files.
5. The auditee transmits the events to the auditor.
6. The auditor writes events to the ADS and signals the auditee to delete the events

from the temporary files.

2. Client logon auditing for clients connecting through CORBA
This includes applications such as Web Intelligence.
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Figure 48: Client logon auditing for clients connecting through CORBA

1. The client connects to the CMS, which will act as the auditee. The client
provides its IP address and machine name, which the auditee then verifies.

2. The auditee writes events in a temporary file.
3. The auditor polls the auditee and requests a batch of auditing events.
4. The auditee retrieves the events from the temporary files.
5. The auditee transmits the events to the auditor.
6. The auditor writes events to the ADS and signals the auditee to delete the events

from the temporary files.

3. Client logon auditing for clients connecting through HTTP
This includes online applications such as BI launch pad, Central Management
Console, and Web Intelligence.
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Figure 49: Client logon auditing for clients connecting through HTTP

1. The browser connects to the web application server, and logon data is submitted
to the web application server.

2. SAP BusinessObjects BI platform SDK submits the logon request to the auditee
(CMS), along with the IP address and name of the browser machine.

3. The auditee writes events in a temporary file.
4. The auditor polls the auditee and requests a batch of auditing events.
5. The auditee retrieves the events from the temporary files.
6. The auditee sends events to the auditor.
7. The auditor writes events to the ADS and signals the auditee to delete the events

from the temporary files.

4. Non-Logon auditing for clients connecting through CORBA
This workflow applies to auditing Web Intelligence events when connecting through
CORBA.
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Figure 50: Non-Logon auditing for clients connecting through CORBA

1. The user performs an operation that may be audited.
2. The client contacts the CMS to check if the operation is configured to be audited.
3. If the action is set to be audited, the CMS communicates this information to

the client.
4. The client sends the event information to the Client Auditing Proxy Service

(CAPS), hosted in an Adaptive Processing Server.
5. The CAPS writes events in a temporary file.
6. The Auditor polls the CAPS and requests a batch of auditing events.
7. The CAPS retrieves the events from the temporary files.
8. The CAPS sends the event information to the auditor.
9. The auditor writes events to the ADS and signals the CAPS to delete the events

from the temporary files.

5. Non-login auditing for clients connecting through HTTP
This workflow applies to auditing Web Intelligence events (except for logon events)
when connecting through HTTP.
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Figure 51: Non-login auditing for clients connecting through HTTP

1. The user initiates a potentially auditable event. The client application contacts
the web application server.

2. The web application checks to see if the event is configured to be audited.
3. The CMS returns the audit configuration information to the web application

server, which passes this information back to the client application.
4. If the event is configured to be audited, the client sends the event information to

the web application server, which passes it to the Client Auditing Proxy Service
(CAPS), hosted in an Adaptive Processing Server (APS).

5. The CAPS writes events in a temporary file.
6. The auditor polls the CAPS and requests a batch of auditing events.
7. The CAPS retrieves the events from the temporary files.
8. The CAPS sends the event information to the auditor.
9. The auditor writes events to the ADS and signals the CAPS to delete the events

from the temporary files.
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Clients that support auditing
The following client applications support auditing:

• Central Management Console (CMC)
• BI launch pad
• Open Document
• Analysis
• Live Office Web Services Provider
• Web Intelligence Rich Client

Note: At least one instance of CAPS must be running in order to collect
auditing events from the clients listed above. Clients not listed above do not
directly generate events, but some actions performed by the servers as a result
of client application operations can be audited.

CMC Auditing page
The Auditing page in the CMC has the following areas:

• Auditing Status Summary
• Set Events
• Set Event Details
• Configuration

The Auditing Status shows a set of metrics that help you optimize your auditing
configuration and alert you to any issues that might affect the integrity of your auditing
data. The following table explains the metrics for auditing.

Metric Details

ADS Last Updated
on

The date and time the auditor CMS last started polling the
auditees for their auditing events.

Auditing Thread
Utilization

The percentage of the polling cycle the auditor CMS spends
collecting data from auditees, the remainder is time spent
resting between polls.
If this reaches 100% the figure will be displayed in yellow,
and means the auditor is still collecting data from the auditees
when the next poll is due to begin. This may cause delays in
the events reaching the ADS.
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Metric Details
If this is happening frequently or persistently, it is recommend
you either update your deployment to allow the ADS database
to receive data at a higher rate (faster network connections or
more powerful database hardware for example), or decrease
the number of auditing events your system tracks.

Last Polling Cycle
Duration

Duration of the last polling cycle in seconds. This indicates
the maximum delay for event data to reach the ADS during
the previous polling cycle.

• If under 20 minutes (1200 seconds), the figure will
appear on a green background.

• If between 20 minutes and 2 hours (7200 seconds), it
will appear on a yellow background.

• If over 2 hours, it will appear on a red background.
If this state persists and you consider the delay too long, it
is recommend you either update your deployment to allow
the ADS database to receive data at a higher rate (faster
network connections or more powerful database hardware for
example), or decrease the number of auditing events your
system tracks.

CMS Auditor The name of the CMS currently acting as auditor.

ADS Database
Connection Name

The name of the database connection currently used by the
auditor CMS to connect to the Auditing Data Store (ADS). For
SQL servers this will be the name of the ODBC connection.
For other database types it will be the database name, followed
by the server name and connection port.

ADS Database
User Name

The user name the auditor CMS is using to log in to the ADS
database.
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Exercise 9: Monitor Server Performance

Exercise Objectives
After completing this exercise, you will be able to:
• Create a Watch
• Schedule a Probe

Business Example
You will create a watch list that monitors Web Intelligence Processing server Processor
utilization. Then you will schedule a probe that will give you insight as to the time it
takes for the CMS to connect to the System Database

Task 1: Create a Watch
Create a Watch that will monitor Web Intelligence Processor utilization over 70%

Hint: If the processor utilization on any of the servers exceeds 70%, it is an
indication that you may need to install and configure another Web Intelligence
Processing server to improve performance.

1. In the CMC, navigate to the Monitoring application.

2. Navigate to the Watchlist tab and select new button to create a new watch.

3. Name your watch- Web Intelligence Processor Utilization

4. Define caution rule for CPU usage to be greater than 50.

5. Define Danger rule for CPU usage to be greater than 70.

6. Change watch state every time Caution or Danger rule evaluate to true. Enable
Alerting to the Administrator account.

Result
Now you can schedule a Web Intelligence Document and observe the processor
utilization on the Dashboard tab.

Continued on next page
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Task 2: Schedule a Probe
Schedule a Probe to verify the amount of time it takes for a user to log in or log out.

1. In the CMC, navigate to the Monitoring dashboard and then the Probes tab.

2. Locate the CMS Logon Logoff built in probe and schedule it.

3. Set the recurrence option to NOW and click schedule. Wait for the schedule to
process and observe the status.

Result
Once complete, in the Run Result field, click the link provided to observe the
amount of time that transpired in the workflow.
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Solution 9: Monitor Server Performance
Task 1: Create a Watch
Create a Watch that will monitor Web Intelligence Processor utilization over 70%

Hint: If the processor utilization on any of the servers exceeds 70%, it is an
indication that you may need to install and configure another Web Intelligence
Processing server to improve performance.

1. In the CMC, navigate to the Monitoring application.

a) Click Start → Programs → SAP BusinessObjects BI platform 4.0 → SAP
BusinessObjects BI platform → SAP BusinessObjects BI platform Central
Management Console

b) In the CMC Home area, click Monitoring.

2. Navigate to the Watchlist tab and select new button to create a new watch.

a) Click the Watchlist tab.

b) Click New

3. Name your watch- Web Intelligence Processor Utilization

a) In the Name field, enter Web Intelligence Processor Utilization.

b) In the Description field, Web Intelligence Processor Utilizations >70%

c) Select Three (OK, Caution, Danger).

d) Select both Settings – Show on Dashboard andWrite to Trending Database.

e) Click Next.

4. Define caution rule for CPU usage to be greater than 50.

a) Expand the Servers option under Available Metrics and expand the Web
Intelligence Processing Server.

b) Select CPU usage % and click > to move it to the Added Metrics window.

c) Set the threshold to >50.

d) Click Next.

Continued on next page
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5. Define Danger rule for CPU usage to be greater than 70.

a) Expand the Servers option under Available Metrics and expand the Web
Intelligence Processing Server.

b) Select CPU usage % and click > to move it to the Added Metrics window.

c) Set the threshold to >70.

d) Click Next.

6. Change watch state every time Caution or Danger rule evaluate to true. Enable
Alerting to the Administrator account.

a) Select the radio button for Change watch state every time Caution or
Danger Rules evaluates to true.

b) Select the Enable alert notifications check box. Use Administrator for
list of users to be notified.

c) Click Save.

Result
Now you can schedule a Web Intelligence Document and observe the
processor utilization on the Dashboard tab.

Task 2: Schedule a Probe
Schedule a Probe to verify the amount of time it takes for a user to log in or log out.

1. In the CMC, navigate to the Monitoring dashboard and then the Probes tab.

a) In the CMC Home area, click Monitoring.

b) Click the Probes tab.

2. Locate the CMS Logon Logoff built in probe and schedule it.

a) Select CMS Logon Logoff.

b) Click Schedule.

Continued on next page
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3. Set the recurrence option to NOW and click schedule. Wait for the schedule to
process and observe the status.

a) Click the Recurrence tab.

b) In the Run object selection list, select NOW.

c) Click Schedule.

Result
Once complete, in the Run Result field, click the link provided to observe
the amount of time that transpired in the workflow.
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Lesson Summary

You should now be able to:
• Use Monitoring
• Use Auditing
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Lesson: Managing the Federation

Lesson Overview
Federation is a cross-site replication tool for working with multiple SAP
BusinessObjects Business Intelligence platform deployments in a global environment.

Lesson Objectives
After completing this lesson, you will be able to:

• Recognize when to use the different types of replication
• Manage replication conflict resolution

Business Example
Federation allows you to have separate security models, life cycles, testing, and
deployment times, as well as different business owners and administrators. For
example, you can delegate administration features that restrict the sales application
administrator from changing a human resources application.

Federation
Federation is a cross-site replication tool for working with multiple SAP
BusinessObjects Business Intelligence platform deployments in a global environment.
Content can be created and managed from one BI platform deployment and replicated
to other BI platform deployments across geographical sites on a recurring schedule.
You can complete both one-way replication and two-way replication jobs.

The benefits of Federation include the ability to:

• Reduce network traffic
• Create and manage content from a single site
• Increase performance for end users
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When you replicate content using Federation, you can:

• Simplify administration needs for multiple deployments
• Provide a consistent rights policy across multiple offices for global organizations
• Obtain information faster and process reports at remote sites where data resides
• Save time by retrieving local and dispersed data faster
• Synchronize content from multiple deployments without writing custom code

Federation allows you to have separate security models, life cycles, testing, and
deployment times, as well as different business owners and administrators. For
example, you can delegate administration features that restrict the sales application
administrator from changing a human resources application. You can replicate a
variety of objects with Federation, as described in the following table.

Category Object types you can
replicate

Additional notes

Business Views Business View Manager,
DataConnection, LOVs,
Data Foundation, etc.

All objects are supported,
although not at the
individual level.

Reports Crystal reports, Web
Intelligence, and
Dashboard Design.

Full client add-in and
templates are supported.

Third-Party Objects Excel, PDF, PowerPoint,
Flash, Word, text, rich
text, and Shockwave
Flash files

Users users, groups, Inboxes,
Favorites, and Personal
Category

Business Intelligence
Platform

Folders, Events,
Categories, Calendars,
Access Levels,
Hyperlinks, Shortcuts,
Programs, Profiles, Object
Packages, Agnostic

Universe Universe, Connections,
and UniverseOverload

Scenario 1: Retail (centralized design
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) ACME store wants to send a monthly sales report to the different store locations
using the one-way replication method. The administrator at the origin site creates a
report that administrators at each destination site replicate and run against that store's
database.

Hint: Localized instances can be sent back to the origin site that maintain
each object's replicated info. For example, it will apply the appropriate logo,
database connection information, and so on.

Scenario 2: Remote Schedule (distributed access)

The data is at the origin site. Pending replication jobs are sent to the origin site to run.
Completed replication jobs are then sent back to the destination sites for viewing. For
example, the data for a report may not be available on the destination site, but the
user can configure the reports to run on the origin site before the completed report is
sent back to the destination site.

Federation terms
BI application

The logical grouping of related Business Intelligence (BI) content with a specific
purpose and audience. A BI application is not an object. One BI platform
deployment can host multiple BI applications, each of which can have a separate
security model, life cycle, testing and deployment timeline, as well as separate
business owners and administrators.

Destination site
A BI platformsystem that pulls replicated BI platform content from an origin site.

Local
The local system where a user or administrator is connected. For example, the
administrator of a destination site is considered “local” to the destination site.

Locally run completed instances
Instances that are processed on the destination site and then sent back to the
origin site.

Multiple origin sites
More than one site can serve as an origin site. For example, multiple
development centers generally have multiple origin sites. However, there can be
only one origin site per replication.
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One-way replication
Objects are replicated only in one direction: from the origin site to the destination
site. Any updates made at a destination site remain at that destination site.

Origin site
The BI platform system where the content originates.

Remote
A system that is not local to a user. For example, the origin site is considered
“remote” to users and administrators of the destination site.

Remote connection
An object that contains information used to connect to a BI platform deployment,
including username and password, CMS name, WebService URI and clean-up
options.

Remote scheduling
Schedule requests that are sent from the destination site to the origin site.
Reports on destination sites can be scheduled remotely, which sends the report
instance back to the origin site for processing. Then the completed instance is
returned to the destination site.

Replication
The process of copying content from one BI platform system to another.

Replication job
An object that contains information about replication scheduling, which
content to replicate, and any special conditions that should be performed when
replicating content.

Replication list
A list of the objects to be replicated. A replication list refers to other content
such as users, groups, reports, and so on, in the BI platform deployment to be
replicated together.

Replication object
An object that is replicated from an origin site to a destination site. All replicated
objects on a destination site will be flagged with a replication icon. If there is a
conflict, objects will be flagged with a conflict icon.
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Replication package
Created during the transfer, the replication package contains objects from a
replication job. It can contain all the objects defined in the replication list,
as in the case of a rapidly changing environment or initial replication. Or it
can contain a subset of the replication list if the objects change infrequently
compared to the schedule of the replication job. The replication package is
implemented as a BI Application Resource (BIAR) file.

Replication refresh
All objects in a replication list are refreshed regardless of the last modified
version. 18.2.17 Two-

Two-way replication
Acts the same as one-way replication, but two-way replication also sends changes
in both directions. Updates to the origin site are replicated to each destination
site. Updates and new objects on a destination site are sent to the origin site.

Replication Types and Mode Options
Depending on your selection of Replication Type and Replication Mode, you will
create one of four different Replication Job options: one-way replication, two-way
replication, refresh from origin, or refresh from destination.

One-way replication

With one-way replication, you can only replicate content in one direction, from the
Origin site to a Destination site. Any changes made to objects on the Origin site in the
Replication List are sent to the Destination site. However, changes made to objects on
a Destination site are not sent back to the Origin site.

One-way replication is ideal for deployments with one central BI platform deployment
where objects are created, modified, and administered. Other deployments use the
content of the central deployment.

To create one-way replication, select the following options:

• Replication Type = One-way replication
• Replication Mode = Normal replication

Two-way replication
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With two-way replication, you can replicate content in both directions between the
Origin and Destination sites. Any changes made to objects on the Origin site are sent
to Destination sites, and changes made on a Destination site are sent to the Origin
site during replication.

Note: To perform remote scheduling and to send locally run instances back to
the Origin site, you must select two-way replication mode.

If you have multiple BI platform deployments where content is created, modified,
administered, and used at both locations, two-way replication is the most efficient
option. It also helps synchronize the deployments.

To create two-way replication, select the following options:

• Replication Type = Two-way replication
• Replication Mode = Normal replication

Refresh from Origin or Refresh from Destination
When you replicate content in one-way or two-way replication modes, the objects on
the replication list are replicated to a destination site. However, not all of the objects
may replicate each time the replication job runs.

Federation has an optimization engine designed to help finish your replication jobs
faster. It uses a combination of the object's version and time stamp to determine
if the object was modified since the last replication. This check is done on objects
specifically selected in the replication list and any objects replicated during
dependency checking. However, in some cases the optimization engine may miss
objects, which won't be replicated. In these cases, you can use “Refresh from Origin”
and “Refresh from Destination” to force the replication job to replicate content, and
their dependencies, regardless of the timestamps. "Refresh from Origin" only sends
content from the origin to the destination sites. "Refresh from Destination" only sends
content from the destination sites to the origin site.

The following three examples describe scenarios using “Refresh from Origin”
and “Refresh from Destination” where certain objects will be missed due to the
optimization.

Scenario 1: The addition of objects that contain other objects into an area that is
being replicated.

Folder A is replicated from the origin site to the destination site. It now exists on both
sites. A user moves or copies Folder B with Report B, into Folder A on the origin site.
During the next replication, Federation will see that Folder B's timestamp has changed
and will replicate it to the destination site. However, Report B's timestamp does not
change. Therefore, it will be missed by a regular one-way or two-way replication job.
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To ensure Folder B's content is properly replicated, a replication job with “Refresh
from Origin” should be used once. After this, the regular one-way or two-way
replication job will replicate it properly. If this example is reversed and Folder B is
moved or copied on the destination site, then use “Refresh from Destination”.

Scenario 2: The addition of new objects using LifeCycle Manager or the BIAR
command line. When you add objects to an area that is being replicated using
LifeCycle Manager or BIAR command line, the object may not be picked up by a
regular one-way or two-way replication job. This occurs because the internal clocks
on the source and destination systems may be out of sync when using the LifeCycle
Manager or BIAR command line.

Note: After importing new objects into an area that is being replicated on the
origin site, it is recommended that you run a “Refresh from Origin” replication
job. After importing new objects into an area that is being replicated on the
destination site, it is recommended that you run a “Refresh from Destination”
replication job.

Scenario 3: In between scheduled replication times. If you add objects to an area that
is being replicated and can't wait until the next scheduled replication time, you can use
“Refresh from Origin” and “Refresh from Destination” replication jobs. By selecting
the area where objects have been added, you can replicate content quickly.

Note: This scenario can be costly for large replication lists, so it is
recommended that you do not use this option often. For example, it is not
necessary to create replication jobs to refresh from the origin to destination
mode on an hourly schedule. These modes should be used in “run now” or
infrequent schedules.

In some cases, you cannot use conflict resolution, including: “Refresh
from Origin”: destination site option wins is blocked, or “Refresh from
Destination”: origin wins option is blocked.

Managing Conflict Detection and Resolution
In Federation, a conflict can occur when the properties of an object are changed on
both the origin site and destination site. Both top level and nested properties of an
object are checked for conflicts. For example, a conflict can occur if a report or the
name of a report is modified on both the origin and destination sites.

Some instances do not create a conflict. For example, if the name of a report is
modified on the origin site, and the description of the replicated version is modified on
the destination site, the changes merge together and no conflict occurs.
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One-way Replication Conflict Resolution
In one-way replication, you have two choices for conflict resolution:

• “Origin site takes precedence””
• “No automatic conflict resolution””

Origin site takes precedence

If a conflict occurs during one-way replication, the origin site object takes precedence.
Any changes to objects on a destination site are overwritten by the origin site's
information. For example, if a report is modified on both the origin site and the
destination site, the destination site modification will be overwritten by the origin
site version after the next replication job.

Because the conflict is automatically resolved, it is not generated in the log file and
does not appear in the conflicting object list.

No automatic conflict resolution

If a conflict occurs and you select “No automatic conflict resolution”, the conflict is
not resolved, a log file is not generated, and it does not appear in the conflicting object
list. Administrators can access a list of all replicated objects that are in conflict in the
Federation area of the CMC. Objects in conflict are grouped together by the remote
connection they used to connect to the origin site with. To access these lists, go to the
Replication Errors folder in the Federation area of the CMC, and select the desired
remote connection. All replicated objects on a destination site will be flagged with a
replication icon. If there is a conflict, objects will be flagged with a conflict icon. A
warning message also appears in the "Properties" page.

Two-Way Replication Conflict Resolution
In two-way replication conflict, you have three choices for conflict detection:

• Origin site takes precedence
• Destination site takes precedence
• No automatic conflict resolution

Origin site takes precedence

If a conflict occurs, the origin site will take precedence and overwrite any changes
to the destination site.
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Example: Lily modifies the name of a report to Report A. Malik modifies the name of
the replicated version on the destination site to Report B. After the next replication job
runs, the replicated version on the destination site will revert to Report A. This will
not generate a conflict in the log file, and it will not appear in the conflicting object list
because the conflict was resolved according to the user's instructions on the origin site.

Destination site takes precedence

If a conflict occurs, the destination site keeps its changes and overwrites them to
the origin site.

Example: Kamal modifies the name of a report to Report A. Peter modifies the name
of the replicated version on the destination site to Report B. When the replication job
runs, a conflict is detected. The name of the destination report remains as Report B. In
two-way replication, changes are also sent back to the origin site. In this scenario,
the origin site is updated and its report name is changed to Report B. This does not
generate a conflict in the log file and it will not appear in the conflicting object list
because the conflict was resolved according to the user's instructions.

No automatic conflict resolution

When “No automatic conflict resolution” is selected, a conflict will not be resolved.
The conflict will be noted in a log file for the administrator, who can manually resolve
it.

Example: Michael modifies Report A on the origin site. Damien modifies the
replicated version on the destination site. When the next replication job runs, the
report is in conflict as it has changed on both sites and will not be resolved. The
destination report is kept and changes to the origin's report are not replicated.
Subsequent replication jobs behave the same way until the conflict is resolved. Any
changes on the origin site will not get replicated until the conflict is manually resolved
by the administrator or delegated administrator.
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Best Practices
You can use Federation to optimize the performance of a replication job. If there a
large number of objects in a single replication job, you can take additional steps to
ensure that it runs successfully. Typically, you should be able to replicate up to
32,000 objects in each replication job. However, some deployments may require
configurations with smaller or larger replication sizes.

1. Obtain a dedicated Web Services provider

In Federation, replicated content is sent using Web Services. In a default
installation of BI platform, all Web Services use the same web service provider.
Larger replication jobs may tie up the web service provider longer and slow down
its response to other web service requests as well as any applications it serves.

If you plan to replicate a large number of objects at once, or run several
replication jobs in sequence, you may consider deploying Federation Web
Services on its own Java Application server using your own web services
provider.

To do this, use the BI platform installer to install web services. You must have a
Java Application Server already running. If you do not, install the entire Web
Tier Components option, which will install web services and Tomcat.

2. Increase the Java Application Server's available memory Increase the available
memory of your Java Application Server if your single replication job replicates
many objects, or if you are sharing the Application Server with other applications.

3. Reduce the size of the BIAR files being created.

Federation uses Web Services to replicate content between the origin site and
destination site. Objects are grouped together and compressed into BIAR files
for more efficient transportation. When replicating a large number of objects,
configure your Java Application Server to create smaller BIAR files. Federation
will package and compress objects across multiple smaller BIAR files so the
number of objects you want to replicate will not be limited.

4. Increase the Socket Timeout.

The Adaptive Job Server is responsible for running the replication job. During
the execution of the replication job, the Adaptive Job Server establishes a
connection to the origin site. When receiving large amounts of information from
the origin site, it is important that the Socket which the Adaptive Job Server is
using to receive information does not timeout. The default value is 90 minutes.
You can increase the Socket Timeout if you need to.
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Figure 52: Federation
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Exercise 10: Manage Federation Services

Exercise Objectives
After completing this exercise, you will be able to:
• Create a replication list .
• Create a remote connection
• Create and schedule a replication job

Business Example
As a system administrator, you will configure a Federation Origin site as well as
a Federation Destination Site. A Web Intelligence Document and all respective
dependencies will be federated (using one way federation) to the destination site.

Task 1: Create a new Web Intelligence document
Create a new Web Intelligence document using the e-fashion universe named U##
Federation Webi and publish it to the Report Samples Directory. This document will
be federated to the Destination site later in this exercise.

Site

Origin WDFLBMT2268

Desintation WDFLBMT2287

Task 2: Create a replication list
Create a replication list in the origin site wdflbmt2268.

1. On origin system WDFLBMT2268, Log on to the CMC, navigate to the
Replication Lists area. Create a new Replication List by selecting Manage> New
Replication List. Name the replication list Your Name replication List. Click
next

2. Expand the Public Folder and select U## Federation Webi document created in
step 1 in this task. Click save

Continued on next page
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Task 3: Creating a remote connection
Creating a remote connection on destination site on wdflbmt2287.

1. On WDFLBMT2287, log on to the CMC and navigate to the Federation area.
Right click on the Remote connections folder and select New> New Remote
Connection. Name it- Federation Remote Connection.

2. Enter the following parameters:

Field Value

Title U##_Remote_Connection

Remote System Web Services URL http://wdflbmt2268:8080/dswsbobje

Remote System CMS wdflbmt2268

User name Administrator

Password <Assigned password>

Task 4: Create and schedule a Replication Job
Create and schedule a Replication Job on the Destination System

1. In the Federation area of the CMC, right click on the existing Federation Remote
Connection and select New Replication Job. Name it, Your Name Replication
Job. Click Next.

2. Select the available Replication list you created on the origin site.

3. Schedule the Replication Job to run.

Result
Check the status is changed to Success. Verify the replication of the Federation
of the Webi document and dependent objects (Connection and Universe).
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Solution 10: Manage Federation Services
Task 1: Create a new Web Intelligence document
Create a new Web Intelligence document using the e-fashion universe named U##
Federation Webi and publish it to the Report Samples Directory. This document will
be federated to the Destination site later in this exercise.

Site

Origin WDFLBMT2268

Desintation WDFLBMT2287

Task 2: Create a replication list
Create a replication list in the origin site wdflbmt2268.

1. On origin system WDFLBMT2268, Log on to the CMC, navigate to the
Replication Lists area. Create a new Replication List by selecting Manage> New
Replication List. Name the replication list Your Name replication List. Click
next

a) In the CMC Home page, click the Replication Lists link.

b) Click Manage → New → New Replication List.

c) Name the replication list U##_ Replication List.

d) Click Next.

2. Expand the Public Folder and select U## Federation Webi document created in
step 1 in this task. Click save

a) Expand the Public Folders

b) Select the U## Federation WebI document created.

c) Click Save & Close.

Continued on next page
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Task 3: Creating a remote connection
Creating a remote connection on destination site on wdflbmt2287.

1. On WDFLBMT2287, log on to the CMC and navigate to the Federation area.
Right click on the Remote connections folder and select New> New Remote
Connection. Name it- Federation Remote Connection.

a) In the CMC Home page, click the Federation link.

b) Right-click the Remote Connections folder and select New → New Remote
Connection

2. Enter the following parameters:

Field Value

Title U##_Remote_Connection

Remote System Web Services URL http://wdflbmt2268:8080/dswsbobje

Remote System CMS wdflbmt2268

User name Administrator

Password <Assigned password>

a) Fill out the remote system connection using the information provided.

b) Click OK.

Task 4: Create and schedule a Replication Job
Create and schedule a Replication Job on the Destination System

1. In the Federation area of the CMC, right click on the existing Federation Remote
Connection and select New Replication Job. Name it, Your Name Replication
Job. Click Next.

a) In the Federation page of the CMC, right-click U## Remote Connection
and select New → New Replication Job.

b) In the Title field, enter U##_ Replication Job.

c) Click Next.

Continued on next page

300 © 2012 SAP AG. All rights reserved. 2012



BOE330 Lesson: Managing the Federation

2. Select the available Replication list you created on the origin site.

a) Select the available Replication list you created on the origin site

b) Click Next.

c) In the next screen, keep all default selections. Click OK.

3. Schedule the Replication Job to run.

a) Right-click the U## Replication Job and select Schedule.

b) Click Schedule.

Result
Check the status is changed to Success. Verify the replication of the
Federation of the Webi document and dependent objects (Connection and
Universe).
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Lesson Summary

You should now be able to:
• Recognize when to use the different types of replication
• Manage replication conflict resolution
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Unit Summary
You should now be able to:
• Describe the roles of the upgrade management tool
• Migrate objects using the upgrade management tool
• Explain Lifecycle Management
• Describe the Lifecycle management console
• Manage promotion jobs
• Use Monitoring
• Use Auditing
• Recognize when to use the different types of replication
• Manage replication conflict resolution
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Test Your Knowledge

1. Which tool do you use to manage promotion jobs?
Choose the correct answer(s).
□ A Central Configuration Manager
□ B Import Wizard
□ C Lifecycle management console
□ D Upgrade management tool

2. What do you need to take into consideration when planning content security?

3. What does it take to setup One-Way Federation?
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Answers

1. Which tool do you use to manage promotion jobs?

Answer: C

Lifecycle management console is used to manage promotion jobs.

2. What do you need to take into consideration when planning content security?

Answer:

• Folder content structure
• Group/user structure
• Which access levels to work with
• How to secure content - Where to apply various access levels and for

which groups

3. What does it take to setup One-Way Federation?

Answer: Create a Replication List (Origin). Create a Remote Connection (on
the Destination system pointing to the Origin system). Create a Replication
Job (under the Remote Connection). Finally schedule the Replication Job and
test the results.
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Course Summary
You should now be able to:

• Explain SAP BusinessObjects BI platform architecture, administration, and
security

• Ensure availability of your SAP BusinessObjects BI solutions
• Design a scalable system
• Size a SAP BusinessObjects BI deployment
• Deploy a SAP BusinessObjects BI platform
• Manage content across BI deployments.
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Feedback
SAP AG has made every effort in the preparation of this course to ensure the accuracy
and completeness of the materials. If you have any corrections or suggestions for
improvement, please record them in the appropriate place in the course evaluation.
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